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1. CAUTIONARY WARNING AND WARRANTY 

b.!., CAUTIONARY WARNING 

The logic analyzer functions of the Omni Series are designed for 
use only by qualified technical personnel trained to work on electronic 
circuitry that is in a power-on condition. Such circuitry may have 
hazardous voltages present; the operator!!!!!!, have a knowledge of 
electronic circuit operation, accepted maintenance procedures, and 
appropriate safety practices for the circuitry being tested. 

1.2 LIMITED WARRANTY 

OmniLogic, Inc., warrants each new system against defects in 
material or workmanship for a period of ninety days from date of 
delivery to the original customer. The Logic Analyzer Printed Circuit 
Board has a warranty period of one year. Fuses, probes, and probe tips 
are excluded from this warranty. This warranty is specifically limited 
to the replacement or repair of any defects, without charge, when work 
is authorized or unit is returned to OmniLogic, Inc., 350 Sunset Blvd 
N., Renton, WA 98055, transportation charges prepaid. This express 
warranty excludes all other warranties, expressed or implied, and IN NO 
CASE SHALL THE LIABILITY OF OMNILOGIC, INC., EXCEED THE PURCHASE PRICE 
OF THE UNIT. OMNILOGIC, INC., SHALL NOT BE MADE LIABLE FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES. No liability is assumed for damage due to 
accident, abuse, lack of reasonable care, loss of parts, unauthorized 
service, or subjecting the instrument to faulty peripherals or input 
values exceeding specified limits. 

Omni Opera ting Manual 1-1 Cautionary Warning 

Ka
yp
roJ
ou
rna
l



Li 

LI 

LI 

LI 

LI 

u 
Li 

LI 

LI 

LI 

Li 

u 
u 
LI 

u 
LI 

Li 

u 
LI 

2. INTRODUCTION 

This manual describes the operation of OmniLogic, Inc.-s Logic 
Analyzers. The purpose of the manual is to enable you to use the Omni 
analyzer to make digital measurements most effectively. The Omni is 
designed for maximum user convenience so that your attention will be on 
the circuit you are testing, rather than on the instrument itself. 

Menus and on-line Help Page explanations make the Omni extremely 
easy to use. Every screen display includes a prompt line at the bottom 
which gives you the allowable commands. A label on the keyboard also 
lists the most often used commands. Little training or reference to 
other materials are needed to use the instrument effectively. Most of 
the material in this manual, in fact, is on-line and available to you 
with a few keystrokes; the Omni, itself, will teach you most of what you 
need to know in order to use it. 

This manual covers only the Logic Analyzer functions. Use of the 
Omni as a CP/M computer is described in the computer manuals packed with 
the unit. 

This manual has a section devoted to each command, and covers the 
operation of the Omni analyzer in detail. The last section, 11Quick 
Start", leads you through the functions and commands, beginning with 
turn-on. If you have never used the Omni before, we suggest you start 
with the Quick Start section (Appendix A) and go step-by-step through 
the Omni's functions. Due to software improvements, there may be slight 
differences between photos in this manual, the descriptions, and your 
unit. 

The information in the Help Pages in your Omni may vary slightly 
from that given here; if so, check the revision date to make sure that 
you have the latest version. 

Rev. D 

Omni Operating Manual Introduction 

Ka
yp
roJ
ou
rna
l



u 
LI 

u 
u 
u 
LI 

u 
LI 

LI 

u 
u 
u 
u 
u 
Li 

LI 

u 
u 
LI 

3. OMNI SPECIFICATIONS* 

3.1 LOGIC ANALYZER !>.!I! COLLECTION CHARACTERISTICS 

Sample Rates 
Internal Clock 

Available periods 

External Clock 
Minimum period 
Maximum period 
Clock stable prior 

to active edge 

Clock Qualify 
Setup 
Hold 

Number of samples collected 

Trigger point 

Delay between event trigger 
to data collection 

Data Channels F through 0 
Data stable prior to 

active edge of clock 
Data stable after 

active edge of clock 

Glitch Channels 3 through 0 
Glitch definition 

Minimum detectable pulse 

_hl TRIGGER CONDITIONS 

Data functions 

Glitch functions 

50, 100, 200, 500ns 
1, ••• 32768us 

50ns 
unlimited 

35ns 

30ns 
Ons 

1000 

16th, 32nd, ••• 
992nd sample 

0 to 34 seconds 

35ns 

Ons 

2 or more data 
transitions in 
1 sample period 

lOns 

AND/OR/NOT on data 

AND/OR/NOT with data 

*Specifications~ subject !Q. change without notice. 
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Latched (synchronous) mode 
Setup 
Hold 

Unlatched (asynchronous) mode 
Minimum event duration 

External Trigger duration 

External Trigger Qualify 
Minimum active 

during event 
Active after 

Timeout mode 
Duration between events 

Repeat until reference 
memory correlated 
or not correlated 

3.3 DISPLAY MODES 

Waveform format 
Sample window 
Number of channels 

Edge format 
Sample window 
Number of channels 

Dump format 
Sample window 

Number of channels 

Matrix format 
Sample window 
Number of channels 
Display matrix 

Instruction Disassembly 
format 

Sample window 
Numher of channels 
Processors supported 

30ns 
Ons 

15ns 

25ns 

25ns 
Ons 

16us to 34sec 

80 to 1000 samples, scrollable 
l to 16 channels 

80 to 1000 samples, scrollable 
l to 16 channels 

252 binary, 231 octal 
232 unsigned decimal 
232 signed decimal 
336 hexadecimal 
all scrollable 
l to 16 

l to 1000 samples 
2 to 8 
16 rows X 16 columns 

13 scrollable 
4, 8, or 16 
Z-80, 8085, 8048 
family and 
user-definable 

Specifications_!!'.! subject _!2 change without notice. 
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Signature format 
Sample window 
Number of channels 

1:!, UTILITY CAPABILITIES 

Pattern Search 

Interval Calculation 

Correlation 

Channel Labels 

Printer Output 

File Operations 

Help Pages 

Extensive built-in tests 

3.5 PROBE CHARACTERISTICS 

Pin ~~ 

1 Clock 
2 DO 
3 D1 
4 D2 
5 D3 
6 D4 
7 D5 
8 D6 
9 D7 

10 Trigger 
11 Ground 

2 to 1000 samples 
1 to 14 simultaneous 

1 to 16 bit maskable 
1 to 6 sample sequence 

Time and sample number 
between cursor 
and/or 2 events 

1 to 1000 samples 
1 to 1000 start skew 
1 to 16 channel tolerance 
1 to 1000 sample 
error allowance 

1 to 15 characters 
per channel 

Any display on CRT 
and multiple 
sequential displays 

Save and recover set-up 
and/or data 

Built-in explanations 
and examples at all 
steps of operation 

Suggested 
Right~ ~ Color 

Clock Qualifier Yellow/White 
DB Black 
D9 Brown 
D10 Red 
D11 Orange 
D12 Yellow 
D13 Green 
D14 Blue 
D15 Violet 
Trigger Qualifier Red/White 
Ground Green/White 

S.E,ecifications are subject .!Q. change without notice. 
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Minimum detectable pulse 

Maximum voltage limits 

Input impedance 

Logic level transition to 
low level 

TrL probes 
CMOS probes 

Logic level transition to 
high level 

TrL probes 
CMOS probes 

10 nanoseconds 

-0. 5V, +5. 5V 

1 megohm 

o.sv 
1.ov 

2.ov 
3.sv 

Specifications~ subject _!2 change without notice. 
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CPU 

RAM 

Mass storage 

Disks recommended 

Keyboard 

Display 

Graphics 

I/0 connections 

Modem (Omni 4 only) 

Real Time Clock (Omni 4 only) 

CP /M COMPUTER* 

Z-80A System 

64K Bytes 

Omni II - 380 Kbytes via dual 5-1 /4 
inch, single sided, double 
density floppy disk drives 

Omni 4 - 780 Kbytes via dual 5-1/4 
inch, double sided, double 
density floppy disk drives 

Omni II - single sided 5-1/4 inch 
floppy disks (Maxell MDl-D) 

Omni 4 - double sided 5-1/4 inch 
floppy disks (Maxell MD2-D) 

Full ASCII keyboard with numeric pad 
and cursor control keys, 
detachable. Keys are 
programmable. 

9 inch, 24 row x 80 column 
8 x 11 pixel character 

Omni II and 4 - green phosphor 

Omni 4 - 160 x 100 pixels 

RS-232C serial port 
(Omni 4 has two serial ports) 

"Centronics" parallel port 

300 Baud, full or half duplex, auto 
dial/auto answer 

Resolution to .0001 second, 5-,year 
lithium battery backup 

*Specifications£! subject !.2, change without notice. 

Rev. D 
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4. UNPACKING 

If there is damage to the inner carton, inspect the Omni carefully. 
If the Omni is damaged, call us immediately at (206) 271-2000 for 
further instructions. 

Set the Omni on a firm surface. The keyboard is attached to the 
main unit by clamps at the right and left sides. The keyboard cable may 
be packed between the keyboard and main unit. The Omni 4 provides a 
storage area for the probes below the disk drives, and the probes and 
probe leads are packed there. There is also a convenient disk storage 
area just below the drives. 

The Omni logic analyzer disks and the CP/M Operating System Disk 
are packed separately from the other disks and manuals, which are in a 
single large flat package within the Logic Analyzer carton. 

Remove the remaining items from the carton, along with the System 
Checklist. Verify that you have received everything on the Checklist. 
If there are any items missing compared to the Checklist enclosed with 
the unit, please call and let us know. 

Table 4-1 on the next page shows a typical checklist. 

Omni Operating Manual 4-1 Unpacking 
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Table i:!. TYPICAL SYSTEM CHECKLIST 

NOTE: This list is provided here as an illustration only. The items 
included in your system may be different. Use the correct System 
Checklist enclosed with your unit to verify that your shipment is 
complete. 

.!S!!!!!.2:. ~ Description 
1 2 Omni Logic Analyzer Disks (master and 

working copy) 
2 1 CP/M Operating System Disk 
3 1 Software Package - package of manuals and 

disks 
4 1 Operating Manual (this manual) 
5 1 Main Unit with Power Cord 
6 1 Keyboard 
7 1 Keyboard Cable 
8 2 Cables and Pods 

each ribbon cable is 36" long 
and has a pod at one end 

9 2 Package of 11 Leads with 11 Clips 
6" leads, ganged together 

Rev. D 
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S. TURN-ON PROCEDURE 

hl INTRODUCTION 

Now tha~ you have the Omni unpacked, you can set it up and try it 
out. The Omni may be used as either a Z-80 based computer with the CP/M 
operating system or as a logic analyzer for probing the operation of 
digital circuits. 

The Omni should be used to test digital equipment only by qualified 
technical personnel (see "Cautionary Warning", Section 1). 

The Omni is intended to operate from an 120 volt AC, 60 Hz power 
source as marked on the rear panel. The Omni is grounded through the 
grounding conductor of the power cord. To avoid electrical shock, plug 
the power cord into a properly wired receptacle before connecting to the 
input or output terminals, A protective ground connection by way of the 
grounding conductor in the power cord is essential for safe operation. 

We also recommend that you use the Omni only on a safe technician's 
test bench when testing digital circuits. That means: 1) A bench or 
table on which any metal parts you are likely to come in contact with 
are grounded. Then.if a conductor carrying high voltage comes in 
contact with the bench, it will not make the bench itself "hot" and a 
hazard to you. 2) A nonconductive surface should be on the floor in 
front of the bench for you and your chair to stand on. Thus, if you do 
inadvertently come in contact with a hazardous voltage circuit, there is 
no current path through you to ground. 

OPERATOR SAFETY COMES FIRST 

If necessary, ground your bench now before proceeding further. 

CAUTION 

Both the Omni main unit and the probes contain circuitry that is 
potentially susceptible to damage from electrostatic discharges. 
Although the probes are input protected against static discharge, when 
you approach the Omni it is good practice to dissipate any static 
charges accumulated on your body by touching the chassis before touching 
the probe pins. Likewise, much digital equipment is static sensitive. 
You should touch the chassis of any equipment you are testing before 
making probe connections to it or touching the internal circuitry. Take 
these precautions after plugging in the power cord to establish a ground 
connection. 

When you are using the Omni as a CP/M computert the probes need not 
be connected and you can use it at an ordinary desk or table. 

Omni Operating Manual 5-1 Turn-on Procedure 
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5.2 SETTING E !!!§. KEYBOARD 

Place the Omni flat on your work surface. The keyboard also serves 
as the front cover, and is held on by clamps on the right and left 
sides. Unfasten the clamps and remove the keyboard. Connect the 
telephone-type coil cord between the connector on the keyboard (on the 
rear edge) and the connector on the main unit (on the rear panel, near 
the top). If there are two telephone-type connectors on the main unit, 
use the one labeled "KEYBOARD." 

You can lift the main unit and lower the stand on the underside so 
that the screen is tilted up and easily visible. 

The Omni is shipped with cardboard packing cards in the floppy disk 
drives to protect the read/write heads. Open the doors of both drives 
and remove the cards. Save the cards for whenever you may want to ship 
the unit in the future. 

Disk drive doors open ~ turn-on .fill!! turn-off I 

Turning the machine on or off with a disk in the drive and the door 
closed may result in scrambling the data on the disk. Opening the drive 
door moves the head away from the disk, preventing power transients from 
affecting the data on the disk. It is all right to have disks in the 
drives at turn-on and turn-off as long as the doors are open. 

If you anticipate a possible power interruption - due to a 
lightning storm or electricians working on the power mains in your 
building, for example - open the drive doors even while using the Omni, 
closing them only when file reads or writes are required. (This won't 
work with a program which uses overlays, such as Wordstar, since the 
program automatically performs disk accesses when you may not expect 
it.) 

If you do scramble the data on a diskette, then you will have to 
use your backup diskette to make a new working copy. And if you don't 
have a backup ..• 

5.3 POWER .Q!i 

The power switch is the large rocker switch on the rear panel. 
Turn it on now. The drives will start whirring and you will soon see: 

* Omni * 
Please insert your diskette into Drive A 

Insert whichever diskette you are going to use in Drive A. To use 
the Omni as a logic analyzer, use the Logic Analyzer Operation Disk. 

It is all right to put a disk in the Omni while the drive is 
whirring and the red light on the drive is on. (This is not true for all 
computers). To put the disk in the right way, hold it with the label 
up. Do not fold the floppy disk, touch the magnetic recording surface, 
or put it near magnetic materials. 
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5.4 MASTER~ 

When you close the door of the drive, the computer will load the 
operating system and display the Master Menu - see Exhibit 5-1. A new 
feature that makes the system very easy to use, the Master Menu 
automatically provides information about each menu choice. 

Earlier Omni models (1984 and prior) do not have the Master Menu 
feature and use the standard CP/M user interface. (The standard 
interface may be reached from the Master Menu by pressing <ESC>). The 
last section of this chapter, section 5.8, covers the differences of the 
older units. 

The Master Menu groups the files on a disk into categories. 
Initially, information about the categories is displayed. When you 
move the cursor-bar to a category using the cursor keys, the individual 
items in that category are listed along with information about them. 
When you indicate an individual item, more detailed information about it 
appears. 

Masttr t1tnu 

:jte the up-arrow and douti-arrow leys to m::,ve the 
o,~~e~ed bar to your choice. Then, press the 
~ ;i-t-e--ro~ ~ey. To e:w: it th is rrenu, press ESC 

Exhibit 5-1. Master Menu. 
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For the Logic Analyzer Disk, the two categories are: 

Logic Analyzer 
Disk Utilities 

Use the up-arrow and down-arrow keys to move the dark bar area over 
"Logic Analyzer". Then press the right-arrow key. The list of 
individual functions available will be displayed in the middle column: 

Logic Analyzer 
EPROM Programmer 
Pattern Generator 

To activate one of the functions, simply move the bar over it and 
press <RETURN>. If you activate "Logic Analyzer", for example, the Omni 
will load and begin running the logic analyzer program. 

5.5 !!fili ! WRKING !!1filS. 

Two copies of the logic analyzer software are provided, a Master 
Disk and an Operating Disk. Put the Master in a safe place and use the 
Operating Disk as your working disk. Only masters are provided for the 
other software. Make working copies and set aside the masters before 
using the other software. 

See the Specifications Section for the type of disks required. 

5.6 COPYING DISKS 

All Omni models, both those equipped with the Master Menu and 
earlier units, have convenient disk copy programs. 

From the Master Menu select ''Disk Utilities" and then "Copy a 
Disk." A menu will appear with four choices - C, B, 0, and E. But 
before making a selection, remove the disk in Drive A and insert the 
disk you wish to copy. This is the source disk. 

Put a blank disk, the destination disk, in Drive B; this will 
become the copy. (You can use a disk here that is not blank, but it 
will be reformatted as part of this copy method and anything on it 
previously will be erased.) After the prompt line, choose C: 

Please enter selection. Press C, B, O, or E ->C 

Note: your input is underlined here to distinguish it from data 
displayed by the computer. 

The program will then display some more information, after which 
you type <RETURN>: 

••• press the RETURN key to start the copy operation. You 
may return to the main menu by pressing any other 
key.<RETURN> 

Omni Operating Manual 5-4 Turn-on Procedure 
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Note: here "<RETURN>" means "press the RETURN key," not type the 
characters"< RETURN >11• 

The program will display the track numbers as it makes the copy, 
and will report errors if there are any. If there are errors, start the 
copy operation over; if it does not work the second time, the 
destination disk is probably bad - use another. 

After the files are copied, the program will ask if you want a 
special command line executed at boot-up. You do not, so merely type 
<RETURN> to accept the default case. 

The program then returns to its main menu. Choose "E" to exit. 

The last step in making a copy is to label it. Do not write on the 
label after it is on the disk with a pencil or ballpoint pen; you can 
use a felt t~p pen, which requires very little pressure. We suggest 
that you include on the label the version of CP/M, the files on the 
disk, and at the bottom of the label your initials and the date. 

5.7 OPERATING THE LOGIC ANALYZER 

To use the Omni as a logic analyzer, put the operating disk 
( labeled "Omni Logic Analyzer Operating Disk") in Drive A. The Logic 
Analyzer Disk must be in Drive A for the built-in Help Pages to be 
accessible. 

Press the Reset button. When the Master Menu appears, select 
"Logic Analyzer" as described above. The computer will load the logic 
analyzer program and run a series of self-tests. See Exhibit 5-2. If 
you have the probes plugged in and connected to nothing, the tests will 
be valid and the screen will display several messages reporting the 
results. 

These tests check out the logic analyzer hardware only, from the 
ends of the probes to the sample collection circuitry. The tests will 
be passed only if the probe cables are connected to the Omni and the 
probe leads are "open" - not connected to anything. If the probes are 
not installed, or if they are connected to a circuit, a failed test will 
be indicated on the screen. 

If one or more tests fail, the Omni will display failure messages 
and stop. You may override the stop-on-fail by pressing <SPACE>; the 
logic analyzer will then go on to the next step, which is the Trigger 
Condition Setup Menu. 

The f_ollowing chapters describe use of the Omni Logic Analyzer for 
digital measurements. 

You can exit the logic analyzer program and return to computer mode 
by using CONTROL-C whenever the input prompt (cursor) is in the lower 
left corner of the screen. 

Omni Operating Manual 5-5 Turn-on Procedure 
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QCO: CIRQJITRV TEST 
1R I ffi£R roilli!ll TEST 
m:H:TEST 
OOTA Ii.Rt LCM LEVEL TEST 
OOTA mi HI~ LEVEL TEST 
6l. nm Ii.Rt L(l.l LEVEL TEST 
6llTOl Ii.Rt HI~ LEVEL TEST 

Cffil JV Rev 07~4 
Inverting Probes 

Test conplete ~ith no errors 

Exhibit 5-2. Self-test display. 

5.8 EARLIER KlDELS 

Earlier models of the Omni {1984 and prior) use the standard CP/M 
disk directory user interface. The logic analyzer functions are all the 
same. 

The earlier models use the program COPY.COi to copy disks. Put a 
disk containing the CP/M operating system in Drive A and boot up (which 
loads the operating system into the computer) by pressing the Reset 
switch. The Reset switch is the red button on the rear panel of the 
Omni II and 4. Don't flip the rocker switch and turn off the computer 
by mistake. 

If the disk with CP/M does not also have COPY.CC}{ on it, put a disk 
containing COPY.CCM in Drive A before the next step. You can use the 
DIR command to see if the disk has COPY.CCM on it. 

After the AO> prompt, type "COPY<RETURN>" to run the copy program: 

AO>COPY<RETURN> 

From this point, the program runs as described above. 
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To use the Omni as a logic analyzer, reset it and put the Logic 
Analyzer Operating Disk in Drive A. To see a directory listing of the 
files on the disk, after the ''AO>" prompt type "DIR<RETURN>". 

The directory will show at least six files. LA.COM and LA.LAO are 
the logic analyzer program. LA.LAH contains the Omni's on-line Help 
information. DATA-1-.IAD, DATA-2-.LAD, and DATA-S-.LAS contain sample 
data for this start-up exercise. 

When the "AO>" prompt appears again after the directory listing, 
type "LA<RETURN>". The Omni will load and begin running the logic 
analyzer program, starting with the self-test as described above. 
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6. BASIC OPERATION 

The Omni's basic operation may be summarized as follows: 

1) Once connected to a circuit and told to "Go collect data", the 
Omni begins to collect data into the 16 channels (or optionally 32 
channels) of its Sample Memory from the circuit under test. The data is 
"clocked in" - a new data sample of 16 bits, one bit for each probe data 
line, is gathered with each clock pulse. The clock pulses are either 
derived from the circuit under test (External Clock), or generated by 
the Omni (Internal Clock). The Omni continually collects data and 
records it in Sample Memory, overwriting old data as it cycles through 
memory, until a trigger event occurs. 

2) The recognition of a trigger word (chosen by the operator) in 
the data stream causes the Omni to start a counter that defines the 
number of additional samples to be collected. Data collection continues 
so that the defined number of samples after the trigger word are 
captured for observation. The number of samples from the trigger word 
to the end of the trace is called the Trigger Point ■ The default value 
is 500, which gives a trace with the trigger word in the center of the 
1000-word Sample Memory. 

3) The Omni then displays on the screen the data in its Sample 
Memory. The display shows a history of the digital activity in the 
circuit, both before and after the trigger word. The trigger word is at 
the center of the screen. 

Thus a logic analyzer, like an oscilloscope, collects data 
corresponding to voltage versus time and displays it as "traces 11 • 

Two features make the logic analyzer a very powerful tool: 

1) It can collect data on many lines at once; in this case, on 16 
(or optionally 32) lines ■ Observing the bit stream on a single line at 
one time, as with an oscilloscope, is of little value since the bit 
pattern.is meaningful only in comparison to the simultaneous bit 
patterns on other lines. 

2) The logic analyzer displays data prior to the trigger event, as 
well as after. The oscilloscope only starts the trace at or after the 
trigger event. When a digital circuit goes awry, the cause is usually 
found in what happened beforehand, not afterwards. 

On the other hand, a logic analyzer bas two limitations compared to 
an oscilloscope. It records voltages as only "high" or "low'' (binary 1 
or 0), ignoring the details of waveform shape. Also, it records the 
logic level only at the active clock edge. This second limitation is 
overcome to some extent by glitch capture capability, which alerts the 
user to the presence of multiple transitions between clock edges. The 
Omni's specifications guarantee detection of glitches as narrow as 10 
nanoseconds, and it will typically record glitches as brief as 6 or 7 
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nanoseconds, depending on the polarity. 

The time scale resolution is limited to the minimum clock period 
that the logic analyzer can handle. The Omni will accept a clock 
frequency of up to 20 MHz, yielding 50 nanoseconds resolution. If finer 
resolution is required, there is a Trigger Output on the rear of the 
analyzer that provides an output pulse when the trigger word occurs. 
This signal can be used to trigger a 200 MHz oscilloscope, giving far 
greater resolution when a recurring trigger word is available. 

After the data around the trigger event has been collected, it can 
be displayed in a variety of formats for convenient study and 
interpretation. The Omni's display formats are: 

Waveform Display - format similiar to timing diagrams in digital 
data books. 

Edge Waveform - same format as Waveform, however in regions where 
. the data is not active, the data is compressed so that only 

regions of the Memory where the data is changing are 
displayed. 

Dump - format similiar to computer memory dumps where logic levels 
are represented as numbers and grouped as hexadecimal, binary, 
octal, signed or unsigned decimal digits. 

Matrix - format where the numbers of occurrences of logic level 
combinations are shown in a matrix format. 

Instruction Disassembly - format where logic level patterns are 
displayed as microprocessor instruction mnemonics. 

Histogram - provides information on the amount of time a computer 
spends executing different parts of a program, based on data 
collected from the address bus. 

Signature Analysis - calculation, display, and comparison of 
signatures for up to fourteen circuit nodes at one time. 

Scrolling through the data is facilitated by commands for direct 
cursor positioning, cursor arrow keys, and a Locate command which finds 
desired logic patterns. The ability to individually label each channel 
aids in the readability of the display. With this feature, the names of 
the circuit points to which the probes are connected can be displayed 
directly on the screen. 

Analysis is aided by displays which show time or number of samples 
since the trigger event; commands which allow the calculation of sample 
number and time intervals; and the correlation of the collected data 
with data previously collected and saved on a disk file. The ability to 
produce a printed version of any screen display allows several sets of 
data to be collected for analysis at a later time or for use in • 
consultation with others familiar with the circuit under teat. This 
same feature can be used to produce a record of properly operating 
circuits for later reference. 

Omni Operating Manual Basic Operation 

" n 

" 
n 
n 

" 
n 
n 
n 
n 

n 

" 

Ka
yp
roJ
ou
rna
l



u 
.u 
LI 

u 
u 
u 
u 
Li 

u 
u 
u 
LI 

LI 

Li 

u 
u 
u 
u 
Li 

Several features have been incorporated in the Omni to make it 
user-friendly. Most data entry is via menus, with the cursor placed at 
the position of current activity. Immediate feedback is given after 
each keystroke, and prompts are given at appropriate times to inform you 
of the type and range of inputs desired. The inputs are queued so that 
you can type as fast as you desire without concern that keystrokes will 
be lost (this applies to the logic analyzer program only; queuing 
features vary for other programs when using the Omni as a computer.) 
The cursor position is highlighted for easy location. At any time, you 
can access a list of commands or information on any command. The format 
of each command, applications, and examples of its use are provided by 
the on-screen Help Pag~s. This feature virtually eliminates the need to 
refer to this or other manuals once you are familiar with the Omni's 
basic operation. 
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7. CONNECTING THE PROBES 

7. 1 INTRODUCTION 

The Omni has 22 input lines that connect via probes to points in 
the circuit you are testing. The lines are: 

16 Data lines 
1 Clock 
1 Clock Qualifier 
l Trigger 
l Trigger Qualifier 
2 Grounds 

The 16 data lines collect the digital data which will be stored as 
samples in the Sample Memory, then later displayed. 

The Clock line allows data collection synchronously with an 
external clock, such as a microprocessor system clock. You may not wish 
to sample on every pulse of the system clock, but only on clock pulses 
synchronous with some other event. The Clock Qualifier allows you to 
use this second event to qualify the data collection. 

Usually, you will be triggering on a certain combination of bits on 
the data lines, called the trigger word. However, on occasion you may 
wish to trigger on some ex c -=rnal event. The Trigger line allows this. 
You may also wish to qualify the trigger with some other event, and the 
Trigger Qualifier line allows this. The Trigger Qualifier signal may 
also be used as a seventeenth bit for word recognition. 

B INPUT~ 

The 22 lines connect to the Omni via two pods, 11 lines to each 
pod: 

Signal Signal Suggested 
Pin ~~ Right f2!! Lead Color 

1 Clock Clock Qualifier Yellow/White 
2 DO D8 Black 
3 D1 D9 Brown 
4 D2 DA Red 
5 D3 DB Orange 
6 D4 DC Yellow 
7 D5 DD Green 
8 D6 DE Blue 
9 D7 DF Violet 

10 Trigger Trigger Qualifier Red/White 
11 Ground Ground Green/White 

The two pods connect via 36-inch, special high-flex ribbon cables 
to connectors on the front panel of the Omni. See Exhibit 7-1. While 
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Exhibit 7-1. Omni input leads and pods. The input connectors are inside 
the opening in the front panel·below the disk drives; the cables were not 
plugged in when this photograph was taken. 

facing the machine, "Left" and "Right" refer to the ribbon cable 
connectors on the main unit; the "left pod" is whichever pod is plugged 
into the left connector. The pods themselves are identical. 

The right pod carries the eight high order channels, DF-D8. The 
left pod carries the low eight channels, D7 through DO. Of these, the 
lowest four channels, D3 through DO, contain enhanced circuitry which 
will capture glitches. If you wish to use glitch detection, connect the 
low four channels of the left pod to the points you wish to test. 
Otherwise, no special orientation is needed when connecting the probe 
assemblies. 

Each input pin at the buffer pod accepts a 6-inch test lead 
terminated in a pushbutton "grabber" clip. The "grabber" is small 
enough to attach to the pins of standard intergrated circuits, which 
have 0.1 inch pin spacing. The grabbers hang on quite securely. 

The Omni is normally supplied with 22 grabber clips and leads. The 
clips are of special construction for secu~e connection to small, 
closely spaced conductors such as integrated circuit pins. They are 
designed to rotate so that the pods and leads may be moved about without 
the clip twisting loose from the pin. The lead wires are made with over 
100 tiny strands of copper for maximum flexibility and resistance to 
breakage. The leads have a special locking connector that holds the 
lead securely to the pod, yet releases easily when desired. 

Omni Operating Manual 1-2 Connecting the Probes 

" 
" n 
n 
n 

" n 
n 

" n 
n 
n 

n 
n 

" 

Ka
yp
roJ
ou
rna
l



u 
LI 

LI 

u 
u 
u 
u 
u 
u 
u 
u 
LI 

LI 

LI 

u 
u 
u 
u 
u 

Eleven of the clip-leads are ganged together, while the other 
eleven are separate. The leads are color-coded to make channel 
identification easier; we recommend that the various color leads be 
plugged into the buffer pods in the order listed in the table above. 

7.3 TTL OR C!iDS ---.----

The pods contain buffers that minimize the load on the circuit 
under test while allowing the Omni to be several feet from the test 
point. The input impedance of the pods is 1 megohm ■ Buffer pods are 
currently available for two logic families, Tl'L and CMOS. The 
appropriate one should be selected for the type of circuit under test. 
A TTL level buffer pod is normally supplied with the unit. For 
measurements on CMOS circuits, the CMOS buffer pod is preferred. It is 
possible to utilize one Tl'L buffer pod and one CMOS buffer pod if 
analysis is to be performed on circuits which contain both CMOS and TrL. 
Where one pod is to be used for both types of logic, select the TTL pod. 
Note the difference in threshold levels between the TrL and CMOS pods in 
the characteristics listed below. 

TTL Buffer Pod Characteristics: 

o logic level transition to low level at 0.8 volts 
o logic level transition to high level at 2 volts 
o minimum detectable pulse 10 nanoseconds 
o maximum voltage limits -.sv, +5.SV 
o imput impedance 1 megohm 

CMOS Buffer Pod Characteristics 

o logic level transition to low level at 1.0 volts 
o logic level transition to high level at 3.5 volts 
o minimum detectable pulse 10 nanoseconds 
o maximum voltage limits -.sv, +5.SV 
o input impedance 1 megohm 

7.4 PROBE POLARITY 

The probe circuitry inverts the polarity of the signals. As part 
of the power-on self-test, the Logic Analyzer program checks whether 
inverting probes are connected or not and configures the software 
appropriately. Thus if the probes are connected when you load the Logic 
Analyzer program, the polarity will be correct. If you do not connect 
the probes until after self-test, you will also need to call up the 
Options Menu (O Command) and change Item S, Probe Type, from Non­
inverting to Inverting. Merely accessing the item toggles the entry 
from one state to the other. 

M CHANGING nfil:. SETUPS 

It is often convenient to utilize multiple sets of test clips when 
changing from one test setup to another. Using this technique, it is 
easy to go back to an earlier setup by swapping the test clips at the 
pod rather than having to reconnect each of the eight test clips. This 
feature is further enhanced by utilizing the file input/output features 
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of the analyzer to save and restore channel identification labels. 
Refer to the File Operations section for details. 

Each pod has its own ground line. The ground line should always be 
connected to a convenient ground position on the circuit under test. It 
is usually a good idea, especially when glitches or high frequency 
signals are being monitored, to place the ground clip near the probe 
clips. This will produce the most accurate representation of the 
signals as seen in the circuit under test. 

NOTE: 

Failure to connect the ground clip can cause misleading 
information to be collected by the analyzer. 

If, after connection to the test circuit, the probes should be 
placed in the wrong pod, or the pods exchanged in their connections to 
the front of the Omni, no damage will be done. However, any 
interpretation of the collected data will likely be meaningless until 
the inversion is detected and corrected. 

7.6 CLOCK~ TRIGGER OUTPUTS 

Clock Output and Trigger Output signals are available at the rear 
of the Omni at connector pins mounted directly on the logic analyzer 
data collection board. They are high speed, TTL level signals suitable 
for triggering an oscilloscope or other digital processing equipment. 
The outputs are isolated from the other circuitry through dedicated 
74LSO4 buffers. Thus loading on these outputs will not affect logic 
analyzer operation. 

Exhibit 7-2 
Trigger Output. 
O.1-inch apart. 
ground. 

shows the connector pinout for the Clock Output and 
Each connector has two pins O.O25-inch square, spaced 
The top pin carries the signal and the lower pin is 

The falling edge of the Clock Output signal is synchronous with the 
sampling window for the Omni's data input lines. It is valid for both 
Internal Clock and External Clock operation. The Clock Output's active 
edge is the falling (negative going) edge, regardless of the Clock 
Polarity chosen for External Clock operation. 

The Trigger Output signal is active high. It is valid for all 
modes of trigger operation - Internal or External Trigger, Latched or 
Unlatched, qualified by the Trigger Qualify or not. The Trigger Output 
signal is derived from the trigger signal that actually initiates 
completion of data collection in the Omni. 

The Trigger Output signal may be used to trigger an oscilloscope 
for examination of waveform shapes. For example, it may be desirable to 
observe operation of power circuitry controlled by a single-chip 
microcomputer system. Use the Omni to trigger on the digital 
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CLOCK 
OUTPUT 

GROUND 

---::::, . 
---~ . • <:---

• 
TRIGGER 
OUTPUT 

GROUND 

Exhibit 7-2. Clock Output and Trigger Output connector pinouts. The 
two connectors are accessible through vertical slots in the rear panel 
of the Omni. 

conditionst and the oscilloscope to examine the power signals. In such 
a case, it may be desirable to force the microprocessor into a loop to 
give a reasonable repetition rate for the scope trace. 

The Trigger Output may also be used to trigger a wide bandwidth 
oscilloscope for high resolution study of digital signals. For example, 
with a 200 MHz oscilloscope, waveform details as fine as 1.5 nanoseconds 
can be observed. By providing the necessary trigger signal to allow the 
oscilloscope to display the digital events of interest, the Omni makes 
possible ultra-high-resolution measurements beyond the normal capability 
of either a logic analyzer or oscilloscope alone. 

With the Omni operating in the Internal Clock mode, the Clock 
Output may be used as a convenient signal source where an accurate, 
stable digital clock signal is required. For example, the Clock Output 
may be used as the clock source to test clock-driven digital circuits 
such as counters, shift registers, and state sequencers. •Since the 
Omni'·s data collection is synchronized to the clock, collecting state 
data to track the operation of these circuits is very easy. 
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8. MENUS AND C<MMANDS 

8.1 INTRODUCTION 

The Omni needs three kinds of input from you to operate: 

Trigger and sampling conditions for collecting the data - trigger 
word, clock pulse polarity (for external clock}, and so on. 
This information is entered on the Trigger Condition Setup 
Menu (Trigger Menu for short). The initial entries on this 
menu default to the most commonly used values. 

Go Command - causes the Omni to start collecting a new data sample 
and looking for a trigger condition. 

Display selection - set up the Omni to display the collected data. 
The default display is the Waveform Display, which shows the 
signals as a timing diagram. Also available are the Dump 
Display, which lists the data as hexadecimal, binary, octal or 
decimal numbers, and several other special purpose displays. 

Two methods are used to control the Omni: Menus and Commands. 
Menus are used to set up the event recognition method (either trigger 
word in the input data stream or External Trigger signal), Sample Rate, 
and other control parameters. Commands control the format in which the 
collected data is displayed. 

8.2 MENUS 

The menus are called up by single letter commands. For example, 
t1on will call up the Options Menu. The single letter suffices; it is 
not necessary to press <RETURN>. 

The menus and the letter commands that call them up are: 

Co11l1lland 

C 
F 
H 
L 
0 
p 
s 
T 
z 

~ called .!!E. 

Correlation Menu 
File Operations Menu 
Histogram Menu and Display 
Locate Pattern Menu 
Options Menu 
Pattern Generator 
Signature Analysis Menu 
Trigger Menu 
Complex Trigger 

Each menu shows the present values of the parameters it controls. 
On power-up, the most commonly used parameter values are installed as 
defaults. See Exhibit 10-1 for an example of the Trigger Menu, the most 
frequently used menu. 
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To enter a new parameter in a menu item, type the item number to 
move the prompt-cursor to the item, then enter the desired parameter 
value. If the item has more than one data entry field, press <RETURN> 
to move to the next field. For example, Item 3 on the Trigger Menu has 
both binary and hexadecimal entry fields; press <RETURN> to move from 
the binary field to the hexadecimal field. 

Press <SPACE> to leave an item and return the prompt-cursor to the 
lower left corner of the screen. 

hl COMMANDS 

Commands control the collection and display of data. Commands are 
made up of a command letter and one or two optional parameters. The 
commands that collect or display data are shown below. Optional 
parameters are shown in square brackets, " [ J ". 

Command 

D [x] 
E [x] 
G 
l[x] 
M[x[ ,y]] 
W[x[ ,y]] -

Effect 

Numeric dump from sample x 
Edge display from sample x 
Go collect data 
Instruction disassembly from sample x 
Matrix display from sample x toy 
Waveform display from sample x toy 
Load trigger word and collect data 

Additional commands that perform various useful functions are: 

Command 

?[C/D, ..• ] 
N#xyez ... 
CTRL-P (x [ ,y]] 
X[x[,y]) 

Effect 

Help Pages for Commands C, D, ••• 
Name Channel number# with xyz ••• 
Print copy of sample x toy 
Calculate time between cursor, x, or y 

When you enter the first letter of a command sequence, the format 
for the rest of the command appears immediately on the prompt line. Do 
not put a space after the command letter; the space is inserted 
automatically. When you enter two numeric parameters, use a space to 
separate them. All commands except "G" and "•" must be ended with 
<RETURN>. 

As an example, consider the command: 

WS<RETURN> 

"W'1 calls up· a Waveform Display of the most recently collected data. 
The parameter "S" causes the display to start from Sample 5, the fifth 
sample after the trigger event. 

If you make an error in the middle of a command sequence, type 
"/<RETURN>" to abort the command, then re-enter the command correctly. 
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Commands are accepted when the prompt-cursor appears in the lower 
left corner of the screen, 

Both lower and upper case characters are accepted; lower case is 
treated internally as uppercase. The "WS" command could have been typed 
as "w5" with the same result• The slash character"/" is accepted as 
"'l", a comma is accepted as"<", and a period is accepted as">". Thus 
one-finger typists do not need to use the shift key. 

8.4 REPRESENTATION OF DIGITAL SIGNALS BY NUMBERS - -----------------
As the name "digital logic" implies, electronic signals may be used 

to represent numbers, and vice-versa. The basic form of representation 
is binary, where, for example, an eight-digit binary number such as 
"1001 0111" is used to represent the signals on eight electrical lines. 
Each digit in the binary number is a "O" or a "1 ", representing a high 
voltage level (HI) or low voltage level (LO) on the corresponding line. 

Let "us represent the form of the binary number like this: 

abed efgh 

Here "a" represents the first bit, "b" the second, and so on. The 
number may be evaluated by multiplying the bits by powers of 2 and 
summing: 

N • a*2 7 + b*2 6 . . + h*20 

Thus "a" is the high-order bit, "b" is the next bit, and so on to "h", 
which is the low-order bit. Extending the correspondance beween the 
eight bits and the eight signal lines, we may apply mathematical 
terminology to the signal lines. The line corresponding to the high­
order (leftmost) bit is the high-order line, and the line corresponding 
to the low-order (rightmost) bit is the low-order line. 

For the Omni, we call the signal lines channels. They are labeled 
according to the powers of two in the binary number. Thus eight of the 
channels are called Channel 7, Channel 6, and so on to Channel O. We 
may also call Channel 7 the high-order channel {in this group of eight), 
and Channel O the low-order channel. 

Binary numbers are difficult for people to deal with. When 
expressing digital signals as numbers, it much more convenient to use a 
number base such as decimal {base 10), hexadecimal {base 16), or octal 
{base 8). Note, however, that the correspondance between the digits of 
the numbers and the signals is lost when decimal is used. "173" may 
represent the signals on Channels 7 through O very nicely, but the "7 11 

does not correspond to the signal on any one channel or group of 
channels. 

Hexadecimal representation is often preferred because each hex 
digit does correspond exactly to the signals on four channels; a hex 
digit is equal to four bits. A signal on the Omni's 16 channels may be 
represented by four hex digits, e.g., "9AC5". In this context, 11911 

corresponds to the signal(s) on Channels F-C, "A" to Channels B-9, and 
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so on. To interpret this in terms of signal levels, translate it to 
binary. Thus "9" is equal to "1001" in binary, which means a HI level 
on Channel F, LO on Channel E, LO on Channel D, and HI on Channel c. 

!,:i FORMAT !Q! ENTERING NUMBERS 

Most entered data is numeric and can be specified in a variety of 
formats. All numbers are assumed to be in hexadecimal format, unless 
indicated otherwise by a base suffix. To enter a number in another 
base, such as decimal, append one of the following base specifiers: 

Suffix 

B 
D 
H 

0 
u 

binary 
decimal 
hexadecimal 

octal 
unsigned decimal 

Valid Digits 

0 and 1 
0,1, ... ,9 
0,1,2, ... ,9,A,B,C,D,E,F 

{default radix) 
0,1,2, ... ,1 
0,1, .. _ .. 9 

Typical input values are: 

Example 

1234 
1234D 
-1234 
47H 
ABCDH 
1011B 
170 

Meaning 

decimal 1234 
decimal 1234 
decimal negative 1234 
hexadecimal 47 {i.e. decimal 71) 
hexadecimal ABCD {i.e. decimal 43,981) 
binary 1011 {i.e. decimal 11) 
octal 17 {i.e. decimal 15) 

The term "radix" is sometimes used as a synonym for "base." 

The "sample number" for a given sample means the position of the 
sample compared to the trigger event, which normally corresponds to 
Sample 0. For example, in the "WS" command referred to earlier, the 
number "S" indicated S samples after the trigger event. Samples before 
the trigger event are indicated by a negative sample number such as "W­
S". Note that if a nonzero value is specified for the Delay on the 
Trigger Menu, Sample O will be delayed with respect to the trigger event 
by that amount. 

If time units are desired rather than sample number, then the 
number should be suffixed with time units. These units are: 

Suffix Meaning 

NS or N nanoseconds (.000000001 second) 
us or u microseconds (.000001 second) 
MS or M milliseconds (.001 second) 
s seconds 
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The command: 

W Su<RETURN> 

will generate a Waveform Display of the collected data with the sample 5 
microseconds after the trigger event positioned at the left side of the 
screen. Numbers are maintained to three significant digits after the 
decimal point and you are allowed to enter numbers which contain decimal 
points. The following examples illustrate some valid number 
repr esen ta tions. 

Example 

SOOns 
-5500us 
-S.Sms 

Meaning 

500 nanoseconds after the trigger event 
5500 microseconds before the trigger event 
same as previous example (i.e. S.5 

milliseconds before) 

A number such as "S00.75ns" is overly precise since the resolution of 
the analyzer is limited to the nearest SO nanoseconds. This number 
would be accepted as "SOOnsu. 

8.5 CURSORS 

The Omni uses two cursors, called the prompt-cursor and the 
highlight-cursor. The prompt-cursor is a blinking block or underline 
that shows were characters entered from the keyboard will appear on the 
screen. The highlight-cursor, also called the sample cursor, is a 
highlighted area of the screen used to mark a certain sample in a 
display. The highlight-cursor also uses either a vertical line to 
indicate the marked sample (for the Waveform and Edge Displays) or a"<" 
character {for the Dump Display). 

!,& DISPLAY CONTROL !!!§_ 

Displays are controlled by the following keys: 

> 
< 
<-

<SPACE> 

Function 

scroll display one page to right 
scroll display one page to left 
move highlight-cursor one position left 
move highlight-cursor one position right 
scroll display or highlighted item up one position 
scroll display or highlighted item down one 

position 
exit current menu or display 

8. 7 ill!, INFORMATION • 

A list of all the commands appears on the Reference Card, Appendix 
Bat the end of this manual, and in abbreviated fom on a label on the 
keyboard. nie list is also available on-line as two Help Pages; see the 
next section for further information on the Help Pages. 

Rev. D 
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9. HELP PAGES 

Help Pages may be called up as needed. Whenever the command line 

appears, a list of the menus and commands may be obtained by typing 
"?<RETURN>". 

This list is the same as that given on the Reference Card at the 
end of this manual, Appendix B. The first half of the list appears on 
the screen immediately; to view the second half, press <SPACE>. 

More detailed information about any menu or display command may be 
obtained "with a question mark followed by the command letter, for 
example: 

?W<RETURN> 

A Help Page will appear that gives details on the format and use of the 
W Command, which controls the Waveform Display. 

The Help Pages are contained in disk files that are presented in 
response to commands beginning with"?". The Logic Analyzer Disk must 
be in Drive A for the Help Pages to be accessible. 

After viewing a Help Page, press <SPACE> to return to the menu or 
display you were viewing before. 

The menus have additional Help Pages on-line for each menu item. 
Type "?" followed by the number of the menu item to see a detailed 
explanation of the item. For example, on the Correlation Menu, "?5" 
gives a detailed explanation of Item 5, Starting Point Skew Allowance. 
Exhibit 9-1 shows the Correlation Menu and the corresponding Help Page 
for Item 5. After reading the explanation, press <SPACE> to go back to 
the menu. 

When the first letter of a command is keyed in, abbreviated Help 
information for the command is automatically displayed. The information 
appears as a prompt line that gives the format for the command or a 
description of its effect. 
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(b) 

Exhibit 9-1. Correlation Menu (a) and the Help Page for Item 5 (b). 
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10. TRIGGER CONDITION SETUP MENU 

..!.Q.tl.. INTRODUCTION 

The trigger word and other trigger conditions are entered in the 
Trigger Condition Setup Menu, Exhibit 10-1, usually called the Trigger 
Menu for short. It is the first page that appears after self-test and 
the command lists when you load the logic analyzer program, LA. You may 
also call it up with the T Command. 

For the simplest forDI. of triggering, enter the desired trigger word 
in Item 3, Trigger Event. The trigger word is expressed both in binary 
form, which allows "don't care" bits (each denoted by an "X"), and in 
hexadecimal form at the right of the binary field. 

The menu format makes entering the trigger word very easy. Type 
113" to move the prompt-cursor to Item 3. The prompt-cursor will begin 
blinking in the first column (labeled 11Channel F" at the top) to show 
that the Omni is ready to accept an entry in that column. You can move 
the cursor to another channel either by using the left and right arrow 
keys, or by entering the channel designator "F" through "2" ( 11111 and 11011 

are not available for moving the cursor since they are used as entry 
symbols.) Key 11511 , for example, will move the cursor directly to 
Channel 5. 

Keying in a 11111, "0 11, or "X" for a given channel sets the trigger 
level for that channel to high, low, or "don't care", respectively. The 
cursor then moves to the next channel. 

The Omni also allows triggering on logic functions (AND, OR, and 
NOT) of the bits in the collected samples. In order to facilitate this, 
the sixteen channels are divided into four groups of four bits each. 
The four groups are labeled "z", "y", "x", and "w". In addition, 
Channels 3 through O have glitch triggering capability; the glitches are 
considered Group g. Item E, Recognition Function, defines the logic 
function of the five groups which initiates triggering. Type 11E11 to 
move the prompt-cursor to Item E, then key in the number of the desired 
logic function. 

After setting the trigger conditions, type "G11 for "Go and Collect 
Data." The Omni will collect data, stop after the trigger condition is 
satisfied, and display the new data in the current display format. 

When you finish viewing a data display and are ready to reset the 
trigg~r conditions to -collect another sample, press <SPACE> to bring up 
the Trigger Menu again. Yo'u can also reach the Trigger Menu by typing 
"T" • 

If you wish to display less than all 16 channels, or wish to 
display glitches on the lower four channels, Items 1 and 2 allow you to 
set up those conditions. 
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Channe Is f E D C B A 9 8 7 6 5 LI 3 2 1 0 SI gna I 
J) fc:f Ive Probes 0 1 0 1 0 1 1 1 0 1 0 1 0 0 1 1 
2) '1::f Ive GI itch 
Recog Groupings:-- z --:-- y --:-- x --:-- w --: 

3) 1r1gger Event XX XX XX XX XX XX XX XX 
4) Glitch Evenf(gl XX XX 

5) 1r 1gger 6\Jal: X 
b) 1r1gger Point: 512 
7) tkcurrence f: 1 
8) ~lay: 0 
9) 1111Fout: 0 
A) Clk CLalify: X 
Bl Ext Clock: X 
C} Sarrple Rate: 50.fns 

D) Recog 11:Jde: ltlLATOffD 
[) Recog function: 1 
-) 1-z•y•x•w•g ----------

2-(z•y•x•w)+g -~i:t!D 
3--(z·y)•x•w +~rn 
4-(z•y)+(x•w) 
5-z•y•(x+w) 
&-External ----------

I Index 1-E, G•start. P•print, ?, (space) 

Exhibit 10-1. Trigger Menu as it appears on the screen. 

lQ.4 SAMPLE CLOCK 

The Omni uses a clock signal, called the sample clock, as its cue 
to sample the logic level on the sixteen input lines. A sixteen bit 
word, one bit for each channel, is collected on the active edge of the 
sample clock. (The active edge may be either the rising or the falling 
edge.) The sample clock may either be a signal generated by the Omni 
itself (Internal Clock), or a signal derived from the equipment under 
test (External Clock). 

Use of the Internal Clock is often referred to as asynchronous 
sampling (not synchronous with signals in the equipment being tested), 
or "timing analyzer mode." To activate this mode, enter a Sample Rate 
in Item C, The default mode is Internal Clock mode with a Sample Rate 
of 50 nanoseconds (50 nanoseconds beween samples). Using the Internal 
Clock, the clock edge used (rising or falling) is not meaningful to the 
measurement and is not specified. 
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Use of the External Clock is often referred to as synchronous 
sampling, or "state analyzer mode. 11 To activate this mode, enter the 
desired clock edge, "l" or "O" (rising or falling), in Item B; Item C 
will be updated to show "External Clock" automatically. 

There is often some confusion between clocking and triggering when 
using a logic analyzer for the first time. It takes 1000 clock edges to 
fill the trace memory with 1000 samples. It takes only one trigger 
event to stop data collection and give a display. We recommend that you 
always use Internal Clock and manual trigger for your first measurement 
in any testing. That will show you the signals on the input lines, no 
matter what they are. We also recommend that you go through the Quick 
Start procedure (Appendix A) the first time you attempt to use the Omni. 

10.3 GLITCHES 

A "glitch" is a narrow pulse, usually created as a spurious by­
product accompanying state changes in a logic system. Address decoders 
and other multi-gate circuits often produce glitches when some parts of 
the circuit respond slower than others, yielding illegal states that 
last for less than a clock cycle. 

In synchronous (clocked) logic, glitches are usually harmless since 
they occur between active clock edges, and hence are ignored. Some­
times, however, they cause trouble, and when they do, the Omni may be 
used to· detect them and isolate the source. 

Basic logic analyzer circuitry, which collects data only at the 
active clock edge, will not normally detect glitches. The Omni contains 
latches that follow the incoming data stream; if two or more level 
transitions occur within one clock period, that is considered a glitch. 
Detection of the glitch is recorded in a special glitch memory. When 
glitches are present and glitch display is activated, glitches appear on 
the Waveform Display as narrow pulses. 

Channels 3 through O have the ability to capture glitches. Item 4, 
Glitch Event, controls triggering on glitches. Enter a "l" to activate 
glitch triggering on a given channel, or an "X" to disable. The glitch 
polarity is not significant; when a "l" is entered, the Omni will 
trigger on glitches of either polarity in that channel. Entering a "O" 
has the same effect as entering a "l". 

If glitch triggering is activated for more than one channel, 
appearance of a glitch on any .2.!!! activated channel will satisfy glitch 
recognition • 

. .!2.!.i .!, COMMAND . 

The• Command is a combination command that allows you to both 
change the trigger word and initiate triggering at the same time. To 
use it, line up the sample cursor, in the Waveform. or other data 
display, on the word you wish to use as the new trigger word. Then type 
"•" to load the word marked by the cursor into Item 3, Trigger Event, 
and start data collection. When you use the"•", the trigger event will 
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be the value displayed at the trigger position. Any channel that is not 
displayed (i.e., not active) will take on an "X" (don" t care) value in 
the trigger word • 

..lQ.:1. TRIGGER POINT AND DELAY 

A trace of approximately 1000 samples is collected during each data 
collection run (approximately 500 samples when using the 32 channel 
adapter). Normally, the trigger event will correspond to a point 
approximately in the center of the trace, so that there are 500 samples 
before the trigger event and 500 samples after the trigger event. 

The sample corresponding to the trigger event is normally labeled 
Sample O. The other samples are numbered relative to the trigger event; 
thus Sample 5 is the fifth sample after the trigger event, Sample -10 is 
the tenth sample before, and so on. 

Sometimes it is desirable to observe samples that are more than 500 
sample clocks before or after the trigger event. Tvo menu parameters, 
the Trigger Point, Item 6, and the Delay, Item 8, make it possible to 
do this. Exhibit 10-2 shows how these two parameters skew the collected 
data in time relative to the trigger event. 

!TRIGGER 
EVENT 

1000 DATA SAMPLES 

' 

/ ___ /'\ __ _ 
\ 

JpAMPLE (p 

\______ ,_ ____ ...,,/ .......,,,. 
DELAY 

TIME---~> 

Exhibit 10-2. Relationship between the trigger event, Delay, Trigger 
Point, and Sample O. The ability to specify independently the Delay and 
Trigger Point makes it possible to view data before, after, or long 
after the trigger event. Note that when the Delay is O {the default 
case), Sample O is simultaneous with the trigger event . 

. 
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The Trigger Point defines the number of samples that the trace 
extends past Sample O (which normally corresponds to the trigger 
event). For example, a value of 96 will cause 96 samples to be saved 
after the trigger, and thus approximaterly 900 before; the trace will 
extend from (approximately) Sample -900 to Sample 96. The default value 
for the Trigger Point is 512, which puts Sample O in the middle of the 
collected data. 

By setting the Trigger Point to 992, 992 samples after the trigger 
event may be observed. If data is to be collected at some longer time 
period after the trigger event, then a Delay parameter (Item 8) can be 
specified. This will skew the collected data some specified time after 
the trigger. The value of the Delay corresponds to the time difference 
(expressed as a certain number of sample clocks or as an absolute time 
value) between the trigger event and Sample O. Thus when a non-zero 
Delay is present, Sample O does not correspond to the trigger event. 
Only positive delay values are allowed. {The capability of accepting 
negative delay values has not been implemented, as this would require 
that the instrument be capable of predicting the future.) 

10.6 AN EXAMPLE 

The availability of many different trigger parameters vastly 
increases the Omni~s power to isolate and capture a particular event. 
For example, assume that you have an eight bit microprocessor system 
that is supposed to be moving a zero out of the accumulator at a certain 
instruction in its program, but sometimes a non-zero number appears and 
disrupts system operation. 

To capture this event, you could connect Channels 7 through Oto 
the lowest eight address lines, and Channels F through 8 to the data 
bus. For the Trigger Event, enter the lowest eight bits of the address 
of the critical instruction in Channels 7 - 0, and zeros in Channels F -
8. Use Section 3 of the Recognition Function (Item E) to achieve 
triggering when Channels 7 - 0 equal the Trigger Event~ Channels F -
8 do .!!.Q! equal the Trigger Event. With these conditions, whenever the 
critical instruction moves a non-zero number out to the accumulator and 
onto the data bus, the Omni will trigger on that event and display both 
address and data bus information before and after. 

10.7 MENU ITEMS 

Detailed explanations of the individual menu items follow. To 
enter a parameter in a menu item, first press the key corresponding to 
the number of the item, e.g. press ''l" to move the prompt-cursor to Item 
1° After the change has been made, press <SPACE> to leave the item and 
return the prompt-cursor to its home position at the lower left. 

Item 1) Active Probes 

This item has two functions. One, it shows the instantaneous logic 
levels on the input probe lines for the channels that will be included 
in the data displays. Two, it shows which channels will be included in 
the data displays, and provides a way of selecting the channels which 
will be displayed. 
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A high or low logic level on each input probe line is indicated by 
a "l" or a "O". The level display is updated several times a second and 
a varying logic level will cause the display to flicker between "O" and 
"l". Channels not included in the displays will have a blank space in 
the corresponding bit position in this item. 

To activate a given channel for display, first press "l" to move 
the cursor to this item. Then keys "F", "E", "D", ••• "O" will activate 
the corresponding channel. Or, use the"<-" and"->" cursor keys to 
move the cursor to the desired channel, and press any other key except 
"X". To deactivate a channel, press the "X" key. The keys auto-repeat. 

Note that when you move the cursor to a channel, the channel label 
appears to the right under "Signal". 

Exit this item with <SPACE>. 

This item affects only the display format; it has no effect on data 
collection (data is always collected on all channels) or triggering. 

Item 2) Active Glitch 

This item selects the channels for which glitches will be displayed 
on the Waveform and Edge Displays. Channels with a "fJ" symbol will 
display glitches, others will not. Glitch capability is limited to 
Channels 3 through O. To activate a given channel, first press "2" to 
move the cursor to Item 2; then key "3" or 112" will move the cursor to 
the corresponding channel and activate it ■ Or, use the"<-" and"->" 
cursor keys to move to the desired channel, then press any other key 
except "X" to activate it. To deactivate the channel, press the "X" 
key. Press <SPACE> to leave this item. 

This specification affects only the display format; it has no 
effect on data collection (data is always collected on all channels) or 
triggering. Glitch display can be activated only for channels also 
active in Item 1. 

Item 3) Trigger Event 

When the Omni encounters the word entered in this item in the data 
stream, it will trigger, stop data collection after the specified number 
of additional samples, and display the collected data. To set the 
trigger condition for a given channel, move the cursor to that channel ■ 
Keys "F", "E", • •• "2" will move the cursor to the corresponding 
channel, or the"<-" and"->". cursor keys may be used. For each 
channel, enter a "l" to choose a high logic level as the recognition 
condition, or a "O" to choose a low level ■ Enter an nxn to choose a 
"don't ~are" condition. Item 3 defaults to all "don't cares" on power­
up. 

After entry, the trigger word also appears in hexadecimal notation 
at the right of Item 3. "Don't care" bits are valued at O in the 
translation to hexadecimal. To enter the trigger word directly in 
hexadecimal, press <RETURN> to move the cursor into this field from.the 
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binary field. Direct hexadecimal entry does not allow "don't cares." 

Press <SPACE> to leave this item and return the prompt-cursor to 
the lower left. 

Item 4) Glitch Event (g) 

Any of the four channels in Group w can enter into the recognition 
event by entering a 111" when the cursor is positioned at the desired 
channel. No glitch is an "X". The cursor positioning commands are the 
same as for Item 3. Unlike the Trigger Event, however, the glitch 
channels operate on an OR logic condition. If any one (or more) of the 
selected glitch channel detects a glitch, recognition occurs. 

Item 5) Trigger Qual. 

Trigger qualification can be specified by entering a ''O" or "l" in 
this item. "X" disables trigger qualification. 111" indicates that the 
probe Tr£gger Qualify line must be at a high logic level before an event 
can be recognized; when the input line is at a low level, all data input 
to the event recognizer is ignored. ''O" indicates the opposite 
condition, that is, the event can only be recognized when the Trigger 
Qualify input is at a low level. Essentially, the Trigger Qualify acts 
as a 17th channel (or as a 33rd channel when the 32 channel option is 
installed) for tfigger event recognition. 

To use Trigger Qualification, Line Ton Probe Pod B (right pod) 
must be connected to the trigger qualifying signal. 

Item 6) Trigger Point 

A 1OOO-sample trace is collected about the trigger event during 
each data collection run. The number of samples that the trace extends 
past the trigger event (which normally corresponds to Sample 0) is 
specified with this item. A value of 90 will cause 90 samples to be 
saved after the trigger, and thus approximately 900 before. A value of 
500, the default condition, puts the trigger event approximately in the 
middle of the collected data. 

Item 7) Occurrence I 

This specifies the number of times the trigger event must occur 
before recognition takes place. An occurrence is counted each time the 
trigger pattern goes from a state where the signal does not match the 
trigger pattern, to one that does match the trigger pattern. The length 
of time for a match or no-match condition has no bearing on the 
occurrence counting. Selection of 1 to 15 occurrences is supported. 

·ltem 8) Delay 

Usually data will be collected immediately around the trigger 
event. However, if data is to be collected at some time period after 
the trigger event, then a delay can be specified. This will skew the 
collected data some specified time after the trigger. The delay can be 
specified as a certain number of sample clocks or as an absolute time 
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value. Absolute time delay is selected by using suffixes to indicate 
time units: "ns" or "n" for nanoseconds; "us" or "u" for microseconds; 
"ms" or "m" for milliseconds; and "s" for seconds. No suffix implies 
that the delay parameter represents number of samples, rather than time 
units. Depending on the sample rate, the delay can range from 16 
microseconds to 34 seconds. Only positive delay values are accepted. 
The delay and timeout resources are shared, so that when either is 
selected, the other is disabled. 

Item 9) Timeout 

this function provides a means of detecting when a certain pattern 
(which normally occurs repetitively) is absent for a specified time or 
longer. The pattern is entered in Item 3, Trigger Event, and the time 
limit, called the Timeout period, is specified in Item 9. If a Timeout 
period goes by during which the (normally repetitive) event has not 
occurred, then a trigger Will be generated and data collected. 

For example, consider the case of a microprocessor-based controller 
which is required to poll several input devices periodically. If the 
controller fails to respond to a service demand Within a certain time, a 
fault condition occurs. This can be caused by the processor getting 
"tied up" spending too much time on one task. To solve the problem, it 
is necessary to identify which task is tying up the processor when a 
fault - failure to poll the input device - occurs. Set up the Omni to 
collect microprocessor addresses, which Will identify program tasks. 
Set up the triggering so that Item 3, the Trigger Event, corresponds to 
polling of the critical imput device. For the Timeout period, enter a 
time value equal to the normal interval between the polls of the input 
device. Then when the input device is not polled on schedule, the Omni 
Will execute a trigger sequence, that is, halt data collection and 
display the data. The addresses of the offending time-consuming task 
will be captured in the data. 

The Timeout period depends on the Sample Rate and can vary from 16 
microseconds to 34 seconds. It can be specified either as a certain 
number of sample clocks or in time units. Enter time units in the same 
way as described above for Delay, Item 8. The Delay and Timeout 
resources are shared, so that when either is selected, the other is 
disablect. 

Item A) Clk Qualify 

Sampling normally occurs on every cycle of the signal (external or 
internal) being used as the sample clock. If there are periods when 
data collection should not be performed• the Clock Qualify line can be 
used to limit the collection to only the desired periods. For example. 
it may be desired to collect only data bytes sent to a particular I/0 
port. This may be achieved by using the I/0 write strobe as the 
External Clock, and using the decoded port select signal in the port 
circuitry for Clock Qualify. 

Entry of a "l" in this item causes data to be collected only when 
the Clock Qualify line is high. A "O" enables data collection only when 
the Clock Qualify line is low. If no qualification is desired. enter an 
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"X" to specify the "don't csre" condition. 

To use Clock Qualification, Line Con Probe Pod B (right pod) must 
be connected to the clock qualifying signal. In the example above, that 
would be the decoded port select signal. 

Item B) Ext Clock 

When synchronous data collection is to be performed, the External 
Clock selection should be used and the desired sampling edge specified, 
If the sample is to be saved on the low to high transition of the clock, 
enter a "l" (positive going) edge. A negative going edge is selected 
with a "0" entry. To deselect the External Clock, either enter "X" in 
this item or specify an Internal Clock Sample Rate in Item C. 

To collect data with an External Clock, Line Con Probe Pod A (left 
pod) must be connected to the signal in the equipment under test that is 
to be use~ as the clock signal. 

Clock rates up to 20 MHz (50 nanoseconds) are supported, 

Item C) Sample Rate 

When the Internal Clock is used, a Sample Rate must be chosen, The 
Sample Rate can be varied from 50 nanoseconds (20 MHz) to 32 
milliseconds (30 Hz). For high speed data collection, rates of 50ns, 
l00ns, 200ns, and 500ns sre available, If a rate that is not available 
is selected, then the next faster available rate will be used, Slower 
rates can be selected in one microsecond intervals up to 32.766 
milliseconds, To specify the sample rate, enter the desired rate 
followed by a time unit suffix, "n", "u", "m", "ns", "us", "ms", or 11s 11

• 

Item D) Recog Mode 

The Recognition Mode may be Latched or Unlatched. That is, trigger 
recognition can be performed on data as it passes through the 
recognizer, or the data can be latched by the sample clock prior to 
recognition, The Unlatched mode is appropriate when high speed signals 
of potentially short duration are being detected, The Latched mode 
should be used when monitoring a data bus type circuit, where data is 
considered valid only during the clock edges. Selecting this item 
toggles (changes) the Recognition Mode from Unlatched to Latched, and 
vice-versa. 

Item E) Recog Function 

The sixteen data channels and four glitch channels are organized 
into five groups labeled "z", "y", "x", "w", and "g". These groups may 
be combined via this item to allow triggering on various logical 
combinations of data and glitch. For example, Function 1, "z.y.x,w.g", 
requires that the 16 data lines match the Trigger Event specified in 
Item 3, and that a glitch appear on one of the channels specified in the 
Glitch Event, Item 4. 
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If no Glitch Event (Item 4) is specified, Function 1 will be 
satisfied when only the Trigger Event (Item 3) is satisfied. 

Function 2, "(z.y.x.w)+g", requires only that the Trigger Event .2.! 
the Glitch Event be satisfied; not both. 

Function 3 is "('z.y) .x.w". Here the overbar symbol means logical 
negation, that is, "z" means "not z". Since "g" does not appear, 
Function 3 applies only to the sixteen data lines. It is satisfied 
when, and only when, all three of the following conditions are true: 
Channels F through C (Group z) do not match the data event; Channels B 
through 8 do not match the data event; and Channels 7 through O (Groups 
x and w) do match the data event. "Not match" for a group means any one 
(or more) bits within that group failing to match. 

Function 4, "(z.y)+(x.w)", also applies only to the sixteen data 
lines. It is satisfied when either Channels F-8 (z and y) or Channels 
7-0 (x and w) match the data event. 

Function S, "z.y.(:ir+w)", is satisfied when Channels F-8 (z and y) 
match the data event, and either Channels 7-4 (x) or Channels 3-0 (w) 
match the data event. 

If Function 6, External Trigger, is selected, then you must also 
specify the edge.of the trigger pulse on which triggering shall occur. 
Enter "l" for a leading (rising) edge or "O" for a trailing (falling) 
edge. 

To use an External Trigger, Line Ton Probe Pod A (left pod) must 
be connected to the signal in the equipment under test that is to be 
used as the trigger signal. 

When you are viewing the Trigger Menu, you can access Help Pages 
for Items 1, 2, etc. by typing "?l ", "?2", etc. Press <SPACE> after 
viewing a Help Page to return to the Trigger Menu itself. Help 
information for the Trigger Menu as a whole may be accessed by typing 
"?T" when the prompt-cursor appears at the lower left corner of the 
screen. 

10.9 COMPLEX TRIGGER 

The Complex Trigger Function allows triggering on a sequence of 
trigger words, rather that a single trigger word. This capability is 
also called sequential triggering or multilevel triggering by some logic 
analyzer manufacturers. 

Type "Z" to bring up the Complex Trigger Menu, which controls this 
function. Exhibit 10-3 shows an example of the menu. 
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Exhibit 10-3. Complex Trigger Menu. 

Calling up the menu enables the Complex Trigger Function.· When it 
is enabled, the trigger pattern is governed by the entries on this menu 
rather than by Item 3 on the Trigger Menu. 

The successive trigger words are entered in Items 2 through 8 of 
the Complex Trigger Menu. The trigger words must occur in the order 
listed for triggering to occur. That is, each trigger word must have 
appeared in the data stream and been recognized before the Omni is ready 
to recognize the next word. The Omni initially watches for the first 
word. Once that has been recognized, it watches for the second word 
and so on. After the last word occurs and is recognized, the Omni 
completes the data collection and displays the data in the usual way. 

There is a delay following recognition of a word in the trigger 
sequence, called the Setup Delay, until the Omni is ready to recognize 
the next word. Occurrences of the next word in the data stream before 
the Setup Delay has expired will be ignored. The Setup Delay has a 
minimum value of 100 microseconds. Greater time values may be entered 
in the menu. 

The menu also includes a Trigger Mask (Item 1) to limit recognition 
to a subset of the total sixteen channels. 
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Accessing Item 9 toggles the Complex Trigger Function between 
enabled or disabled status; when it is disabled, normal triggering as 
defined on the Trigger Menu governs the trigger method. The Complex 
Trigger Function is disabled at power-up. 

10.10 EXAMPLE OF COMPLEX TRIGGERING 

Many computer software bugs can be localized by collecting the 
addresses of instructions as they are executed. Studying the flow of 
program control will reveal which part of the program is at fault. 

However, programs often use nested subroutines, or subroutines 
called from several places in the main program, to perform a complex 
series of steps. In such cases, there are many "execution paths" that 
the program may take ■ Often a troublesome problem is associated with 
only one execution path. A subroutine may perform correctly sometimes 
but misbehave other times, depending on where it was called from in the 
main program. To locate the bug, you need to focus data collection "by 
path." 

The Complex Trigger Function allows you to do exactly that ■ Enter 
as trigger words the calling addresses of the successive subroutines in 
the path you wish to study. The Omni will collect data around the last 
trigger word, which becomes Sample O (typically) in the displayed trace. 
The sample data will reveal the system behavior that results from that 
particular path. 

10 .11 COMPLEX TRIGGER ~ ITEMS 

Item 1) Trigger Mask 

Not all probe lines need be included in the trigger words. A "l" 
in a given bit position means that the corresponding bit is considered 
by the recognition circuits. An "X" means the bit is ignored. The 
Trigger Mask word is also automatically displayed to the right in 
hexadecimal notation, where each "X" is assumed to have a value of O. 

Items 2) Trigger Word and Setup Delay 

Enter the first trigger word following the "2) ". If you wish to 
specify a setup delay value, use the right-arrow cursor key to move the 
cursor to the Setup Delay field. Merely press <RETURN> to get the 
default delay of 100.0 microseconds. 

Items 3) through 8) 

Enter additional trigger words and (if desired) setup delay values 
in these items. 

Item 9) Complex Recognizer Enabled/Disabled 

Accessing this item toggles the Complex Trigger Function between 
enabled and disabled status. The disabled condition allows you to 
return to single word triggering (that is, Item 3 on the Trigger Menu 
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again determines the trigger word) without disturbing the list of words 
in Items 2 through 8. 

10 .12 COMPLEX TRIGGER. ~ ~ 

To display information for the Complex Trigger function, type "?Z'' 
when the prompt-cursor appears at the lower left corner of the screen. 
To display information for the individual menu items when viewing the 
menu, type "?l ", "?2", and so on. After viewing the information, press 
<SPACE> to return to the menu itself. 
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11. OPTIONS MENU 

..!h!. INTRODUCTION 

The Options Menu (Exhibit 11-1) controls various aspects of the 
data displays: output number baset sample or time units on the Waveform 
and Edge Displayst display Sample or Reference Memory, enable modem, 
probe type (inverting or non-inverting)t and disassembly status lines 
available or not (for the Instruction Disassembly function). 

To call up the Options Menu, type "O<RETURN>". 

Exhibit 11-1. Options Menu as it appears on the screen. 
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11.2 ~ ITEMS 

To enter a new parameter in one of the menu items, type the item 
number in order to move the prompt-cursor to the desired item. 
Following are explanations of the individual menu items: 

Item 1) Output number base: 

The default output number base is hexadecimal. The menus and 
displays that show the data in alphanumeric form (Dump, Matrix, and 
Trigger Setup) use the number base specified in this item. 

In hexadecimal notation, the 16 channels are organized into groups 
of four, and the value contained in each group (each four bits) is 
displayed as a single hexadecimal digit. The number base can be changed 
to octal (groups of 3 channels), binary (each digit represents one 
channel), or one of two decimal representations. The signed decimal 
grouping treats the Channel F value as the sign bit of a twos complement 
number. The unsigned decimal format allows only positive values. 

After moving the cursor to this item by typing 1, enter one of: 
octal, B for binary, D for decimal, H for hexadecimal, 0 for octal, or U 
for unsigned decimal. 

Item 2) Sample/Time units on waveform: 

The Waveform and Edge Displays contain a graticule scale which 
indicates the position of each sample displayed relative to the trigger 
event. This scale can be labeled either with number of samples before 
and after the trigger point, or with time units before and after the 
trigger point. Selecting Item 2 toggles the scale labeling between 
these two cases. When time units are selected, the values will be 
displayed in an engineering format to three significant digits. Units 
of nanoseconds (ns), microseconds (us), or milliseconds (ms) are used. 

Item 3) Display Sample or Reference Memory: 

When data is collected, it is automatically stored in Sample Memory 
and displayed in the current display mode. It is also possible to load 
previously collected data into Reference Memory, and then display the 
Reference Memory. This facility is useful for making comparisons 
between two sets of collected data, such as when the correlation 
function is used. 

There are two ways of loading data into Reference Memory. It may 
be transferred there from Sample Memory, or it may be retrieved from a 
file previously saved on disk. Sample to Reference transfer is perormed 
via the File Menu. File to Reference transfer can be done from the 
Correlation Menu or File Menu. 

When Reference Memory is selected, all subsequent displays will 
show it until Sample Memory is again selected or a new data collection 
is made with the G or "•" Commands. Selecting Item 3 toggles between 
Sample Memory and Reference Memory. 
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Item 4) Enable modem: 

The Omni 4's internal modem is controlled by this item. Accessing 
Item 4 toggles the modem status between enabled and disabled. When the 
Logic Analyzer Program is first loaded, the modem is enabled for input 
(that is, input from a phone line through the modem. will be treated the 
same as input from the keyboard) and disabled for output (output is sent 
to the screen, not the modem line). 

"Enable" (first access of Item 4) enables the output as well as the 
input. This allows you to dial up the Omni from a remote location, and 
control the logic analyzer from the remote location. Transmit "O" to 
access the Options Menu, then 114" to enable the modem. Once enabled, 
output goes to the modem rather than the screen. This gives you full 
control of the Omni over the phone connection. Note that until this 
full control is established, you will not have any feedback over the 
phone line - you have to send the "O" and "4" blind. 

"Disablen (second access of Item 4) disables both modem input and 
output, returning full control to the local keyboard and screen. To 
return to the initial state, it is necessary to exit and then reload the 
Logic Analyzer Program. 

Item 5) Probe type: 

The Omni software can accomodate either inverting or non-inverting 
probes. Accessing this item toggles a software switch between Inverting 
and Non-inverting settings. All present OmniLogic probes are of the 
Inverting type, which is the default case for this item. This function 
is included to provide flexibility for possible future options. It may 
presently be used where display of negative logic is desired. 

The Help Page for the Options Menu may be accessed with "?O". When 
viewing this Menu, Help Pages for Items 1, 2, etc., may be accessed with 
"?l ", "?2", and so on. When you finish viewing the Help information, 
press <SPACE> to return the Options Menu itself. 
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12. GO AND STA.RT DATA COLLECTION 

.ll.:.1 INTRODUCTION 

After the probe leads are connected to your circuit and you have 
entered the appropriate data collection parameters in the Trigger Menu, 
type "G" to initiate data collection. 

The G Command instructs the analyzer to start collecting data using 
the sampling characteristics defined on the Trigger Menu. With each 
active clock edge, one sample is collected from the data input lines and 
loaded into the Sample Memory. The analyzer collects data until the 
trigger event specified on the Trigger Menu appears. It collects a 
defined number of samples after the trigger event, and then data 
collection stops and the data is displayed. 

The number of samples collected after the trigger event is defined 
by the number specified in Trigger Menu Item 6, Trigger Point. The 
sample collected at the time of the trigger event is labeled Sample O in 
the data display. Thus in the display, the Trigger Point is the number 
of samples from Sample Oto the end of the trace. 

If the trigger event does not occur, the analyzer will continue to 
collect data indefinitely. Likewise, if the sample clock stops after 
the trigger event but before the number of samples called for in Item 6 
has been collected, the analyzer will not complete the trace. !n both 
of these cases, the analyzer appears to be waiting. If triggering does 
not occur after a reasonable length of time, press any key except 
<SPACE> to end data collection, initiate a manual trigger, and display 
the data collected to that point. 

Pressing <SPACE> will abort sample collection without a trigger and 
return to the Trigger Menu. The data in the Sample Memory will not 
change. 

The"•" Command, like the G Command, also initiates data 
collection. However, before starting data collection, it enters the 
sample marked by the sample-cursor as the trigger word in Item 3 on the 
Trigger Menu. See Chapter 10 for more information on the"=" Command. 

12.2 DISPLAY FORMATS 

Command 

w 
E 
D 

I 
H 
M 

Omni Operating Manual 

Display~ 

Waveform. Display 
Edge Display 
Dump Display - hexadecimal, octal, binary or 

decimal listing 
Instruction Disassembly Display 
Histogram Display 
Matrix Display 
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Upon completion of data collection, the Omni will disp_lay the data 
in Sample Memory in one of the above six display modes - whichever one 
was used last. On first use, the Waveform Display appears. A different 
display mode may be selected by typing the appropriate command letter, 
"W'', "E", "D", "I", "H", or "M'', followed by <RETURN>. 

To display the Help Page for the G Command, type "?G". 
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13. WAVEFORM DISPLAY 

13 .1 INTRODUCTION 

The Waveform Display gives a simultaneous view of up to 16 channels 
of digital information that was collected by the Omni. The format is 
similar to timing diagrams found in digital data books, and is 
particularly helpful for hardware troubleshooting. It is the default 
display mode at turn-on. The collected data will be shown in the 
Waveform Display until another display format is chosen • 

.!1.:! SCREEN CHARACTERISTICS 

An example of the Waveform Display is shown in Exhibit 13-1. The 
display is SO samples wide. A sample was collected for each cycle of 
the signal used as the sample clock. Since the maximum clock rate is 20 
MHz, the finest resolution that can be obtained with the Waveform. 
Display is 50 nanoseconds between samples. (Waveform. details can be 
viewed to higher resolution by using a wideband oscilloscope and the 
Trigger Output signal; see Section 7.) 

Features of the display are: 

Channel labels - at left side of the screen. The default labels 
are DF, DE, and so on through DO. The additional 16 channels 
available with the 32 channel option default to AF through AO. 
The labels shown in Exhibit 13-1 (DATA7, MREQ, etc.) are 
user-selected labels entered using the N Command. 

Waveforms - show the high and low logic levels versus time on the 
sixteen data lines. 

Glitches - shown as narrow pulses if glitch display is enabled and 
any glitches are present. 

Movable highlighted cursor - marks Sample -466 for further 
attention. 

Graticule - beneath the waveforms. Identifies the samples 
relative to the trigger point, and is calibrated with either 
sample numbers or time divisions (as specified in the Options 
Menu, 0 Command). 

Hex codes - in vertical columns beneath the graticule. Represent 
the hexadecimal equivalents of the data above. 11FC52" is 
marked by the cursor and highlighted by increased brightness. 
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Exhibit 13-1. Waveform Display. The W Command causes data in the 
Sample Memory or Reference Memory to be displayed in this format. 
if the data was last displayed in this form.at, new data collected 
response to the G Command will also be displayed in this format. 

Also, 
in 

Rate - indicates either the Sample Rate 1 when the Internal Clock is 
being used, or External Clock 1 when an external source is 
being used as the sample clock. When Internal Clock is used, 
the Sample Rate is expressed in time units, typically 
nanoseconds. 

Delay - indicates the Delay (of Sample O compared to the Trigger 
Event), a data collection parameter specified on the Trigger 
Menu (Item 8). 

Window - to the right of the Delay. The bright area shows where 
the 80 samples displayed lie in the total 1000-sam.ple memory. 
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SM or l!M - to the right of the window. Indicate whether the data 
being displayed is in the Sample Memory or the Reference 
Memory. 

<G or G> - if shown, mean there are glitches to the left or the 
right of the cursor. <G> indicates glitches to both the right 
and the left. 

ref: - indicates the sample used as a reference by the X 
Cotllllland, that is, the sample from which an interval is 
measured. The X Command is a utility that calculates the 
interval, in number of samples and time, beween two samples. 
See Section 16 for further information on the X Command. 

cur: - identifies the position of the highlighted sample cursor 
relative to the trigger event (Sample 0). When the Internal 
Clock is used, the time interval between the sample marked by 
the cursor and Sample O can be calculated, as it is equal to 
the number of samples in the interval times the Sample Rate. 
The Omni calculates the time interval and displays it here. 

? - at lower left. This is the home position of the prompt­
cursor. Commands entered by the user appear here. 

Enter: - shows the commands which may be entered next. Press 
<SPACE> or the "T" key to return to the Trigger Setup Menu. 

il:1 COMMAND FORMATS 

The Waveform Display is controlled by the W Command by using one of 
the following command formats: 

W Display data as waveforms while centering the sample marked 
by the highlighted cursor in the previous display. For 
example, if you wish to move the display 20 samples to the 
right, move the cursor 20 samples to the left of center and 
press "W<RETURN>". The display will then move 20 samples to 
the right. 

Wx Display data as waveforms starting from sample x. xis 
entered in sample number units. If Internal Clock is being 
used, x may also be entered time division units. 

Wx,y Display data as waveforms from sample x to sample Y• 

WALL Display data as waveforms from first through last sample. 

The form Wx: will always cause 80 samples (less a few covered up by 
the channel labels) to be displayed. The form Wx,y will always cause at 
least 80 samples to be displayed, even if y-x is less than 80. 

If y-x is greater than BO, samples from x to y will be be "time 
compressed 11 to provide a 11zoom lens" view of the data that is useful for 
finding data patterns of interest quickly. However, this feature must 
be used with care for the following reasons. 
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With compression, the HI or LO level shown in each column on the 
screen for a given channel may really be the algebraic sum of several 
samples. For example, if y-x is equal to 240, then each of the 80 HI or 
LO levels shown for Channel O really represents three samples in the 
data- If the three samples are all HI, then the screen will show a HI, 
and fairly represent the data. On the other hand, if the three samples 
have a mix of logic levels, then the logic level displayed will be based 
on "majority rule." 

The compressed display depicts the data most fairly when there are 
few transitions in the data. If there are many closely spaced 
transitions, detail is lost • 

.!l.d, COMMAND EXAMPLES 

Wl6 Display data as waveforms starting at sample 16. 

W-500, 500 Display "zoom" of data from samples -500 to 500. 

W300ns Display data from the sample at 300 nanoseconds. 

il.!1 DISPLAY CONTROL KEYS 

The highlighted cursor or the entire display may be scrolled right or 
left using these keys: 

< scroll the display horizontally one page to the left with an 
overlap of 5 samples (75 samples displayed) 

> scroll the display horizontally one page to the right with an 
overlap of 5 samples (75 samples displayed) 

<- move the highlighted cursor one sample to the left 

-> move the highlighted cursor one sample to the right 

These four keys auto-repeat; hold the key down for repeated scrolling 
or cursor movement. 

To display the Help Page for the W Command, tYPe "?W<RETURN>". 
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14. EDGE DISPLAY 

14.1 INTRODUCTION 

The Edge Mode Display is a compressed version of the Waveform 
Display. It might also be called the Transition Display, because it 
displays transitions only. Most repeated occurrences of the same 
pattern are not displayed, thus showing samples only where the data is 
changing. If three or more consecutive samples in all the channels to 
be displayed remain in a steady state, the data will be removed and the 
display will show a vertical blank where the steady state data was 
removed. 

Exhibit 14-1 is an example of the Edge Display as it appears on the 
screen. 

Exhibit 14-1. Edge Display. The E Command causes data in the Sample or 
Reference Memory to be displayed in this format. 
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14.2 SCREEN CHARACTERISTICS 

Explanations of the data appearing in the Edge Display are given 
below. 

Channel labels - left side of screen; default to the DF, DE••• Dl, 
DO shown on the Trigger Menu and on the probes at power-on. 
The labels shown here (DATA-7-, MREQ, etc.) are user-specified 
labels which were entered with the N Command. 

Waveforms - for active channels show the transitions versus time on 
the displayed data lines. Time periods where no transitions 
occur (i.e., 3 or more consecutive samples without a change 
in any of the selected channels) are displayed as a single 
blank column. The value of the data during the time period 
represented by the blank column is the same as the data shown 
in the column to the left of the blank. 

Glitches - shown as narrow pulses on the waveforms if glitch 
display is enabled and any glitches are present. 

Highlighted cursor - marks a particular sample. Its location is 
displayed to the right of "cur:. It is movable with the <­
and -> keys. 

Graticule - located beneath traces; identifies the samples relative 
to the trigger point. Calibrated in either sample or time 
divisions (specify on Options Menu, 0 Command). Time 
divisions are dependent on Sample Rate selection. 

Hex codes - in vertical columns beneath the graticule; represent 
the hexadecimal equivalents of the data above. The hex value 
of the sample marked by the cursor is highlighted by increased 
brightness. 

Rate - indicates either the Sample Rate, when the Internal Clock is 
being used, or External Clock, when an external source is 
being used as the sample clock. When Internal Clock is used, 
the Sample Rate is expressed in time units. 

Delay - indicates the Delay (of sample O compared to the trigger 
event), a data collection parameter specified on the Trigger 
Menu. 

Window - to the right of the Delay shows where the 80 samples 
displayed lie in the total 1000-sample memory. 

SM or RM - to the right of the window indicate whether the data 
being displayed is in the Sample Memory or the Reference 
Memory. 

<G or G> - if shown, mean 
right of the cursor. 
and the left. 
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ref: - indicates the sample that the X Command uses as a reference 
point to measure from. The X Command is a utility that 
calculates the interval, in number of samples and time, beween 
two samples. See Section 16 for further information on the X 
Command. 

cur: - identifies the position of the highlighted sample cursor 
relative to the trigger event (Sample O). When the Internal 
Clock is used, this part of the display also shows the time 
interval between the sample marked by the cursor and the 
trigger event. 

?_ - at lower left is the home position of the prompt-cursor. 
Commands entered by the user appear here. 

Enter: - shows the commands which may be entered next. Press 
<SPACE> or the "T" key to return to the Trigger Setup Menu. 

14. 3 COMMAND FORMATS 

The Edge Display is controlled by the E Command using one of the 
following command formats: 

E 

Ex 

Display data as compressed waveforms while centering the 
sample marked by the highlighted cursor in the previous 
display. 

Display data in Edge mode starting from sample x. xis 
entered in sample number units. If Internal Clock is being 
used, x may also be entered in time division units. 

Ex,m Display data in Edge mode starting from sample x and 
including only channels defined by min the edge transition 
algorithm. 

ll,:i COMMAND EXAMPLES 

E16 Display data in Edge mode starting at sample 16. 

E300ns Display data from the sample at 300 nanonseconds. 

li,:i DISPLAY CONTROL ~ 

The highlighted cursor or the entice display may be scrolled right 
or left using these keys: 

< scroll the display horizontally one page to the left 

- > scroll the displ~y horizontally one page to the right 

<- move the highlighted cursor one sample to the left 

-> move the highlighted cursor one sample to the right 
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These four keys auto-repeat; hold the key down for repeated scrolling or 
cursor movement. 

To display the Help Page for the E Command, type "?E". 
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15. NAME CCMMAND 

1i:.!. INTRODUCTION 

N, the Name Command, changes the channel names that label the 
traces in the Waveform Display, Edge Displ~y, and Signature Analysis. 
The Logic Analyzer initially shows labels DF, DE, ••• DO for the standard 
16 channels. If the 32 channel option is installed, labels AF, AE, ••• AO 
appear for the additional 16 channels. If signals such as a read pulse, 
write pulse, and two address lines are being probed, more descriptive 
names such as READ, WRITE, ADDRO, and ADDRl make interpreting the data 
much easier. 

New labels installed with the N Command also appear automatically 
on the Trigger Menu. On the Trigger Menu, the label for whichever 
channel the cursor is on appears under "Signal" when you are entering 
new parameters in Items 1 through 4. 

15.2 COMMAND FORMAT 

Use the N Command with the following format: 

N#xyz Name channel# as xyz 

# = channel indentifier F,E, •• 2,1,0 

xyz • any character string not over 15 characters long. Spaces are 
not allowed in the string; use underscore or hyphen 
characters instead. 

14.3 EXAMPLE 

N 2MFM-READ Name Channel 2 with the label "MF.M-READ". Each 
Waveform, Edge, and Signature Analysis Display, as well as 
the Trigger and Search Menus, will then contain this label 
instead of the default label, ''D 2". 

15.4 HELP~ 

To display the Help Page for this command, type "?N". 

Rev ■ D 
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16. INTERVAL CALCULATIONS 

1i:.!_ INTRODUCTION 

The X Command is a convenience feature that calculates the 
interval, expressed in time or number of samples, between any two 
samples. You provide the two end points of the interval, and the Omni 
calculates the time (if Internal Clock is being used) and number of 
samples between these points. The end points can be entered as 
parameters with the command, or the highlighted cursor can be used to 
mark them. 

ll.:1_ COMMAND FORMAT 

The X Command can be used in one of these formats: 

X Calculate the number of samples and time between the current 
highlighted sample and the reference sample. The reference 
sample is the sample marked with the cursor during the 
previous use of the X command. If the X Command has not been 
used since data was last collected, Sample O is the reference 
sample. 

Xm Calculate the number of samples and time between the current 
highlighted sample and sample m. 

Xm,n Calculate the number of samples and time between samples m 
and n. 

16.3 EXAMPLES 

X lOns 

X 10,20 

Calculate the number of samples and time between the 
current highlighted sample and the sample that occurred 
lOns after trigger. 

Calculate the number of samples and time between sample 
number 10 and sample number 20. 

These commands must be followed by a <RETURN> when they are entered. Do 
not type the space between the "X" and the "10"; it appears 
automatically. Note that when two parameters are specified, a comma is 
required to separate them. 
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(a) 

(b) 

Exhibit 16-1. Two uses of the Interval function (X Command). 
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Assume that Internal Clock is being used with a Sample Rate of 5 
microseconds. 'lben the command "X 10,20° will result in this display at 
the lower right corner of the screen: 

Delta Time: 10/50.0us 

Sample 10 and sample 20 are 10 samples apart, which is 50.0 
microseconds, given 5 microseconds between samples. 

It is possible to mix time and sample number units when using the X 
Command. Assuming the same 5 microsecond Sample Rate, the command 

X 10,125us<RETURN> 

will give the output "15/75.0us". Sample 10 corresponds to 50us, and 
125us corresponds to sample 25. 

In another format, assume the display cursor fs at sample number 
30. The command 

X 1 O<RETURN> 

will cause an output of "20/100.0us". Since only one parameter was 
provided in the command, the cursor position (30) was used as the left 
point of the interval and the 10 as the right point. 

Let us assume that the cursor was positioned on the leading edge of 
some waveform when the command "X 10" was given, and the cursor has 
since been moved to the trailing edge of the same waveform at sample 
number 65. The command 

X<RETURN> 

will calculate the interval of time between the cursor at last use of 
the X Command (30), and the current cursor position (65). The output in 
this case will be "35/155. Ous". Using this technique of cursor 
positioning in conjunction with the X Command, it is very easy to 
measure time intervals for waveforms, parts of waveforms, or for time 
between events. For waveform timing, the display will usually be Timing 
or Edge. With the Dump Display, intervals between events may be 
calculated by marking them with the cursor and using "X<RETURN>" twice. 

Another powerful technique is to use the Locate function to 
position the cursor on the events of interest, and the X Command to 
calculate the interval between them. After the first occurrence of the 
pattern has been found, issue "X<RETURN>" to establish the cursor 
position as a point of reference. (Ignore the output of this first X 
Command; we are only interested in establishing a reference for the next 
use.) Then find the second event with the Locate function. Finally, 
use "X<RETURN>" again to give you the number of samples and time between 
the first and second events. 
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The Help Page for the X Command may be obtained by typing "?X". 

Rev. D 

Omni Operating Manual 16-4 Interval Calculation 

n 
n 
n 
n 
n 
n 
n 
n 
n 
n 

" 
" 
" n 

" n 
n 
n 

" 

Ka
yp
roJ
ou
rna
l



u 
·LI 

u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 
u 

17. DUMP DISPLAY 

11.!.l. INTRODUCTION 

This display, illustrated in Exhibit 17-1, shows the data in Sample 
Memory as a listing in hexadecimal, binary, decimal, or octal format. The 
radix (base) of the display defaults to hexadecimal, but can be changed to 
binary, decimal, or octal using the Options Menu, 0 Command. 

4Hf.' 71:ffi U::l 7ffil 7601 7ffil 7601 F003 7601 C071 7601 ff(ll 7501 7501 7601 7Ef11 
nro 71:ffi 8070 7ffi1 7601 7601 7611 E%:1 7601 CB(}; 7G01 C23'3 7601 7ffil 7601 7W1 
E<'.{1,::1 7Effl C071 7ffi1 7601 7ffil 7601 7600 7E.01 1807 7601 457A 7601 7601 7601 7E.01 
7fJF 7Effl E[,:=u 7501 0013 7Ef11 7ffil 7601 7E.01 FB48 7601 0078 7601 7ffi1 7601 7E-.Bl 
76ff1 7Effi am 7601 (239 7E-.01 7601 7601 7601 EOOl 7ffil DHf; 7601 7E,01 7601 7E-m 
7E.OO 7Effi cror 7ffi1 457H 7601 <?ffil 7ffi1 7601 l'JF02 7601 8170 7W1 7ffi1 ?E,01 7601 
7E.OO 7Effi D':ff1 7ffi1 0078 7501 7E,01 7E,01 7601 F003 7E,01 C071 7ffi1 l:l.l::B ?E,01 7ffil 
7fa1 7600 [001 7ffi1 DHf, 7ffi1 ?ffil 7Ef11 7501 E1=0:'l 7ffi1 CBl1:-, 7ffl1 C2~8 7Efll 7E.01 
7E.00 7@ '1FEl2 7601 8170 7E.01 7(,01 7ffi1 7W1 7EOO 7W1 1807 7501 l'l:,?A 7ffi1 7ffil 
7Ef{1 7Effi FEK:: 7601 am 7(,01 f{)]:: 7ffil 7E-f11 7Ef11 7ffil F848 7ffil 0078 7Ef11 7£.£11 
7fffi 7600 E~ 7601 CBEf, 7ffi1 CZ:-8 7f.01 7£.£11 7Ef11 7ffi1 [(01 7ffi1 DH£ 7501 7601 
7({{1 7&00 7£00 7E.01 1807 7ffi1 4:,?A 7f:L11 7f.81 7ffil 7f:fH '1F02 7ffi1 8170 7ffi1 7ffil 
7&00 ?Effi 7ffi1 7601 F8l'J8 7601 007B 7Ef1l ?ffil 7ffil 7601 FE03 7ffi1 Of71 7Em l{);f: 
7£ff1 ?Effi 7Et11 7Ef11 EOOl 7Et11 Dlffi 7ffi1 7601 7601 7Ef11 E<x!<:1 7601 CBff, 7ffi1 CZ::--19 
7E£{l 7£-00 7Wl 7E,01 4Ftf' ?Wl 81 ?B 7601 7601 7601 7E-f11 71:.00 7Ef11 1807 7601 "1:,7R 
7ff{1 7Effi 7Ef11 7E21 FEffi 7ffi1 0:171 7ffi1 fft33 7ffi1 7ffil 7ffi1 7ffi1 F8<'l8 7ffi1 007B 
7f:ff1 7E.(f1 7ffi1 7ffi1 ECfl.'1 7ffi1 CTlEl"i 7601 C2J3 7ffi1 7ffi1 7E.01 7ffi1 £001 7Ef11 Dlffi 
7HlJ fIH: 7W1 7E.01 7fffi 7601 1807 7ffi1 4:>?f'.I 7ffil 7ffil 7ffi1 7Ef11 "1H:f' 7ffi1 8170 
7ff{1 w'9 7Ef11 ?ffil 7ffi1 7ffi1 FB<'.!8 ?E.01 OOFB 7ffi1 7E,01 7501 7Ef11 F003 7ffi1 8170 
7E.OO 4578 7Ei11 7W1 7ffi1 7601 [001 7601 OH:£, 7601 7ffi1 7ffi1 7601 E~ 7Efll f: 170 
7E,£{1 007B 7Et11 7E.Bl 7601 7ffil 4F02 7611 8170 7601 7Efil 7ffi1 7Ef11 ?E.00 ?E,01 Bl 70 

Rate OOrniAL IA-lay 0 L__~-----.J ~M ref:0 
l Ent&r: C,D,E,F,G,H, l,l,M,N,O,P,S, T,W,X,Z, =, 7,sp cur:286 

Exhibit 17-1. Dump Display. The D Command causes data in the Sample or 
Reference Memory to be displayed in this format. Also, if the data last 
displayed was in this format, new data collected in response to the G or 
"•" Command will be displayed in this format. The sample cursor is a 
"<" symbol next to the highlighted sample in the fifth column. 

Omni Operating Manual 17-1 Dump Display 

Ka
yp
roJ
ou
rna
l



The same data can be re-displayed in the new base after changing 
the base; it is not necessary to collect a new sample. This flexibility 
greatly eases interpretation of the data. For example, control lines 
are usually best represented in binary, while data lines demand hex or 
decimal. 

Exhibit 17-2 shows the same data as 17-1, but re-displayed in 
binary notation. The Omni automatically centers the display about 
whichever sample was marked by the cursor in the previous display. 

When the 32 channel option is used, the two banks (of 16 channels 
each) can be simultaneously diaplayed with different number bases. 

The Dump Display is normally used with External Clock to collect 
state data. 

0111 0110 EllE 1111 
0111 0110 fllfl 1111 
0111 0110 flm 1111 
0111 0110 Elm 1111 
01110110EIB31111 
01110110{fJ:131111 
0111 0110 EBll 1111 
0111 0110 Ell:O 1111 
0111 0110 EBll 1111 
0111 0110 EBll 1111 
0111 0110 EBll 1111 
0111 0110 Elm 1111 
01110110EIB31111 
0111 0110 EBll 1111 
0111 0110 EBll 1111 
0111 0110 EllE 1111 
0111 0110 EllE 1111 
0111 0110 til:ll 1111 
0111 0110 ml 1111 
0111 0110 flm 1111 
Mil 1101 0011 1010 

1100 0010 0011 1011 
0100 0101 0111 1010 
E11E Ellfl 0111 1011 
1101 £ml OCH3 0111 
1111l 1111 0111 0010 
110011111 0111 0011( 
1100 1 ff.fl EHl3 01 10 
Eml lEffl EHl3 0111 
1111 um 0100 1010 
1110 1101 EHl3 0011 
0100 1111 0000 0010 
1111 1011 0000 0011 
1110 1001 0000 0110 
0111 0110 Ellfl 1110 
011101100000 1111 
0111 0110 Elf-fl 1111 
0111 0110 Elf-fl 1111 
0111 0110 0000 1111 
0111 0110 ElBJ 1111 
01110110tlJl31111 
01110110Elil31111 

0111 0110 Elll:1 1111 
0111 0110 Elfl:l 1111 
0111 0110 EllE 1111 
0111 0110 f(0J 1111 
0111 0110 Elfl:l 1111 
0111 0110 f:0Jl 1111 
0111 0110 f:0Jl 1111 
0111 0110 EBJ:l 1111 
0111 0110 EBJ:l 1111 
0111011011£0 1111 
0111 0110 Ell£! 1111 
0111 0110 Elff.l 1111 
0111 0110 Eflfl 1111 
0111 0110 Elff.l 1111 
0111 0110 Elff.l 1111 
0111 0110 EIHl 1111 
0111 0110 EIHl 1111 
0111 0110 Ellll 1111 
0111 0110 Ellll 1111 
0111011011m 1111 
0111 0110 aJll 1111 

Rote EXTEJffl D:, I ay 0 L----"L----J 91 ref: 0 
l Enter: C,O,E,F,G,H,I,l,M,~,O.P,5,T,W,X,Z,~,?,sp cur:-5 

Exhibit 17-2. Dump Display of the same data as in the last exhibit, 
this time in binary form.at. The display is centered about the sample 
marked by the cursor in whichever display appeared previously. 
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11..:l SCREEN CHARACTERISTICS 

Explanations for the data appearing in the Dump Display appear 
below. 

Rate - indicates either the Sample Rate, when the Internal Clock is 
being used, or External Clock, when an external source is 
being used as the sample clock. When Internal Clock is used, 
the Sample Rate is expressed in time units. 

Delay - indicates the Delay (of Sample O compared to the Trigger 
Event}, a data collection parameter specified on the Trigger 
Menu. 

Window diagram - to the right of the Delay; shows where the samples 
displayed lie in the total 1000-sample trace memory. 

SM or RM - to the right of window; indicate whether the data being 
displayed is in the Sample Memory or the Reference Memory. 
Selected via the Options Menu, 0 Command. 

<G or G> - if shown, mean that there are glitches to the left or 
the right of the cursor. <G> indicates glitches to both the 
right and the left ■ 

ref: - indicates the sample used as a reference point by the X 
Command, that is, the point from which an interval is 
measured. The X Command is a utility that calculates the 
interval, in number of samples and time, between two samples. 
See Section 16 for further information. 

Enter: - shows the commands which may be entered next ■ 

cur: - indicates the current cursor position in sample number or 
time units relative to the trigger event. 

.!L.l COMMAND FORMAT 

The Dump Display is controlled by the D Command. Anytime the 
current display menu does not contain a D option, the data in trace 
memory may be displayed by using one of the following command formats: 

Dx Display data in Dump format, starting from sample x. 

D Display data in Dump format, centered on the current cursor 
position. 

17.4 EXAMPLE 

Dl6 Display data in Dump format, starting at sample 16. 
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.!.L1, DISPLAY CONTROL Y!§. 

The sample cursor is a highlighted"<" symbol. 'nte sample marked 
by the cursor is also highlighted by intensified brightness. lite cursor 
may be moved right, left, up, or down, or the entire display paged right 
or left, using these keys: 

< scroll the display horizontally one page to the left. 

> scroll the display horizontally one page to the right. 

<- move the cursor one column to the left. 

-> move the cursor one column to the right. 

1' move the cursor up one sample. 

+ move the cursor down one sample. 

To obtain the Help Page for the D Command, type "?D". 

Rev. D 
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18. CORRELATION 

lli,l INTRODUCTION 

The Omni has a Sample Memory and a Reference Memory. The Reference 
Memory is normally used to hold data collected previously, for purposes 
of comparison with the data most recently collected. 

The Correlation function makes the comparisons between data in the 
Sample and the Reference Memory·. You can also use this function to 
define a scenario which data collection will be repeated until 
correlation with Reference Memory is attained; or until the sample data 
being collected fails to correlate with the reference data. 

The Correlation function is controlled by the Correlation Menu, 
which appears in response to the C Command. Exhibit 18-1 shows an 
example of the Correlation Menu and of the resulting Correlation 
Display. Note that non-correlating samples are marked with a"<•>" 
symbol and highlighted. 

This function is very effective for finding discrepancies between 
performance of a digital system under test (Sample) and a known good 
system (Reference). 

In the simplest mode of operation, the <TAB> key (in conjunction 
with the Correlation Menu) causes correlation to be performed between 
the data in Sample and Reference Memories. It does not cause new data 
to be collected. Repeated use of the <TAB> key while viewing the 
Correlation Menu merely repeats the exercise of the correlation 
algorithm. 

Correlation may be performed on the data in two disk files by 
following this procedure: first, call up the File Menu (F Command) and 
load one file into the Sample Memory using Item 4 or 5. Second, load 
the other file into Reference Memory using Item 3. Third, call up the 
Correlation Menu (C Command) and enter the desired correlation 
parameters on the menu. Next, press <TAB> to cause correlation to be 
performed. The result will be immediately displayed in a form similar 
to Exhibit 18-l(b). 

18.2 CORRELATION~ 

Eight parameters are used to set the conditions for making 
correlations. The Correlation function has a number of modes that make 
it very flexible. 

Item 1) File to correlate with: 

The data in Reference Memory is loaded from a file on the disk. 
The file was created previously when data from a prior collection cycle 
was saved from the Sample Memory onto the disk, using the File 
Operations Menu. 
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1) file to correlate w,th: IHTEmAL 

2) Channe I masl: 
r E D C B A 9 B 7 6 5 4 3 2 l 0 
1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

3) first sarrple included: 25 
4) Hurroer of s~les: 400 
5) Start ,ng slew allowance:25 
6) Slew a1ignn-enf SaI14J!es: 1 
7) Sanplmg folerMce: 5 
8) Channel (bit) folerMce:0 
9) Repn,t data col led ion unf 1 I: A 
-> Al (not a.cf ,w) 

Bl Sanples correlate with reference 
C) Sanples do not correlate with reference 

I Index 1-6, Gfostart, P, ?, or (space) 

(a) 

Ml Ref Data Som Data Sem I 
270 7rnr ?Ear 258 
271 7EBF <·> 761F 259 
272 . MIF 7ffiF 2f.fl 
m 00:Jl ID::€ 251 
274 C239 C239 252 
275 457A 457A 2EJ 
27b 0078 007B 2&1 
2T1 DH£ 0105 265 
278 BF70 8F70 2E6 
279 am am '267 
280 (Bfl, ma; 2E,8 
281 1807 1807 259 
282 FB<'IB f848 270 
283 [001 [001 271 
28<'1 ctrre 4FK: 272 
285 f1fil FEm 273 
28& E~ E~ 27~ 
287 7ffiE 760[ 275 
288 7ffiF 760F 27E, 
289 7ffiF 7b0F 277 
2':{I 7ffiF 760F 278 
291 7ffiF 7Ef1F 279 

Correlation failed at s~le: 271 --up,dn, (sp),fl 

(b) 

Exhibit 18-1. Correlation Menu (a) and resulting display (b). 
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To retrieve the prior data from disk and load it into the Reference 
Memory, enter the filename in this item and press the return key. 
Alternatively, the file may be loaded to the Reference Memory using the 
File Menu (F Command). If the file is not on the disk, a disk I/0 error 
message will appear. Recovery from the error is automatic; the input 
prompt will reappear at the lower left corner of the screen. 

Item 2) Channel mask: 

Channels which do not contain meaningful data and are to be ignored 
in the correlation can be "masked out" by entering a Channel Mask 
specification in Item 2. Enter a "1" to indicate channels to be 
included in the correlation. Enter an "X" to indicate channels to be 
excluded. If a "O" is entered, it will have the same effect as a "1 ". 
The cursor control keys-> and<- can be used to move the prompt-cursor 
without affecting a channel specification. Direct positioning of the 
prompt-cursor to Channels F through 2 can be accomplished by entering 
the channel number. Press <RETURN> or <SPACE> to leave this item. 

Item 3) First sample included: 

Item 3 allows you to specify the first sample at which the 
correlation process is to begin. Samples before the specified first 
sample are ignored by the correlation algorithm. The number entered 
here refers to the sample num~er in Reference Memory. The default entry 
for this item is Sample O. 

Item 4) Number of Sampies: 

This item is used in conjunction with Item 3 to limit the range of 
samples over which correlation is performed. The correlation algorithm 
will stop after processing the number of samples spe~ified in this item. 

Item 5) Starting point skew allowance: 

Due to sampling differences, comparable patterns in the Sample and 
Reference Memory may not start at the same sample number. The 
difference is called "skew." The correlation algorithm allows for this 
skew. Item 5 may be used to specify the maximum allowable skew. For 
example, a value of 10 for the starting point and 4 for the skew would 
mean that starting point of the matching data in the Reference Memory 
could be anywhere from 6 to 14. 

Item 6) Skew alignment samples: 

The correlation skew algorithm begins comparing the data at a trial 
skew value, and if match is achieved over the number of samples 
specified in Item 6, it assumes that the trial skew value is correct. 
It then completes the comparison process and displays the result. If 
the correlation skew algorithm can~ot locate a sequence of samples that 
match exactly for the specified skew alignment samples (and with a 
starting skew anywhere in the Item 5 skew allowance), then the 
correlation is aborted. If such is the case, an appropriate message is 
displayed. 
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For example, assume that 10 is entered in this item. Then when 
Sample and Reference Memory are compared using the trial skew value, if 
the first 10 samples compared match, the algorithm concludes that it has 
the correct skew value, completes the comparison, and displays the 
result. 

If a match is not achieved over the first 10 samples, the algorithm 
tries another skew value. This process repeats until a skew value is 
found that gives a match over the first 10 samples, or all the skew 
values allowed by Item 5 have been tried. 

The default value for this item is 1, which means that the 
algorithm tries different skew values until it finds one sample that 
matches, then it completes the correlation using that skew value. 

Item 7) Sampling tolerance: 

Sampling effects may cause some slight variation in the data 
collected, especially if you use Internal Clock, which is asynchronous 
with the system being measured. (Normally, External Clock is used.) 
Item 7 allows you to specify a Sampling Tolerance value; this is the 
number of nonmatching samples that will be allowed before correlation is 
considered to have failed. 

When correlation fails, a message "Correlation failed at sample:" 
will appear at the bottom of the screen. If the Sampling Tolerance is 
5, you will see 5 sample mismatches above the sample reported by the 
message as the one where correlation failed. 

Item 8) Channel (bit) tolerance: 

The channel (bit) error tolerance allows for the case where less 
than perfect correlation is desired. For example, correlating 14 
channels out of 16 may be regarded as adequate. The number acceptable 
for a match, if different than the number of active channels as defined 
in the Channel Mask, may be specified in Item 8. Assuming that all 16 
channels are active, then for this example it would be appropriate to 
enter 14 in Item 8. 

Item 9) Repeat data collection until: 

Selection A of this item is the default data collection mode. 
The Omni makes one data collection each time you issue the G Command or 
"•" Command • 

When selection Bis chosen, the Omni enters a mode in which it 
will collect data repeatedly. Then when you issue the G or"•" Command, 
the analyzer collects data to fill the Sample Memory, and then tests for 
correlation between the data just collected and the data in Reference 
Memory. If correlation is achieved, it stops and displays the result. 
If correlation is not achieved, it resumes data collection and then 
repeats the cycle. The process is repeated over and over until 
correlation is achieved. 
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Selection C also activates a repeat data collection mode. When you 
issue the G or"•" Command, the Omni likewise collects data to fill the 
Sample Memory, and then tests for correlation with the data in the 
Reference Memory. However, in this case, it continues to repeat the 
collect and correlate cycle so long as correlation is achieved; when 
correlation fails, it stops and displays the result. 

Note that data is not being collected during the part of the cycle 
in which the Omni is testing for correlation in the data. 

18.3 HELP PAGE 

A Help Page for the Correlation Menu may be obtained by typing 
"?C". When viewing the menu, you can access Help Pages for Items 1, 2, 
etc., by typing "?I", "?2", etc. After seeing the help information, 
press <SPACE> to return to the Correlation Menu itself. 

Rev. D 
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19. MATRIX DISPLAY 

19 .1 INTRODUCTION 

This display, illustrated in Exhibit 19-1, is a table showing the 
number of times a specific bit pattern has occurred within a given range 
of samples. The maximum pattern length is eight bits. The display uses 
the lowest eight active channels according to the Trigger Menu, T 
Command. 

Chonnels 7 6 5 a / 3 2 1 0 Range -500 to 499 
0123 4 5 6 7 8 9 ABC DEF 

0 : 3 20 20 20 20 17 17 17 
1 : 99 
2 : 
3 : 
4 : 
5 : 
o: 
1:20 20 
8 : 
9: 
A: 
e: 
C : 
0 : 
E : 
r : 

21 20 
17 

20 20 

1 77 271 265 
1 2 

3 3 3 3 

1 Enter: C,0,E,F,G,H,1,L,H,H,O,P,S,T,W,X,2,=, ?,sp 

Exhibit 19-1. Matrix Display. 
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19.2 DISPLAY CHARACTERISTICS 

There are 256 possible bytes, that is, 256 possible different 
combinations of 8 bits. The body of the table shows the number of times 
each of the 256 different combinations occurs in the specified range of 
samples. 

A byte is represented in hexadecimal notation by two digits, e.g. 
"7B". The scale O - F on the left lists the first hex digit of the 
byte, and the scale across the top lists the second. Thus to find the 
number of occurences of the byte "7B'', find "7" on the left side scale, 
then read across to column "B". The example in Exhibit 19-1 shows that 
7BH occurs 20 times. 

The other features of the display are: 

Channels - at the upper left; lists the eight (or less) channels 
that were surveyed in creating the display. 

Range - at the upper right; gives the range of samples over which 
the count was made. In the example, the byte 7BH occurs 20 
times between sample -500 and sample 499, inclusively. The 
range is specified in the parameters x and y used with the M 
Command. 

Enter: - at the bottom; indicates the commands which are available 
now. 

12.d COMMAND FORMATS 

The Matrix Diagram Display is controlled by the M Command by using 
one of the following command formats: 

M display matrix of data shown in previous display, starting 
from the same sample as the previous display. The number of 
samples shown will be the same as in the previous matrix. 

Mx 

Mx,y 

MALL 

display matrix of data for the same number of samples as the 
previous matrix, starting from sample x. 

display matrix of data in Sample Memory from sample x to 
sample y, inclusively. 

display matrix for entire Sample Memory. 

The parameters x and y may be expressed as sample numbers. If 
Internal Clock is being used, they may be expressed either as sample 
numbers or as time units. When the Matrix.Display is first used after 
turn-on, the default value for the number of samples over which the 
matrix is calculated is 80 samples; in other words, y is assumed equal 
to x+79 if it is not specified. 
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19.4 EXAMPLES 

M40ms 

display data between samples 16 and 64, inclusively. 

display data starting at the sample 40 milliseconds after 
trigger, for the same number of samples as the previous 
display. 

19.5 DISPLAY CONTROL KEYS 

The"<" and">" keys allow you to shift the range of samples over 
which the matrix is formed. 

< 

> 

display matrix ranging over the same number of samples as the 
current matrix, but just before the current matrix. 

display matrix ranging over the same number of samples as the 
current matrix, but just following the current matrix. 

For example, assume that the current matrix is a summary over 
samples 40 through 79. Striking the "<" key causes a matrix for samples 
0 through 39 to appear (after a short delay). The ">" key causes a 
matrix for samples 80 through 119 to appear. 

To display the Help Page for the M Command, type "?M". 

Rev. D 
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20. LOCATE 

20.1 INTRODUCTION 

Locate is a utility feature which finds a data pattern in the 
sampled data. It is used after data collection has occurred, and is 
independent of the Trigger Event and other trigger conditions used to 
specify the collection of data. 

Exhibit 20-1 shows two examples of the Locate Menu, in which the 
search parameters are entered. Exhibit 20-2 shows the appearance of the 
Waveform Display after a desired sample pattern has been found and 
highlighted using the Locate function. Note that the cursor is on the 
sample containing "FC52", the first word of the Search Pattern specified 
in Exhibit 20-l(a). 

20.2 LOCATE~ 

Enter "L" to bring up the Locate Menu. To change any aspect of the 
menu, enter the desired item number and change the parameter. 

The first three items are used to set up conditions for the search. 
Item 1, Start Sample Number, indicates the sample number at which to 
begin the search. Item 2, Input Mode, specifies the number base for the 
subsequent items. Item 3, Global Channel Mask, is used to select the 
bits that will be used during the pattern search. Bits that are to be 
included in the search are indicated by a "l". Bits that are to be 
ignored are entered as a "O". The default conditions for these first 
three items are adequate for most searches. 

The data pattern to be found is entered in Items 4 through 9, the 
Search Pattern. The pattern is a sequence of digital words which must 
be matched by a corresponding consecutive sequence of data samples in 
the Sample Memory. The search starts at the Start Sample Number and 
proceeds through the Sample Memory until the first complete match is 
found, or if there is no complete match, until it reaches the end of 
Sample Memory. 

After entering the first word of the pattern in Item 4, press 
<RETURN> and the prompt-cursor will move to Item 5, ready to receive the 
second word. When you have entered as many words as your search pattern 
requires (often only one), press <SPACE> to leave the Search Pattern 
items. 

20. 3 MAKING '.!!!§. SEARCH 

When all changes to the menu have been entered, press the <TAB> key 
to initiate the pattern search. If the pattern is found, the Omni will 
return to a data display with the found pattern highlighted. If the 
pattern is not found, "Not Found" will appear in the upper right corner 
of the Locate Menu. 
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J) Start ~,le Hul!tier --488 

2) Input !"ode HEX 

3) GI oba I Channe I Mask ffff 

4) Search Pa11ern FCS2 
5) 
&) 
7) 
8) 
9) 

I Index 1-9, G to search, P, 7, or (space) 

(a).· 

I) St or! 5onli I e Hunber --452 

2) Input i'l'.,de Bl~ 

F E D C 8 A 9 8 7 6 5 4 3 2 I 0 

3) Global Chonne I Mask I 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

4) Search Pattern 
5) 
6) 
7) 
8) 
9) 

0 0 1 1 1 1 0 0 0 0 1 0 0 1 1 1 
1 1 1 1 1 0 1 0 X X X X X X X X 
xxxxxxxxxxxxxxxx 
xxxxxxxxxxxxxxxx 
00001000XXXXXXXX 
xxxxxxxxxxxxxxxx 

I Index 1--9, G to se!!rch, P, 7, or (space) 

(b) 

Exhibit 20-1. Locate Menu. (a) Example of entries in hexadecimal 
(b) Example of entries in binary format, which allows "don't care" 
specification of individual channels in the search pattern. 

format. 
( ''X") 
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Exhibit 20-2. Waveform Display of the sample pattern "FC52" found 
using the Locate function. 

Note that the <TAB> key does not cause the Omni to collect new 
data. It merely initiates a search through the existing data in Sample 
Memory. 

Each time a search pattern is found, the Start Sample Number on the 
menu will be updated automatically to start the next search at the 
sample after where the pattern was last found. Once a search pattern 
has been entered, it is possible to find the second, third, and all 
subsequent occurrences of that pattern by repeatedly typing <TAB> to 
resume the search. 

1Q.d. ~ ITEMS 

More details about the individual menu items follow. 
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Item 1) Start Sample Number 

A pattern search can begin at any sample within the 1000 sample 
trace. The sample can be specified either by a sample number, or if the 
Internal Clock is used, by a time value such as 50us or -lOOOns. All 
sample number and time references are made with respect to the trigger 
event. Sample number O and time O normally correspond to the point at 
which the trigger event occurred. (If the Delay parameter, Item 8 on 
the Trigger Menu, is non-zero, then Sample O will be delayed relative to 
the trigger event by the Delay value chosen.) 

When a starting sample number is selected, all samples before the 
starting sample are ignored when executing a pattern search. 

Item 2) Input Mode 

This item is used to select the most convenient number base for 
specifying the Channel Mask and Search Pattern. The default is 
hexadecimal. For binary, decimal, octal, or unsigned decimal, enter 
"B", 11011 , 11011 , or "U", respectively. "H" restores hexadecimal. When the 
Input Mode is changed, all lines following are automatically updated to 
reflect the new input number base. 

Item 3) Global Channel Mask 

Quite often a pattern search does not include all sixteen data 
channels. Through the use of the Global Pattern Mask, the unused 
channels can be ignored (made 11don"t cares") during the search. A "l" 
indicates a channel that will be considered in the search. A "O" means 
"don't care", a channel that will be ignored in the search. 

The Global Pattern Mask entry will usually be in a number base 
other than binary, such as hexadecimal. In that case·, the pattern of 
"l"'s and "O"'s just mentioned refers to the binary form of the number 
(as is always the case when a number is used to describe digital 
signals). 

When the Search Pattern is specified in a nu~ber base other than 
binary, the Global Pattern Mask is the only way to indicate specific 
"don't care" channels. When the Input Mode is binary, as an alternative 
each "don't care" channel can be indicated with an "X" in the Search 
Pattern. 

Items 4) thru 9) Search Pattern 

The Search Pattern can consist of one to six consecutive sixteen 
bit words. The search is considered successful only if a consecutive 
sequence of samples is found in the Sample.Memory that matches the 
pattern word for word. ''Don't care" patterns are indicated by a blank 
line, and are entered by pressing <RETURN> to skip over the line. When 
in binary mode, a "don't care" pattern can be entered with an "X" on 
every channel. Upon completion of the pattern entry, press <SPACE> to 
exit this item. 
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lQ.:.1 EXAMPLES 

The first example involves monitoring the instruction sequence on a 
microprocessor's eight-bit data bus. Consider the menu entries: 

1) Start Sample Number 50 

2) Input Mode HEX 

3) Global Channel Mask FFOO 

4) Pattern C300 
5) 5500 
6) 2300 
7) 
8) 
9) 

Here the channels of interest are the upper 8 (i.e., Channels F 
through 8). This is indicated by eight high level bits ("FF") in the 
top (leftmost) position of the Global Channel Mask. The lower eight 
bits of the Global Channel Mask are set to "O" to establish a "don't 
care" condition on the low channels. 

The pattern is the sequence "CJ", "55", and "23". (I.e., a jump to 
location 2355 on a Z80 microprocessor. The "55" comes before the "23" 
because the Z80 fetches the low byte first.) To maintain positional 
integrity, each of these three entries was filled to the right with 
1100". (Any eight-bit fill would provide the same result because the 
Channel Mask forces these bits to be "don't cares" during the search.) 
Because the start sample number is 50, any occurrences of the three 
sample sequence before sample number 50 are ignored. 

Toe second example illustrates the same application scenario, 
however the search is generalized to require a match on any jump to a 
23:XX address. The menu entries for this case are: 

1) 

2) 

3) 

4) 
5) 
6) 
7) 
8) 
9) 

Start Sample Number 

Input Mode 

Global Channel Mask 

Pattern 

50 

BINARY 

1 1 1 1 1 1 1 1 X X X X X X X X 

1 1 0 0 0 0 1 1 X X X X X X X X 
xxxxxxxxxxxxxxxx 
0 0 1 0 0 0 1 1 X X X X X X X X 

Since the input mode is binary, additional qualification of the 
pattern is possible. Toe Global Channel Mask specification forces the 
use of only the high eight bits in the search. The second sample in the 
pattern is specified as a "don't care", and hence will always match the 
data collected following the "CJ". The search will be successful on any 
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three sample sequence where the first sample is "C3", the third is "23" 
and the second can be any pattern. 

A Help Page for the Locate Menu may be accessed with "?L". When 
viewing the menu itself, you can access Help Pages for the individual 
Items 1, 2, etc,, by typing "?l", "?2", etc. Press <SPACE> to return to 
the Locate Menu from the Help Pages. 

Rev. D 
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21. FILE OPERATIONS 

21.1 INTRODUCTION 

File operations allow you to: 

o store and retrieve sample data and test parameters to and from 
disk files. 

o display a directory of the files stored on disk. 

o delete data files. 

o move data from Sample Memory to Reference Memory. 

o retrieve tables of instruction mnemonics for different 
microprocessors for the Instruction Disassembly function. 

o record keystrokes in a log file, and later re-execute them 
automatically. 

These functions are controlled by the File Menu, which appears in 
response to the F Command. Exhibit 21-1 shows the File Menu as it 
appears when first called up. 

l!_4 ~ ITEMS 

Explanations of the individual menu items follow. 

Item 1} Title: 

The title is an optional input of up to 40 characters which will 
label any individual data or setup parameter file saved on disk. When 
this stored data is retrieved, the title is also displayed. The use of 
a title is a convenient way to describe the characteristics of the 
recorded data file for positive identification at a later time. 

NOTE: Spaces are not allowed in the title. Use the underscore 
character or hyphen instead. 

Item 2) READ instruction MNEMONICS from file: 

Instruction disassembly is performed by matching collected data 
with a predefined file of instruction mnemonics. Some mnemonics have 
already been defined and recorded on disk under files bearing the name 
of the processor and the file extension ".LAM". When specifying the 
filename in Item 2, enter only the name of the file; the extension is 
appended automatically. 
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1) T,t le: 

2) REFC 1nstruct1on 11-!EI011CS from file: 280 u::t1 
3) REl-0 into REfTRHICE rrenory from f I I e: 
4) RHO into 51'.WLE mern:n,1 from file: 
5) REffi All data & pararreters from f I le: 

6) !Sill[ SfHll[ meroory onto f, le: 
7) I-RITE ALL data & pararreters onto f1 le: 

8) Display DIR[CTCRY of saved files on dr 1ve: A 
9) DEL[TE data f, le: 
Al CCPY from 91-PLE into REFEREHCE rrenory 
Bl Log f I le status: TEST87 LAL 
Collect ion dates: 5arrp le Reference 

ffi-1J7/fl4 16:42:15 001'07.184 16:39:18 

I Enter 1 - B, ? for help, or Sfll'.(£ to exit 

Exhibit 21-1. File Menu. The Z80 mnemonics file, which is used for 
Instruction Disassembly, appears by default in Item 2. 

Item 3) READ into REFERENCE memory from file: 

After sample data has been collected and saved on disk, it can be 
returned to either Sample or Reference Memory. Moving stored data into 
Reference Memory allows it to be displayed just like data in Sample 
Memory, or it can be used for Correlation operations. Data is read from 
disk into Reference Memory when the filename is entered in this item and 
the <RETURN> key pressed. Do not enter an extension; the extension 
".IAD'' is appended automatically. 

NOTE: The preceding function will not provide Reference Signatures for 
signature analysis. They must be read in using Item 7 on the Signature 
Menu. See Section 24, Signature Analysis. 

Item 4) READ into SAMPLE memory from file: 

To transfer data from a disk file to the Sample Memory, enter the 
filename (without the extension) in this item. The data will be 
restored in its raw format and will not contain any characteristics such 
as channel labels, Sample Rates, or trigger conditions. When the 
retrieved data is displayed, the time scale and other collection 
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parameters on the screen may not correspond to the data, and a warning 
message to that effect will be displayed. 

The Omni records date and time when sample data is collected. This 
time record is saved with a stored file, and returned when the file is 
returned. 

Item 5) READ all data & parameters from file: 

This item retrieves data and parameters that were saved using Item 
7. Upon retrieval of the data and parameters, the analyzer setup 
conditions (trigger word 1 display number base, etc.) are totally 
reconfigured from their current state to the setup conditions that were 
saved on disk. Use of this option is a convenient way to restore a 
given setup state from a power-up condition. 

NOTE: All the parameter settings currently in effect will be lost when 
this function is used, since it replaces them with the parameters stored 
on disk. This includes changing the data in Reference Memory, if File 
Menu Item 3 had a filename in it when the analyzer· state was originally 
stored via Item 7. 

CAUTION: Data files saved using earlier versions of the Logic Analyzer 
Program should not be recalled using this item. In order to expand 
capabilities, it was necessary to modify the parameter storage formats. 
As a result, attempting to recall data that was saved using an early 
program version (prior to 4-1-84) may cause problems. 

Item 6) WRITE SAMPLE memory onto file: 

After data collection has been made, the data can be saved to a 
disk file by entering the filename in this item. Filenames can contain 
up to eight alphanumeric characters and an optional disk drive specifier 
in the standard format: 

d:ffffffff 

where d is the drive specifier ("A" or "B") and ffffffff is the 
filename. Do not enter an extension; all files saved will be 
automatically assigned the extension ".LAD". 

If the disk drive specifier is omitted, the specifier for the 
default drive (often called the logged in drive) will be supplied 
automatically. If a drive other than the current default drive is 
specified, then the specified drive will become the new default drive. 
The default drive is displayed on the File Menu in Item 8. 

Item 7) WRITE ALL data & parameters onto file: 

Item 7 allows you to save not only the data, but also the setup 
conditions of the analyzer. Channel labels, trigger conditions, Sample 
Rates, and display parameters (the total state of the machine) are all 
saved to disk. The former setup conditions (the entire state) are 
restored through the use of Item 5. Enter the filename as in Item 6. 
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Item 8) Display DIRECTORY of save files on drive: A 

It is difficult to remember all the file names that have been saved 
on a particular disk. To display a list of the logic analyzer files 
resident on a given disk, select this item and enter the drive letter 
( "A" or "B") of the desired drive. 

Press any key other than <SPACE> to see a display of all the files 
on the disk. After viewing the directory, press <SPACE> to return to 
the File Menu. 

Item 9) DELETE data file: 

Enter the name of a file (less the extension) in this item to 
delete it from the disk. 

Item A) COPY from SAMPLE into REFERENCE memory: 

Accessing this item causes data to be copied from the Sample Memory 
to the Reference Memory. Typically, a new sample collection will then 
be made for comparison to the previous data. The Correlation function, 
for example, correlates data in Sample Memory against data in Reference 
Memory. 

Item B) Log file status: 

This item is used to make a log of your keystrokes which is saved 
in a disk file. The keystroke sequence may be recalled and 
automatically re-executed at a later time. 

To create a log file, type "B" to access this item. Then enter "W'' 
for "write to log file ■ 11 Enter the filename ( less the extension) when 
prompted for it. After the filename is entered, all keystrokes will be 
recorded automatically. 

To end the logging of keystrokes, type "B" to access this item 
again. The Log file status will be immediately changed back to 
Inactive. 

To re-execute the recorded keystrokes, access this item and type 
"R", for "read from log file", when prompted. Then enter the filename 
of the desired log file. After you have entered the filename, the Omni 
will fetch the file and re-execute the keystroke sequence it contains as 
you watch. When it reaches the end of the file, the Log file status 
will be reset to Inactive. 

A Help Page for the File Menu may be accessed by typing "?F". When 
viewing the Menu, you can obtain Help Pages for the individual Items 1, 
2, etc., by typing "?I", 11?2", and so on. After viewing a Help Page,· 
press <SPACE> to return to the File Menu itself. 

Rev. D 
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22. INSTRUCTION DISASSEMBLY 

22.1 INTRODUCTION 

A microprocessor executes its program by fetching instructions and 
data from memory. The instructions are made up of two parts, opcodes 
and operands. They appear as bit patterns on the data bus when the 
microprocessor reads them from memory. 

The Instruction Disassembly function allows you to trace program 
flow by collecting this data bus activity and translating the bit 
patterns back into instruction mnemonics. 

To effectively utilize this mode of display, a very controlled data 
collection procedure must be observed. This requires coordination 
between the selection of channels, mnemonic definitions in a disk file, 
and selection of an appropriate External Clock source. 

The disassembler operates on the data in eight channels, 
corresponding to the data bus of eight-bit microprocessors. The 
optional 32 Channel Adapter, which extends the Omni's data collection 
capability to 32 channels total, makes possible collection of complete 
data and address activity. 

Use of the Omni's internal clock is not appropriate for instruction 
disassembly, since it is not synchronized with the data on the 
microprocessor's data bus. The data bus is time· shared, and valid data 
is present only while certain control lines are valid. Use one of these 
control lines as the External Clock signal to record data into the logic 
analyzer's memory, for example the "MmORY READ" control line. Be aware 
of the polarity of the control signal selected for use as the External 
Clock. The Omni collects data on the edge of the External Clock signal. 

Once the setup requirements and precautions have been observed, and 
valid data collected, displaying the information in instruction format 
is easy. The I Command initiates instruction disassembly. 

NOTE: The I Comm.and does not cause a new sample to be collected; 
it merely translates the data already in Sample Memory into mnemonics. 

22.2 DISPLAY FORMAT 

After disassembly, the data is displayed as both bit patterns and 
mnemonics in a format similar to that obtained from an assembler 
listing. Exhibit 22-1 shows an example of the Instruction Disassembly 
display~ 

The display is made up of several columns of. data. The left column 
is the sample number ("-465" in the first line in Exhibit 22-1). The 
middle columns are the collected data ("00001111-CB" in the exhibit). 
The right column shows the collected data translated into mnemonics 
C'BIT 0, (HL) "). 
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5-ple- oo-o7 Ct I Bits, 00-DF Qjtes ttiell'Clnic oo-or ~tes 
B131111-<B EIEl BIT 0, CHU C0 -«6 

-462 BEllllll-28 01010010-FC JR z,rc 
-«e llml111-<B 0001EBJ.h16 BIT 0, (HU C0 
-llSl 0EE10001-28 01010010-FC JR Z,FC 
-455 llml 111-<B 00100110-tfl Ji.lRC: B 

-> -453 tE1 Eltl 11-3:: IHC A 
~ B3101~FR JP H,E&l) 
--449 00101101-413 EX Ff",AU: 
-441 11310111&-{9 R£T er 04 
--ffi 8lln111-<B 0001 BIT 0, (Hl) CB 
-442 lm!IBn-28 01011131.0-FC JR 2,rc 
-4ilJ fBn 1111--03 &1 BIT 0, (Hl) C0 
--01 IJEHIIU.-28 01010010--FC JR z,rc 
-41i flffill 11-ffi 0001 BIT 0, (Hl) C0 
~ lBltlBn-28 81010010--FC JR z,rc 
-at flffll 111-cB 0001 BIT 0, (Hl) C0 
-4ZT EBllfBn-28 01010010-FC JR z,rc 
-425 BBll 111-ffi 8131 BIT 0, CHL) C0 
-422 llElfHU-28 81010010--FC JR 2,FC 
-420 IHl31111-<B Eml BIT 0, (HLJ CB 
-417 EBllEB:Jl-28 01010010-FC JR 2,FC 
-415 EIBU 111-<B RElEHB-46 BIT 0, (HL) C0 

1 Enter: C,D,E,F,G,H,l,L,M,H,O,P,S,T,W,X,Z,~, ?,sp 

Exhibit 22-1. Instruction Disassembly Display. The I Command causes 
data in the Sample Memory to be displayed as instruction mnemonics. 

The collected data "00001111-CB" is displayed in this format: 

bbbbbbbb-hh 
I \ 

I \ 
I \ 

8 binary 
digits 

2 hex 
digits 

The 8 bits bbbbbbbb represent the signals on Omni Channels 7-0, some of 
which are connected to the microprocessor control lines. The two hex 
digits represent the data collected on Omni Channels F-8, which are 
connected to the microprocessor data bus. 
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Each line of the display corresponds to one instruction of 
disassembled code. Each line will have either one or two of the 
bbbbbbbb-hh patterns, depending on whether the instruction is a one-byte 
or multibyte instruction. For instructions longer than two bytes, the 
bbbbbbbb-hh patterns show only the first two bytes. 

The representation of the Channel 7-0 control bits (bbbbbbbb) is 
always in binary. The number base for the Channel F-8 data bytes (hh) 
is dictated by the Options Menu, reached by the O Command. The default 
output base is hexadecimal. Refer to the Options Menu section for the 
procedure to change the output base. 

As well as mnemonics, the last column also shows any bytes which 
are read by the microprocessor when it executes the instruction. For 
example, look'at the instruction starting at Sample -448. The 
instruction "RET" is a single-byte instruction; "C9" is the opcode. 
To execute the instruction, the microprocessor read bytes "CF" and 110411 

from memory. 

Thus the last column shows all data bus activity - both the 
reading of the instruction and its execution. 

As with the other display formats, the cursor keys can be used to 
move the highlighted cursor up or down, or scroll the entire display. 

1!!1. BOW!!. WORKS 

During program execution, not only instructions appear on the data 
bus; data read from memory and (in the case of processors using memory­
mapped I/0) input data appear as well. The disassembler must be able to 
distinguish the opcode bytes from all the others in order to disassemble 
the code correctly. There are three ways to do this: 

Use the status lines - some processors provide status signals that 
identify the opcode fetches. The Z80;s /MREQ and /Ml signals 
do this, and the Omni's built-in Z80 disassembler uses them. 
The 8085 and 8080 provide status signals /IOM, SO, and SI, 
which the Omni uses. 

Start from a known opcode - if status signals are not available, a 
non-status disassembler will work properly if it is started on 
an opcode. The Omni's other disassemblers work this way. You 
should start disassembly from an opcode byte with the command 
"In", where sample n contains an opcode. 

Start anywhere - if a disassembler of the second type is started on 
a byte which is not an opcode, the disassembler will 
erroneously interpret it as an opcode and display incorrect 
instructions. However, after a few lines of disassembly, it 
will strike an opcode, get "in sync", and disassemble 
correctly from. there on. 

The Omni actually contains two disassemblers: a status signal type 
disassembler with built-in mnemonics for the Z80 and 8085, and a table 
driven disassembler that reads in the mnemonics from a file and can be 
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used with any processor. The two disassemblers work somewhat 
differently, so they will be described separately. 

22 .4 !fil!_ INSTRUCTION DISASSEMBLY 

The Z80 Disassembly is the default choice - it is activated when 
you first use the I Command. Reading a mnemonic file via the File Menu 
is not required. 

To perform disassembly for a ZBO microprocessor, first connect 
Channels F-8 of the Omni to the Z80 data lines D7-DO respectively. 

Note: The symbols ''D7", "D6", and so on are used for two different 
applications - Omni probe lines and microprocessor data bus signals. To 
avoid confusion here, we will refer to the Omni input lines as "Channel 
F", "Channel 7", and so on. In this section of the manual, ''07", ''D6", 
etc. are used only to refer to the microprocessor data bus. 

Connect /MREQ and /Ml to Omni Channels 6 and 7, respectively. 
These are the two lines that are recorded to distinguish opcode fetches 
from other bus activity. Attach the Clock probe lead to the 
microprocessor system /RD line. 

Set up the desired data collection parameters on the Trigger Menu. 
Use the External Clock option and clock on the positive edge. Use the 
Latched Mode. 

RD 

WR 

74LS08 
(A) 

-D---
74LSOO 

(B) 

EXl'ERNAL CLOCK - SELECTED 
POSTIVE EDGE (1) 

EXl'ER.NAL CLOCK - SELECTED 
NEGATIVE EDGE (0) 

Exhibit 22-2. Circuits to combine /RD and. /WR microprocessor strobe 
signals into a single External Clock pulse. This allows both read and 
write bus cycles to be recorded, and thus appear in the Instruction 
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After all desired trigger parameters are set up and _data has been· 
collected 1 enter the command "I<RETURN>" to perform instruction 
disassembly. A display similar to Exhibit 22-1 will appear. Move the 
cursor by using the up and down arrow keys, and step pages by using the 
"<"and">" keys. 

The six channels not connected yet, Channels 5 through 0, will also 
be displayed in binary form in the second column, along with Channels 7 
and 6. They may be used to monitor any other signals you wish 1 such as 
address lines or bits of I/0 ports. Remember, a maximum of two bus 
cycles per opcode fetch will be displayed for these lines. The Dump 
display may be used to observe any bus cycles for Channels 7-0 not shown 
by the Instruction Disassembly display. although this is rarely 
required. 

If it is required that data from write and output cycles be 
recorded in disassembly, then an external gate will be required to 
logically-OR the /RD and /WR lines to the External Clock input. Exhibit 
22-2 on the previous page shows two possible circuits to accomplish 
this • 

.E.:2. 8085/8080 DISASSEMBLY 

Mnemonics for the 8085/8080 family microprocessors are also 
available. The 8085 is a single-chip improved version of the 8080. It 
runs the same software, except that it has two added instructions the 
8080 does not have. The status signals are the same, /IOM, SO, and Sl. 

To activate the 8085/8080 mnemonics, enter 8085 in Item 2 on the 
File Menu. Note that no mnemonics files for these processors will 
appear in the disk directory - like the Z80 mnemonics. they are built 
into the disassembler. 

Connect Channels F-8 of the Omni to the microprocessor's data lines 
7 through 0, respectively. The latter are labeled AD7-ADO on 8085 and 
8080 chip set diagrams. Connect Channel 7 to microprocessor status line 
/IOM, Channel 6 to status line SO, and Channel 5 to status line Sl. 

From this point, proceed as recommended above for the Z80. 

22.6 !!ll DRIVEN DISASSEMBLER 

The file-driven disassembler does not require status signals from 
the microprocessor. It finds opcodes by the "start from a known opcode" 
or "start anywhere" methods. 

To load the mnemonics for a given microprocessor, first call up the 
File Menu with the F Command. Enter the name of the file containing the 
mnemonics for the processor you wish to use in Item 2, Read Instruction 
Mnemonics From File. Mnemonic files are stored on disk with the file 
extension ".UM". (Do not type the extension; ".LAM" will be appended 
to the file name automatically.) 
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After the data has been collected, use the I Command to initiate 
disassembly. If you know that sample n contains an opcode, you can type 
"In<RETURN>" and disassembly will be correct starting from sample n. 
Often, however, you will not initially know which samples contain 
opcodes. In that case, the first few lines of disassembled code will be 
incorrect. 

.ll.:l 8048 SERIES FILE DRIVEN DISASSEMBLY 

The following briefly explains how to perform instruction 
disassembly for the 8048 Series microcomputers (8048, 8748, 8039, 8035, 
80C48, etc.). A general knowledge of this family of microcomputers is 
assumed. The file-driven disassembler is used with this series. 

A special requirement of 8048 Series disassembly is that the 
microcomputer be executing its program from external ROM, since this is 
the only time opcodes are present on the data bus and can be captured. 
PSEN (pin 9) will be used to strobe the data in, so connect this line to 
the Omni'_s External Clock (positive edge). Connect the 8 data lines 
from the microcomputer chip (pins 12-19) to Channels F-8 on the Omni. 

Set up the trigger conditions as needed. The mnemonics file for 
the 8048 series is stored on the Logic Analyzer disk under the name 
8048FAM.LAM. Load it using Item 2 on the File Menu. At this point data 
can be collected and the I Command can be used to disassemble the code. 

The lower 8 channels (Channels 7-0) are not required for 
disassembly and may all be used for other functions, such ss monitoring 
addresses or bits from I/0 ports. These channels are displayed in binary 
form. 

As was noted above, this approach is based on a method of 
collecting data only when PSEN is active. The mnemonics tsble in the 
file 8048.FAM is constructed for this method, and if you wish to use a 
different approach, you will need to change the table. 

_ll& CREATING MNEMONICS FILES !Q! OTHER PROCESSORS 

You can disassemble code for any processor or stste sequencer by 
putting a table of the corresponding mnemonics in a file on disk. 
Exhibit 22-3 specifies the construction of the table. This makes it 
possible to add instruction disassembly capability for new processors -
it is only necessary to construct a new table. 

The first two bytes in the file represent the size of the table 
(including the first two bytes). Next follow 256 packets, one for each 
of the 256 possible one-byte opcodes. Unused opcodes must also be 
represented in the file, with the mnemonic "??" (two question marks) 
assigned to them. 

The lead byte in the first packet (labeled "byte 2" in Exhibit 22-
3) is a binary number that equals the number of bytes in the packet 
(including the first byte). The next byte ("byte 3") is a binary number 
representing the number of bytes in the instruction fetch for the 
instruction; this is normally one. The next byte ("byte 4") is the 
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number of bytes of operand fetch and additional bus cycles that the 
processor executes for the instruction. The next byte ("byte 5") is the 
opcode, that is, the machine code binary number. The remaining bytes in 
the packet ("bytes 6, 7, ••• n") are the ASCII codes for the instruction 
mnemonic. 

Subsequent packets are constructed the same way. Note that the 
packets are of varying length, depending on the number of bytes 
(characters) in the mnemonic. The next packet follows immediately after 
the end of the prior packet; there is no delimiter between packets. The 
disassembler subroutine uses the first byte of each packet to tell where 
the next packet starts. 

DESCRIPrION OF MNEMONICS TABLE 

byte 0,1 • size of table (unused by online disassembly) 

PACKET DESCRIPrION 

byte 2 • number of bytes in packet 
byte 3 • number of bytes of instruction fetch 
byte 4 • number of bytes of operands fetch and 

bus cycles 
byte 5 -opcode 
byte 6,7, •.. ,m • ASCII for instruction mnemonic 

NEX! PACKET DESCRIPrION 

byte m+l • number of bytes to describe 2nd packet 
etc. 

TERMINATOR BYI'E DESCRIPl'ION 

byte n • 0 to signal end of table 

DESCRIPrION OF PACKET FOR UNDEFINED OPCODES 

byte j+l • 6 
byte j+2 • 1 
byte j+3 • 0 (zero) 
byte j+4 • opcode 

additional 

byte j+S, j+6 • 63, 63 • ASCII for 11??11 (two question marks) 

Exhibit 22-3. Instruction Disassembly Mnemonic Table Specification. 
This describes the structure of the mnemonics table used in disassembly. 
You must have a table like this for every processor for which 
disassembly is to be performed. (Except the Z80 and 8085, for which the 
disassembler has mnemonics built in.) The maximum size allowed for this 
table is 3K bytes. 
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After the 256 packets for the possible opcodes, a terminator byte 
marks the end of the table. It is simply one byte containing a binary 
zero (O). Note that the maximum size allowed for the table is 3K bytes. 

Since the file is a binary file, you need to use an assembler or 
some other program that will produce binary output to create it. We 
suggest that you use an editor to make an .ASM file, then use ASM and 
LOAD to make hex and binary versions. Rename the binary version of the 
file to change its extension from ".COM" to ".LAM". 

Exhibit 22-4 at the end of this section shows the mnemonics table 
(in the form of an .ASM file) for the 8048 microprocessor. 

22 .9 COMMAND FORMAT 

Anytime the prompt line 

Enter: C,D,E,F,G,H,I,L,M,N,O,P,S,T,W,X,Z,•,?,(sp),-p 

appears, the data in trace memory may be displayed in Instruction 
Disassembly mode using a command in the following format: 

I Display data in Disassembled Instruction format, centered on 
the sample marked with the cursor in the previous display. 

Ix Display data in Disassembled Instruction format starting from 
sample number x. 

22.10 COMMAND EXAMPLE 

156 Display data as disassembled instructions starting at sample 
number 56. 

22.11 ~ PAGE 

To obtain the Help Page for this function, type "?I". 
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J>ISASSEMBL V SOURCE 

ow TBLEND JENO OF TABLE 

DB 007H, 01, C•O, C•O, 'NOP' DB OODH, 01, 0(1, 3CH, 'MOVD F·4,A" DB oooH,01,00,01,•77, 
DB OODH, 01, 0(1, 3DH, 'MOVO P!.,1:t• OB OC•EH,01,00.<•2, 'OUTL BUS.A' DB (10DH, 01, 00, 3EH, • MOVD F·o,A" DB OOBH,01,01,03,'ADD A,41· 
DB OODH, (11, 00, 3FH, 'l'IOVD P7,A' DB OlOH,01,01,04, 'JMP PAGE o, .. , DB OODH, 01, (>0,4C•H, 'ORL A,.IRO" DB 007H, 01, or,, o:c;, 'ENI' DB OOOH,01,oo,41H,'0RL A,.iRl' DB 0(16H, 01, OCo,06, '77• 
DEl OOBH,(11 ,00,4::?H, 'l'IOV A, T' DB 009H,01,oo,07,'DEC A' DB OOBH, 01, 01, 43H, 'ORL A,41' DB 00£H. 01. (1(1, c,e, , INS, A, BUS' DB 010H,01,01,4-'IH,'Jl1P PAGE 2., ... DB 009H, 01, 00, C•9,' IN A,F'l' DB (o0CH,01,0(o,45H, 'STF:T CNT' DB OC•BH, 01, (1(1, OAH.' J N A,-F•:2'." DB 008H, (11, 01, 46H, 'JNT l' DB OOcH, 01, (l(,, OBH, '77' DB OOAH. 01, ~1(1, 47H, 'SWAF· p,· 

OB OODH, 01, (,(,, OCH. 'l'ID'JD A,F'4' OB <•OCH. C•l, ,:,,:,. 48H, ·' ORI. A.P,:,· DB OODH. (1 J , ,;,c,, (>OH, ' l'IOVD A.P5" DB (oOCfc. (, 1 , .:,(1, 4 ~;; • ' ORL A, F:1' DB OODH,01,00,0EH.'l'IOVD A, F·o· DB oc,cH. (11. o,:,. 4AH, 'OF:L A..,F:2~ 
DB OODH,01,00,0FH,'MOVD A,FT DB OOCH, (11; o,;,. 41:<H,. ORL A,R:::· DEi OOBH,01,0(>, JOH.' INC ;;)RO' DB 0(1CH. 01, 0(1,4CH. 'ORL A.R4' DB OOBH, 01, 0(1, 1 lH,' INC .ilRl • DB O,)CH, 01. or,, 4DH, 'ORI. A. F/5"' DB (1(>7H, 01. (l1, 12H, 'JB(>' DB (>t)CH, 01, ()(," 4Et-4~ .. ORL A,F6' DEi OOCH, (IJ, 01, 13H,. ADDC A,#' DB O(>CH. (11, (1(1, 4FH, 'ORL A,R7' DB 011H, (11, 01, 14H. 'CALL f·AGE 0.#· DB ,,:.1,)DH ~ (11 "()(1.., ~ 1JH. '!" ANL H",i,RO" DB 009H, 01, OC,, 15H, 'DIS l, 

DB .(;(l[rh.!)1" (l•), 51H!' ~ ANL A, ,o)f'l' DE< (107H, (>1, ~•1, lbH, 'JTF' DB 007H.C1t,01,52H~'JB2' Di; 009H, (>1, OO, 17H,' INC A' DI= (1,)BH. 01, 01, 53H, • ANI. A,41· 
DB OOAH.01,00,JBH,'INC fW' DE< 01 !H. OJ, 01. 54H, 'CALL PAGE. 2 ... ~ 
DB OOAH, 01, (1(1, 19H, 'INC RI. DB OOAH. 01., (,,)" 5'5H. 'STR.1 T' DB OOAH, 01, OC>, lAH, • INC R2' t,B 007H,Ol,Ol,56H,'JT1' 
DB (10AH, 01. OC•, l BH,' I NC R3' DE< OOEh-f.01, 00, 57H, 'DA A" 
DB OOAH, OJ, (1(,, 1 CH, 'INC R4' [,E< (1(1CH ~ 01 • 00 ~ SBH-. ' ANL A. F:(1 ... 
DB OOAH, (11, o,:,, !DH,' INC R5" [,B c,ocH·, 01. (H). 59H, 'AN~ A,Rl' DB O(•AH, (>1, oc,, lEH, 'l NC R6' DB (i(fCH. (11 , (1(1 , 5AH, ' ANL A, R:'.:' DB OOAH, C•l, 00, lFH.' INC R7' DB Ol)[H. ,:i l. (► (1., 5BH" .. ANL A~R3. 
DB C10DH, 01, c,c,, 2(>H, 'XCH A, .>R,:,· DB (t(,~H. (11. (l(i R SCH .. 'At-JL A,R4• DB OC>DH, (tl, OO, 21H, 'XCH A,.>Rl' DB (10CH.Ol,00~5DH~-ANL A,R5·· 
DB (106H, (IJ, (t(,, ZZH'" "7:"!' DB (1(1Cf-'.l. 01, ~)(I. SEH .• ANL A,R6' DB OOBH,Ol,Ol,23H,'l'IOV A.*· DB (H)C: H ~ (11 !' 0,:1, 5~ H' , ANL A,R7' DB Ol(>H, 01, C>l, 24H, 'JMF· F·AGE 1, *. DB 00CH.(1t 9 (104 60H. ·A~D~.~pi~· 
DB OOCH, 01, (I(>, 25H, • EN TCNTl' DB OOCH, (t 1, O•:O, 611-,, 'AD[,A, ~Fil ' DB OOBH, 01, 01, ZcH, 'JNTO' DB (n)Bh. (l l ii ( 10 ~ 6:-H,. • MDV T,A" 
DB 009H,Ol,00,27H,'CLR A' DB O(~oH. 01 '.'•JO~ 6"3H! "7''?~ 
DB c,c,cH, 01, 00, 28H, 'XCH A.R'J' DB OJOH,01,01,64H, 'Jl'IP PAGE ::.•· DB (>OCH, 01, OC•, 29H, 'XCH A.RL' DB 0(1DH, (11 • (1(1, o5H, 'STOF" TCNT"" DB OOCH, 01, 0(1, 2AH. 'XCH A.R:2·· DI" 006H,01,00,6cH, '?7• DB OOCH, 01, 0(1, 2E<H, 'XCH A,R3' DB (109H, 01, 00, 67H, 'RRC h. 
DB oc,cH, 01 '1)(1, 2CH, "XCH A,R4" DB OOCH, ,:,1, ,:,o, 68H. 'ADD A. Rfr' DB OOCH,Ol,00.2DH,'XCH A,f:5• OB OOCH, (,1, 00, 69H, 'ADD A,Rl' DB OC>CH, C•l, 00, 2EH, 'XCH A,R6' DB OOCH, 0 I, OC•. oAH, 'AOt, A, F.2 • DB OOCH,Ol,00,2FH,'XCH A, l<.7' DB OOCH.01, (1,:,, 6BH, 'AD[• A,R:C' DB OOEH, c,1, 00, 30H, 'XCHD A, .>RC>' DB OOCH. (tl, O•J, oCH, 'ADD A,R4' DB OOEH,Ol,00,31H,'XCHO A,.>Rl' DB (IOCHt O 1 * iJ(t. 6-DH •• A[itJ A .. F.:5~ DB C1(17H, (11, 01, 32H, 'JB I' DB c,ocH, 01, <•L), cEH, 'ADD A,R6' DB OOcH,Ol,00,33H,'??' DB OOCH, (1 l, 0(1. 6F"H, • ADt, A,R7' DB 01C•H, 01, 01, 34H, 'CALL PAGE UI" OB OOEH, 01 , 00, 7(•H. 'ADDC A. ;j)p,;,· 
DB OODH,01,00,35H,"DJS TCNTI' DB (1.;,0-1, 01. OC,, 7 IH, 'ADDC A,.>F:1' DB O(i7H,Ol,Ol,36H, "JTO' DB 007H,Ol,01,7ZH. 'JB3' DB 009H,Ol,o0,37H,•cpL A' DB OOcH, 0 I, 00. 73H, • ?7• 
DB 006H,01,00,~BH.'??· DB 011H,01,01,74H,'CALL PAGE :: , .. , 
DB OODH,Ol,00,39H,'0UTL F'l,A' DB OOCH, 01, (>Ct, 75H, 'ENTO CLI<' DB OODH,01,00,3AH,'0UTL P2,A" DEi 007H,Ol,Ol,7cH,'JF1' 
DB 00cH,01,00,3BH,•~?• DB 008H, 01, 0(1, 77H, 'RR A' 

DB OC•DH, (I 1 , (1(1. 78H, 'ADDC A,Ft). 
DB OODH, 01, C>C1, 79H, 'ADDC A,R1' 
DB OODH, 01, (I(>, 7AH, 'ADDC:. A,r.:::-· 
DB OODH,(,1,oc,. 7BH, :-.:.one A, i;:. 
DB OODH,01,00,7CH,'ADDC A, F.·4 • 
DB OODH,Ol,00,7DH,'ADDC A,R5' 

Exhibit 22-4. Mnemonics table for the 8048 microprocessor. This is an 
assembly language source file, designed to be assembled using ASM, the 
Digital Research assembler supplied with CP/M. This listing is provided 
here as an example; the COlllpiled file is included on the Logic Analyzer 
Disk as 8048FAM.LAM. 
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DB OODH, (1J • (u), 7EH, • 4DDC A.h~· DB 006H. 01, Q(,. OCOH. • -:,-:,· n 
DB OC1DH, 01, (1(1, 7FH. 'ADDC A,RT DB 006H, 01, 0(1, OClH, • '?'":"" 

DB OOEH. (1J • 01, B<)H, 'MOVX A. ~r.:o· DB 006H,01,00,0C2H,"?-:>' 
DB OOEH,01,01,BlH,"MOVX A, i)Rl' DB 006H, (11, 00, OC3H, '"'7' 
De 006H, (11, 00, 8:"H, . .,. .... DB 01 OH, (11, 01, OC4H, 'JMF· PAGE 6 ••• 
DB 007H, 01, 00, 83H, 'RET' De OOBH, 01 , 00, (1C5H, ' SEL RBO" 
DB (11(1H, 01, 01, 84H, 'JMP PAGE 4, .... De 006H, (11 ,01. C1C6H, "JZ' 
De (10AH, 01, 00, S~H. 'CLR Fe,• DB OODH,Ol,OO,OC7H,'MOV A.Psw· 
De 007H, 01, 01, SeH, "JNl" DB OOAH, 01, 0•), OCBH, 'DEC R,:i· 
De OC16H, 01, (1(1, 67H, ,..,,..,. DB OOAH, 01, c)O, OC9H, 'DEC Pl' 
De OOOH,01,01,BBH,'ORL BUS0 t1· DB OOAH. 01, (H'.i, OCAH, 'DEC R2" 
DB (l(>CH, (l l , 01 , 8G'H, ' or;;.:L P(>,#. De 1)r)AH, ':!l, (,(,, OCBH, 'DEC R:".' n 
DB OOCH, 01. (11, BAH, 'OR;.. F'l,tl' DB (lr)AH, (11, (H), (1CC"I-I,. DEC R4' 
DB 006H,Ol,0(1,9[1H. DB (1(1AH. 01, 0•), (1CDH,. DEC f<5' 
Do OODH. (I 1 • (1(1, SCH, " □RL[, F·4,A" DB (u)AH. ,:,J. (10, OCEH. "DEC R6" 
DB (i,')DH, 01, (h), BDH, • OF.LO F'~.;... DB (,(IAH. 01, (1(,, (1:'.FH. • DEC R':". 
DB OC1DH, 01, 0(1, EEH, "ORLD P6. A' DB Oi)DH. (=:. (1(,, C•D•)H, • XRL A, :jF,:,· n 
DB O•)DH, 01, (1(,, BFH, • OF.LD F·7. ,;· DB OODH. (1 l . (I(,, (•D1 H. ' >:hL A . .ilFl. 
DB (1(1EH, 01. 01. 9<)H, • MOV)· ill'-;(,• A, DB o•)7H, ,:i1. 01, oo=H. 'JBo' 
De 00EH,Ol,Ol,91H,"MDVY ;ilF·l ,A· DB O(•BH, ,:-1. 01. C>D3H, • XF.L A.~· 
DB (1(1".'H, 01. 01, 92H,. JE-4. [,? 011H,•11.0l.0D4H,"C~LL F'AGE 6. ill' 
Dr (,(1aH. (11, (1(1, 93H. "RE TF· • n• OOBH, (JI.•)(,, (!D~~ •• SEL F.BJ • n 
De 011H, 01, 01, 94H •• CALL PAGE 4 .•• DB 006H, (11 , (1(,, 1)C,6H. • ""'7' 
DB OOAH, C>l, 00, 95H,. CPL FD' DB OODH, (11, (1(1, C>D7H, 'MDV F'SW.A. 
Do (H)7H,(ll,(•1,96H, 'JNZ" Dr •)!•CH, ilj, (11), (1DaH, • XRL A.F·,:,· 
DB 009H, (11, (J(i, 97H .• CLR c· Df ,.:,ocH. 01, ,)(,, (iD9H, • >:RL A,Fd' 
r,B OC•DH, 01, (>l, 98,-,, • ANL EtUS,tl' DB 00CH, 01, 00, OOAH •• XRL A. F.:·· 
DB 0(1CH, 01, C•l, 99H,. ANL F· l, ti' De OOCH, 01, (1(1, ODBH, 'XRL A.F.:-,· 

n 
DB 0(1CH, ,)J. 01, 9AH. 'ANL F:::.~• DS OOCH, 01, •)0, ,)DCH, 'XF:L A,f.L:' 
DB 006H, Ol,(1(1, 9EtH, '-;:•"'" DB OOCH, (l l, (1(1, (1DDH •• )'.RL. A. F:~,· 
r,e OODH. (>1. ( 1(1. 9CH, 'ANL[• F·4,A' DB OOCH, (, 1, (,,), !)[)EH .• i.RL ?.,F,·e,• 

Df (h)DH. •)l,0•~•. 9r1H. "AN~r• F'5,?." DB OOC.H, (1 l, (lO, OOFH .• >:F:L A.F7. 
De (1,)DM. 01, (1,:,, 9EH, • ANL [l Fo.A· Df 0')6H, (11. ,)(1, OE•)H, • "'7• n 
DB (1(1[lh, Ol, OC,, 9FH, • ANi...D F'7,A" DB (106H, (, l • l1(,, ( 1E lH, • ..,7. 
De OODH, ,)1, (l(l', OA,:,1,1, 'MDV ;ilf..(l,A' DB 0(16H, (, 1, 1)(1, OE:::H. • ..,..., • 
DB c .. :ir,H. ,:,1. (h;,, i)?tlH, 'MO'./ ,i>Rl ,A' DB (,(,fl-,,•) 1, (l.:,, OE:".H, 'MOVF·:; A.,;:,.:;· 
Df 006H,01, ,)(,, OA2H, ,-:,..,, DB OIOH,01,Cll,OE~H •• JM~ F"AGE 2.•· 
DB ,:u)DH. (11 . 0(1, (1?. 3H, ' MO'.JF• A, ~A· Df 0(,[1H. (I 1, (1,), (lf5H. 'SEL ME;, n 
DS (ll (,H, 01. (,1, (iA4H,. ~lMF PA5[ !i, ... DS (i;:,':'H, (:1, 01, •)EU·,,· JNC'' 
DB OOAH. (, 1 , 0(1, OH5H, 'CL.F. Fl. DB ,: .. '.•7h, ,:, J , on, (iE7H. • F:LA. 
DB OOCH, 01 • (l(,, (;At,H, "" 0-~1DH, (, l , 01, OEBH, • DJN2' F:c,, ti· 
DB (109H. () 1 . (1(•, (,A 7H •• CF·L c· DI, OODH,01.01,0E=tri, 'DJNZ F:1,fl' 
N· (1(1CH. (11 . ,),), OriBH •• M'.JV R•), A" DI, OODH,01,01.0EAH,"DJNZ R:: • .i· n 
DI, OOCH. (1 l • (!<) • •')A4H, ' MOV Rl.A' t•r (1<)DH, ,:11.01, ,)EFIH .• D~lNZ R:.,.i. 
DB OOCH. (11 , (1,:,, C•AAH. ' MDV F::::.;... Dr< (iODH, 1)1. •)l, <)ECH. "DJl~Z F.4, :ff' 
DS OOCH, (l l . 00, C1ABH, ' MOV F.3,A' DB OC•DH, ,(11, 01, •)E['IH, • D~lNZ R5 . ..i· 
De (1(>CH. 01, c)(,, OACH, • MDV R4,A" De 0 1)DH, (1:1, 01, OEEH, 'DJNZ F;.:, ..... 

DB OOCH, 01, 00, 1)ADH, • MDV R5,A' DB (n)DH,Ol,(11,0EFH, "DJNZ F,7, ... 

DE O,)CH, (11 • c)(l, OAEH, 'MO\/ R6,A' DB OC1DH, 01, (11), OFOH, 'MO'._' M,:;ii::c· 
DB OC•CH, (11 , n,:,, OAFH .• MDV F:7, ~- DB (H)DH,01,0(1,0FlH. 'MO'✓ A, .ilf.:J. 
DB (10DH, 01, (l 1, (lf1(1H •• MDI.' ~F:,:,.t1· De 007H, 01, c)l, OF2H, 'JB7" 
DB O(tDH, (11, 01, OBJ H, • MO',' ~F.l ,ti. DB OC16H, 01, OCi, OF:'.',H, • ":::-?' 
DB 0(17H, (ll, 01, .__)B2H. • J[1=, • DB 011H,Ol,Ol,0F4H,'CALL PAGE. 7,:M" 
DB OC•BH, 01, (11), OB3H, 'JMPF ••• DB OOBH, (11, 00, OFSH, • SEL ME<l. 
DB 01 lH. (ll, 01, OB4H, 'CALL F'AGE 5,it1· DB (106H,01,01,0F6H, 'JC" 
De OC1AH, (1 I , C•O, OB5H, ' CF·L F"l' DS 009H, 01, 00, OF7H,. RLC •• 
DB 01)7H, (11 • 01, OB6H. 'JFi.)" DB OOCH, 01, 00, C~BH, 'MDV A,Ro· 
DB 006H, (ll, (l,), 0B7H, • ?';'•' DB OOCH.Ol,OO,OF9H, 'MDV A, Rl. 
DB OOCH, 01. (11, OBBH •• MDV RO.ti" DB (10CH, (>1, (1(1. OFAH. 'MOV A,R:'' n 
DB OOCH, 01, 01, OB9H, "MDV RI.ti" DB 0(1CH, 01, 00, OFBH, 'MDV A, F:3' 
DB OOCH. 01, 01, OBAH, 'MDV R:,t1• DB OOCH, (>1, 00, OFCH, 'MDV A,f.:4' 
De OOCH,01,01,0BBH,'MOV RJ.,tl' DB OOCH, 01 , 00, (IFDH, -• MDV A,R5' 
DB OOCH,01,0l,OBCH, 'MDV F.4, ... DB (IOCH,01,00,0FE'H,'MOV A,Ro' 
DB OOCH, 01, 01, OBDH, 'MOV R~,t1· DB OOCH, 01, 0(1, VFFH, 't-to·~• i:i, F-:7' n 
DB OOCH,01,Cll,CIBEH,'M□V Ro.ti· TBLEND: 
DB OOCH,01,01,0BFH, "MDV Fc1,•· 

n 

" Exhibit 22-4 (continued). 
Rev. D 
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23. HISTOGRAM DISPLAY 

23.1 INTRODUCTION 

The Histogram function calculates statistics on the data in Sample 
Memory. It is primarily used for studying program execution to improve 
efficiency. When the data in Sample Memory represents addresses of 
instructions in a computer program, the Histogram can be used to measure 
bow much time the computer spends executing different parts of the 
program. 

An example of the Histogram Display, which combines menu and 
display on the same screen, is shown in Exhibit 23-1. 

A histogram is the result of a statistical procedure in which items 
are sorted into different categories according to some characteristic, 
and then the items in each category are counted. 

Exhibit 23-1. Histogram Display. Typical values have been entered in 
Items 2, 3, and 4 to provide an example. 
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The algorithm that produces the Histogram Display works as follows. 
It looks through the Sample Memory for sample data falling in the range 
specified in Items 1 and 2; let us call those "in-range samples." An 
in-range sample will sometimes appear in a "run" of in-range samples 
(that is, with other in-range samples before or after it, or both) and 
sometimes all alone. 

Two questions are of interest here. First, how long are the "runs" 
of in-range samples - how many samples are there in each run? Second, 
and more important, how are the samples distributed in the runs of 
different lengths - how many samples fall in short runs versus long 
runs? So the histogram algorithm identifies the "runs 11 of in-range 
samples, sorts them into categories by length of run, and then counts 
the number of samples in each category. 

Refer now to Exhibit 23-1. The column on the left gives run 
lengths, that is, 116-9 11 means runs 6 to 9 samples long. The second 
column is the percentages of in-range samples that fall in the runs of 
different lengths. The exhibit shows that 3% of the in-range samples 
fall in runs 6 to 9 samples long. 

Note that the base for the percentage (100%} is the total number of 
in-run samples in the Sample Memory. Thus the percentages shown in the 
histogram will always total (~pproximately) 100%. 

This may be applied to computer operation as follows. A 
microprocessor fetches instructions from memory in a sequential fashion, 
incrementing its program counter one, two, or three bytes, depending on 
the length of the instruction. Program loops or branches, however, 
cause the sequence to change. While a program may have no more than a 
dozen instructions within a certain address range, if a loop is there, 
the processor may make thousands of instruction fetches all within in 
that same address range. 

Thus long "runs" of instruction fetches within a certain range of 
addresses reveal intense activity within that part of the program. By 
making a number of Histograms Displays with different range settings, 
you can identify which parts of the program are using the most execution 
time. 

There are three steps to using the Histogram function. 

First, attach the probes to the appropriate points in the equipment 
you are testing. Set up the data collection conditions on the Trigger 
Menu and (if necessary) the Options Menu. 

Second, call up the Histogram Display with the H Command and enter 
the desired parameters in the menu items - the upper and lower limits of 
the range in Items 1 and 2; if multiple accumulations for better 
statistical averaging are required, the desired number of accumulations 
in Item 3; and if run length categories other than the default values 
are desired, the Scaling Factor in Item 4. 
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Third, type "G" to cause data collection. Each repetition of the G 
Command collects new data. 

11:! HISTOGRAM !Jim[ 

As with the other menus, type the item number to put the entry 
cursor on a menu item. The following paragraphs give more details about 
the individual menu items on the Histogram Display. 

Item 1) Start of Range: 

Enter the lower limit for the range in this item. The lower limit 
must be a number between 0000 and FFFF hexadecimal (O and 65,635 
decimal). The default radix is hexadecimal. The number entered should 
contain a radix suffix (e.g., D for decimal, 0 for octal, B for binary) 
if some value other than hexadecimal is input. Numbers entered in octal 
will be immediately converted to hexadecimal on the display. 

The value entered here also depends on the active channels selected 
in the Trigger Menu, T Command. Channels that are not active are 
treated as "don"t care" values both in the data sampled and in the 
numbers specified in Items 1 and 2. For example, if only the lower 
eight channels are active, and they are connected to a computer address 
bus, then all address bits except the lower 8 will be "don"t cares". 
This will usually increase the number of samples that will be counted as 
in-range. 

Inactive channels are assigned a binary value of O for display in 
this item. For example, assume that 3333h is entered in this item while 
Channels 1 and Oare inactive. The Omni converts 3333h internally to 
its binary equivalent, "0011 0011 0011 0011 "• Since Channels O and 1, 
which correspond to the last two bits, are inactive, the last two bits 
are changed to "00", so the binary number becomes "00il 0011 0011 0000". 
The hex equivalent, "3330", is then displayed in Item 1. All this is 
done automatically when you type in "3333". 

Item 2) End of Range: 

Enter the upper limit for the range in this item. The comments 
above regarding the number entered in Item 1 also apply here. 

Item 3) Number of Accumula.tions: 

The Histogram function can perform repeated accumulations for 
better statistical accuracy. Each individual histogram (left set of 
bars in Exhibit 23-1) is generated from the 1000 samples of one data 
collection cycle. For some applications, 1000 samples may not be enough 
to give statistically significant averages. With a sufficient number of 
data collections, however, _a good statistical account of the event can 
be generated on the cumulative histogram (right set of bars). Enter the 
number of repeated collections desired in this item. If a O (zero) is 
entered in Item l, the Omni will repeat accumulations until the space 
bar is pressed. 
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Item 4) Range Scaling Factor: 

Here "range" in the name of Item 4 means "rtm lengths." Nine 
categories of run lengths appear to the left of the display. The 
default categories divide the in-range samples into runs of 1, 2-4, 5-9, 
10-19, 20-49, 50-99, 100-199, 200-499, and 500+ samples. For an entry 
to be made in the 2-4 category, for example, the data collected must 
have fallen within the range specified via Items 1 and 2 for at least 2 
but no more than 4 consecutive samples. 

Finer resolution can be obtained by scaling. Scaling by a factor 
of 10 will then put the top category at So+ and the shorter periods 
proportionately narrower. If scaling is desired, enter the scale factor 
in Item 4. 

23.3 DISPLAY CHARACTERISTICS 

Features of the statistical data produced by the Histogram function 
and shown on the display are: 

Samples - the categories of run lengths for which statistics are 
collected: runs of 500+ samples, rtms of 200-499 samples, and 
so on in the default case. The example in Exhibit 23-1 uses a 
Scaling Factor of 10, yielding rtm length categories of So+, 
20-49, and so on. 

% - the percentage of in-range samples falling in runs of the 
various length categories. The base for the percentage is the 
total number of in-range samples, that is, the samples lying 
in the range given in Items 1 and 2. In the example shown in 
Exhibit 23-1, 3% of the samples lying within the range 000OH 
to BFFFB are in runs of 6 to 9 samples; 1% lie within runs 5 
samples long; and so on. The first% column expresses the 
statistics for the most recently collected data. 

Freq of Last Sample - histogram prepared based on the data most 
recently collected by the G Command. The bar length is 
proportional to the percentage to its left, just defined 
above. 

% - same statistic as that contained in the first% column, except 
that it expresses statistics accumulated (averaged) over a 
number of data collections. In order to get enough data to 
make a statistically significant histogram, it may be 
necessary to accumulate data over several samplings. The 
example shows a histogram accumulated during 100 data 
collections. 

Cumulative Frequency - histogram based on statistics accumulated 
(averaged) over a number of data collections. The bar length 
is proportional to the percentage just to its left. 
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A Help Page for this function appears in response to "?H". When 
viewing the Histogram Display, Help Pages for the individual menu Items 
1, 2, etc., may be accessed by typing "? l", "?2 n, and so on. After 
viewing a Help Page, press <SPACE> to return to the Histogram Display. 

Rev. D 
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24. SIGNATURE ANALYSIS 

24.1 INTRODUCTION 

A signature is a checksum calculated from the data stream passing a 
circuit node. A very powerful troubleshooting technique, signature 
analysis is used to isolate faults in defective circuit boards. The 
user compares the signatures at various points on a malfunctioning board 
to the signatures for a known good board. 

The Omni's signature analysis function is controlled by a combined 
menu and display which appears in response to the S Command. Exhibit 
24-1 shows an example of the menu and display. 

1) Start on: l&P!HG LCU LEVEL 

2) End on: U12-PIH9 LCU LEVEL 

3) Clock Polarity: HEG [[);[ 
4) Clod (}Jal ify: [))ff a:RE 

5) Tr i g £nab I e on: [))ff a:RE 

6) Save to file: 
7) RPad from file: 53 
8) RPad setup f1 le: 
9) ~lete signature f1 le: 

Huntier of Sanp l es: 1012 

Clianne I 
TEST-POIHT-0 
La-PIH25 
LL6-PIH19 
J3-PJH23 
U12-PIH3 
~1-PIHU 
~3-PJH5-DECO'O 
L.6-14--CLOCK( C) 
tB-14--CLOCK(B) 
LJl-9---CLOCK(A) 
~7-PIH16 
TEST-FDIHT-A 
~-9--SYHC-OET 
[JlTA-IHFUT 

~le Reference 
801[ <-> 0353 
EJV <-> 2CI)[ 
-m> <-> B7A[ 
003( (-) 7CS8 
0010 <-> 0183 
$3F <-> 4100 
2876 <-> 8788 
8788 8788 
!Jl10 <-> nEI 
6~3 6~3 
8788 <-> 287& 
8788 8788 
Ef:110 <-> 25[[ 
6~3 69J3 

I Enter 1-9, G to s~le, 7, P, (space) to exit 

Exhibit 24-1. Signature Menu (left) and Display (right two columns). 
Sample signatures that differ from the Reference signatures are marked 
by a"<-->" symbol and highlighted. 
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The signature analysis algorithm generates a four digit hexadecimal 
number. Many manufacturers of digital electronic products now provide 
signature test points and correct signatures in their service manuals, 
making signature analysis possible on the service bench as well as the 
production line. 

The Omni can perform signature analysis on up to 14 test points 
simultaneously. It can collect "reference good" signatures; store them 
on disk; recall them from disk; and collect test signatures and compare 
them to the reference signatures. 

There are three steps in performing a signature analysis: 

First, connect the probes to the equipment to be tested. Connect 
the Omni's Clock probe lead to a circuit point carrying the clock signal 
that will be used. When collecting signatures, the Omni uses the DO 
line to sense a Start signal and the Dl line to sense an End signal; 
connect the probe leads to those signals. Finally-, collect one or more 
of the other 14 data lines, D2 through DF, to the circuit nodes at which 
the signatures are to be taken. 

Note that any one, all, or any combination of the 14 lines may be 
used simultaneously, making thorough testing at multiple test points 
very easy. (In fact, when used with a bed-of-nails board test fixture, 
the Omni will perform most of the functions of a large production board· 
test system at a fraction of the cost.) 

Second, enter the appropriate parameters on the menu - polarities 
of the Start and F.nd signals, Clock Polarity, and if desired, Clock 
Qualify and Trigger Enable conditions. If comparison with Reference 
signatures saved on disk previously is desired, enter the name of the 
file in Item 7. (How to put the Reference signatures on the disk is 
explained below.) 

Third, type "G" to collect samples and generate the test 
signatures, which will appear in a column under "Sample". Any 
signatures which differ from the corresponding Reference signatures to 
the right will be highlighted. 

Reference signatures are created by collecting signatures from a 
known good board; saving the signatures to a disk file using Item 6; 
then recalling the disk file data to the Reference signature memory 
using Item 7. Details on this and other aspects of using signature 
analysis are given below. 

NOTE: Reference signatures can be saved to disk and recalled only by 
using Items 6 and 7 on the Signature Menu. The save and recall 
functions on the File Menu operate only on sample and reference data, 
which are different from sample and reference signatures. Signature 
files have extension ".LAS", while data files have extension ".LAD". 
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24.2 ~ ITEMS 

Details about the individual menu items are given in the following 
paragraphs. 

Item 1) Start on: 

All signals entering the logic analyzer are ignored until the level 
specified for the Start level (high or low) is detected on Channel O. 
Signature generation begins with the first sample collected after the 
start condition is satisfied. 

Enter a 111" in Item 1 to indicate a high Start level, or a "O" to 
indicate a low Start level. 

Item 2) End on: 

Enter a "l" in Item 2 • to indicate a high End level, or a "O'' to 
indicate a low End level. 

Signature generation continues for all samples collected up to, but 
not including, the sample during which the end condition is satisfied. 
If an End signal does not occur within 1000 samples of the Start signal, 
signatures will be calculated based on the first 1000 samples after the 
Start signal. Thus if it is important that the signatures be based on a 
hardware End signal, take care to select an end condition that will 
occur within less than 1000 samples of the start condition. 

Item 3) Clock Polarity: 

Signature analysis requires an external clock signal from the 
equipment under test. Internal clocking is inapprop~iate for signature 
and is not allowed. Select the external clock edge that will provide 
valid data for the type of circuit being tested. For example, if a 
microprocessor•s active low read control line is used as the external 
clock input, then the positive edge would be used to collect data since 
the processor data bus is stable on the positive edge. Enter a "l" in 
Item 3 to indicate clocking on the positive (rising) edge, or a "O" to 
indicate the negative (falling) edge. 

Item 4) Clock Qualify: 

Data collected for signature analysis is recorded on the clock 
edge, but only when the Clock Qualify line is at a specified level. If 
no qualification is desired so that every clock edge records a sample, 
then the "don't care" condition should be used. If data collection is 
to occur when the qualify line is at a higlt level, enter a "l". Enter a 
"O" to allow data collection only when the clock qualify line is at a 
low logic level. Entering "X" makes this item "don•t care", which is 
the default condition. This function increases the flexibility of data 
collection. 
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Item 5) Trig Enable on: 

The Trigger Qualify line can be used to enable the Start condition, 
so that data collection begins only when both Channel O and the Trigger 
Qualify line match their specifications. Enter a "l" in Item 5 to 
achieve trigger enable on a high level. Enter a "O" to achieve trigger 
enable on a low level. If you do not wish to use trigger enable to 
qualify Start collection, enter an "X". 

Item 6) Save to File: 

Signature values for all fourteen channels can be saved on disk for 
later reference by entering the filename under which they are to be 
saved in Item 6. Enter a filename of up to eight characters. A drive 
specification can also be included per the usual operating system 
convention (e.g., B:FILENAME). The extension ".LAS" is automatically 
appended to the filename; if a extension is entered, it is ignored. 

The setup information used to collect the data is also saved on 
disk. The Reference signatures are not saved. (They are already on 
disk, and will remain there.) The saved data can be retrieved by using 
either Item 7 or 8. 

Item 7) Read from file: 

Signatures which were saved with Item 6 can be retrieved and placed 
in Reference Memory for comparison with the newly sampled signatures. 
Sample signatures that do not correlate with Reference signatures are 
highlighted. Enter a filename as in Item 6 above. If the file does not 
exist, a message to that effect will be flashed on the screen. 

Item 8) Read setup file: 

This item allows retrieval of signatures and set-up information 
stored on disk. The hardware will then be configured according to this 
set-up information. This option can be used to repeat a test performed 
at an earlier time. 

Item 9) Delete signature file: 

To delete a signature file, enter its name (without the extension) 
in Item 9, followed by <RETURN>. It will be immediately erased from the 
disk. 

Number of samples: 

This parameter on the menu shows the number of samples used in 
generating the signatures, which is equal to the number of clock cycles 
between the Start and End signals. 
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A Help Page for the Signature Analysis function may be called up 
with "?S". When viewing the Signature Analysis Menu, you can call up 
individual Help Pages for Item 1, Item 2 1 etc., with the commands "?l", 
"?2", etc. After viewing the information, press <SPACE> to return to 
the Signature Analysis Menu. 
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25. PRINTER OUTPUT 

25 .1 INTRODUCTION 

Any of the data displays - such as Waveform, Edge, Dump, 
Instruction Disassembly, Histogram, Matrix, Signature, etc. - may be 
sent to a printer for a permanent hardcopy record by using the CTRL-P 
Command, Printer Output. CTRL-P ("control P") is activated by holding 
down the <CTRL> key and striking the "P" key. The "P" key can be upper 
or lower case. 

~ COMMAND FORMAT 

Anytime the prompt cursor appears in the lower left corner of the 
screen, you can use one of the following formats to print what is shown 
on the screen: 

CTRL-P 

CTRL-Px 

Print the information displayed on the screen. 

Print the information shown on the screen, starting 
at sample x. 

CTRL-Px,y Print the collected data from sample x to sample y, 
in the same format in which it was last displayed 
on the screen. 

CTRL-P? Print all Help Pages on the printer. 

The samples x and y may be designated either by the sample numbers, 
or if Internal Clock is being used so that there is a meaningful time 
scale, by the sample times. 

l2,!1 EXAMPLE 

CTRL-P 10,50us Print data from sample number 10 through the sample 
collected 50 microseconds after the trigger. The 
display mode will be the same as last shown on the 
video screen. 

.ll!!, CONNECTING I!!! PRINTER 

Either the Parallel Port or Serial Port may be used to drive the 
printer. Normal output is to the Parallel Port. If you wish to use the 
Serial Port, use the CP/M program STAT to direct output to the the 
Serial Port: 

AO>STAT LST:-TTY: 

Further information on setting up the ports (baud rate, etc.) for 
your printer may be found in the user's guide for the computer. 

The Omni expects to receive standard "ready" handshaking signals 
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from a printer when data is sent out. If you use the CTRL-P Command and 
no printer is connected, the Omni will go into a wait loop, waiting for 
a nonexistent handshake signal. To recover from this, use the Reset 
function and start over. Any data in the Sample Memory and your 
parameter settings will be lost when you use Reset. To avoid this, make 
sure a printer is connected and operable before you use the CTRL-P 
Command. 

Omnis manufacture before mid-1984 have a single serial port, while 
units made later have two serial ports, one for a printer and one for 
data. On the units with one port, the port is configured as a DTE port 
under the RS232C standard. Serial data is sent out on pin 2 of the 
connector, and received on pin 3. When used for printing as the LST: 
port under CP/M, it requires a HI handshaking signal from the printer on 
pin 5. If your printer does not provide this signal, you can jumper pin 
5 to pin 6, where a HI signal is present. 

On the units with two serial ports, The data port (labeled "J4 
SERIAL DATA I/0") is configured the same way as the single port 
described in the previous paragraph. It is not accessed as the TTY: 
port by CP/M, however; your applications software (such as a modem 
program) will access it directly. 

On units with two serial ports, the printer port (labeled "J3 
SERIAL PRINTER OUPUT") is the CP/M TTY: port. It is configured as a DCE 
port under the RS232C standard. Data is sent out on pin 3 and received 
on pin 2. Pin 20 is used for handshaking; it must be driven HI for data 
to be sent out when this port is made the LST: port using the STAT 
command. There is no handy HI signal source present on the connector. 

In printing waveforms, the Printer Output function uses the 
underscore "-" to represent a low, the tilde 11

-
11 to represent a high, 

the slash 11 
/" to represent a leading edge, and the backslash "\ 11 to 

represent a trailing edge. Many dot matrix printers allow downloading a 
custom character set which gives a better graphic representation of 
waveforms. The character downloading may be performed by a small 
program which is run before loading the Logic Analyzer Program. 

Exhibit 25-1 shows an example of such a program, and Exhibit 25-2 
shows the resulting waveform printout. 

25.5 !!§1!'._ PAGE 

A Help Page for the CTRL-P Command may be accessed by typing 
"?CTRL-P". 
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; THIS PROGRAM CREATES A DOWNLOAD CHARACTER SET FOR 
; PRINTING THE OMNI II TIMING TRACES ON A STAR 
; gemini-lOX PRINTER. ALL CHARACTERS ARE STANDARD 
; EXCEPT: . 
' . 
' 

(/) WHICH IS CHANGED TO A VERTICAL LEADING 
EDGE WITH A FLAT TOP . . , (\) WHICH IS CHANGED TO A VERTICAL TRAILING 
EDGE WITH A FLAT BOTTOM. . 

' 
(-) WHICH IS CHANGED TO A FLAT TOP • 

; VERTICAL ALIGNMENT IS ALSO ASSURED BY SETTING UNI-
; DIRECTIONAL PRINTING. NORMAL PRINTER OPERATION MAY 
; BE RESTORED BY TURNING IT OFF AND THEN ON AGAIN. 

0005 • 
0005 • 
001B • 
DOFF • 
0100 

BOOS 
LSTFUNC 
ESC 
TERM 

*PROGRAM EQUATES* 
EQU OSH ;DOS ENTRY VECTOR 
EQU OSH ;DOS LIST FUNCTION 
EQU lBH ;ASCII FOR ESCAPE 
EQU OFFH ;STRING TERMINATOR 
ORG lOOH 

; THIS ROtrrING READS AND TRANSMITS THE CONTROL 
; SEQUENCES LOCATED AT "STRING". 

0100 211501 DNLDCHR LXI H,STRING ;GET POINTER 
0103 7E DNLD2 MOV A,M ;GET A CHAR 
0104 FEFF CPI TERM ;TERMINATOR? 
0106 CAOOOO JZ O ;YES, RETURN TO CP /M 
0109 ES PUSH H ;NO, SAVE POINTER 
OlOA SF MOV E,A ;CHAR TOE REG 
010B OEOS MVI C,LSTFUNC ;AND our TO PRINTER 
0100 CD0500 CALL BOOS 
0110 El POP H 
0111 23 INX H 
0112 030301 JMP DNLD2 

0115 1B2AOO STRING DB ESC,'*',O 

;RESTORE POINTER 
;BUMP POINTER. 
;AND GET NEXT CHAR 

;COPIES STD CHAR'S 
;DOWNLOAD RA.'{. 

0118 1B2A01 DB ESC,' *", 1 ;CHANGES / 
011B 2F007F0001 DB • 2FH, O, 7FH, O, 1,0, 1, O, 1, 0, 1 

0126 1B2A01 DB ESC,'*',1 ;CHANGES\ 

TO 

0129 5C017F0040 DB 5CH,l,7FH,0,40H,0,40H,0,40H,0,40H 

0134 1B2A01 DB ESC,'*',l ;CHANGES -
0137 7E00010001 DB 7EH,O,l,0,1,0,l,O,l,O,l 

0142 1B2401 DB ESC,"$",l ;ACTIVATES DOWNLOAD SET 

0145 _ 1B5501 DB ESC,'U",l ;SETS UNI-DIRECTIONAL 
;PRINT 

0148 FF DB TERM 
0149 END 

Exhibit 25-1. Hubert Evinger of Advanced Computer Concepts, Inc., 'costa 
Mesa, California wrote this CP/M program for downloading special 
waveform characters to a STAR gemini-lOX printer. 
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-:----+----+----+----+----+----+----+----+----+----+----+----+---

cs-------------------------------------r----------------------L_ 

-----------------------------------------------------------------

_______________________ r-----------------------------------------
A15 _____________________________________________________________ _ 

A14 _____________________________________________________________ _ 

A13 _____________________________________________________________ _ 

A12 ____________________ r-----------------------------------------
A11 _____________________________________________________________ _ 

AlO _______________________________________ r----------------------

-----------------------L ________________________________________ _ 

-+----+----+----+----+----+----+----+----+----+----+----+----+---
-39 -34 ·-29 -24 -19 -14 -9 -4 1 6 11 16 21 

88888888888888888888888888888888888888880088888888888888888888888 
00000000000000000000000111111111111111111111111111111111111111111 
00000000000000000000000111111111111111111111111111111111111111111 
31313131313131313131313202020202020202020246464646464646464646464 

C######_####J SM 
Rate 60.0us Delay 0 

Exhibit 25-2. Example of waveform printout after a special character 
set has been downloaded to the printer by the program in Exhibit 25-1. 
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26. THEORY OF OPERATION 

~ INTRODUCTION 

What is a logic analyzer? 

A logic analyzer is an instrument for collecting and displaying 
digital data. Used primarily for testing digital equipment, it has 
input probes that may be connected to integrated circuit pins inside the 
equipment under test. 

A logic analyzer records the logic levels on many lines, over a 
period of time, and then displays the recorded patterns. By examining 
the collected data, you can trace the operation of the digital circuit. 

The logic levels are sampled in step with a clock signal. The 
clock signal either may be generated inside the analyzer (Internal 
Clock), or may be taken from the equipment under test (External Clock). 
Each sampling stores one data word in the logic analyzer's Sample 
Memory. The analyzer continuously collects data in memory until a 
trigger event, which may be either recognition of a specific word in the 
data stream or an external event, causes it to stop. 

Like an oscilloscope, a logic analyzer collects data corresponding 
to voltage versus time and displays it as "traces". Two features make 
the logic analyzer a very powerful tool: 

A) It can collect data on many lines at once; in the case of the 
Omni, on 16 lines, or, with the the 32 Channel Adapter, on 32 lines. 
Observing the bit stream on a single line at one time, as with an 
oscilloscope, is of little value, since the bit pattern is meaningful 
only in reference to the simultaneous bit patterns on other lines. 

B) The logic analyzer collects data prior to the trigger event, 
again unlike an oscilloscope, which starts the trace after the trigger 
event. When a digital circuit goes awry, the cause is usually found in 
what happened beforehand, not afterwards. 

The logic analyzer has two limitations compared to an oscilloscope 
- it records voltage as only "high" or "low" (binary 1 or 0), losing the 
details of waveform shape. Also, it records the logic level only at the 
clock transitions, thus limiting the time scale resolution to the 
minimum clock period that the logic analyzer can handle. (This 
disadvantage is partially remedied by the inclusion of glitch collection 
capability.) The Omni will accept a clock rate of up to 20 MHz, 
yielding 50 nanoseconds resolution. Also, there is a trade-off between 
resolution and length (in time) of the trace; since the Omni can stor~ 
only about 1000 samples, at the finest time resolution it can.store only 
50 nanoseconds x 1000 • 50 microseconds of trace. In practice, this 
limitation proves to be of little hindrance and 1000 samples are quite 
adequate. 
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INPUT 
DATA 

CLOCK 
INPUT 

...... 
✓ 

TRIGGER 
RECOGNIZER 

\') 

CONTROL 
COUNTER 

SAMPLE 
MEMORY 

16K X lK 
35 nS 

ADDRESS 
COUNTER 

/I\ 

Exhibit 26-1. Diagram of the logic analyzer. The Input Data is picked 
up by the analyzer probes. The Clock Input can be either an External 
Clock signal picked up by the probes, or the analyzer's Internal Clock ■ 

26.2 !!Q.E !I, WRKS 

The heart of the logic analyzer is the Sample Memory (see Exhibit 
26-1). As the Clock Input provides clock pulses, the Sample Memory 
stores samples, one sample for each clock pulse. The clock pulses also 
step the Address Counter, so that samples are stored in successive 
addresses in the Sample Memory. 

The Sample Memory is 16 bits wide and holds 1024 words, that is, it 
has 1024 addresses, from O through 1023. When the Address Counter 
reaches 1023, it "rolls over" and stores the next sample at Address O. 
Thus old data is continually being overwritten as the analyzer collects 
new data. 

The Trigger Recognizer is also connected to the input data stream, 
and will have been set (via the Trigger Menu) to detect some combination 
of bits (the trigger word) in the input data. When the Recognizer 
detects the trigger word, it initiates the trigger sequence. 

The trigger sequence consists of two steps. First, the analyzer 
continues to collect a certain number of additional samples. The 
Control Counter manages this, and the purpose is to provide samples in 
the stored trace after the trigger event, as well as before. (The 

Omni Operating Manual 26-2 Theory of Operation 

" n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 

Ka
yp
roJ
ou
rna
l



u 
LI 

u 
u 
u 
u 
u 
u 
u 
u 
LI 

u 
u 
u 
LI 

LI 

LI 

u 
u 

number of samples collected beyond the trigger event is entered as the 
Trigger Point on the Trigger Menu.) 

As the second step of the trigger sequence, the analyzer displays 
the collected samples. The software automatically formats the display 
according to the parameters entered in the Trigger Menu, which usually 
call for the trigger event to be labeled Sample O and displayed in the 
center of the screen. The Omni does not display all of the 1024 
samples; because of timing micertainties in the collection process, a 
few samples at the ends of the trace may be invalid and the Omni 
excludes them from display. 

12.:1 TIMING ANALYZERS~ STATE ANALYZERS 

Early logic analyzers were one of two kinds, either state analyzer 
or timing analyzer. The state analyzer was clocked by some cyclical 
event in a computer, and recorded the "state" (combination of logic 
levels) at some set of circuit points. It was used for tracing the 
operation of a computer circuit as it moved step-by-step through its 
cycle. 

When connected to the address bus, and connected to use a read or 
write control pulse as its clock signal, the state analyzer would trace 
the sequence of memory reads and writes, thereby tracing program 
execution. The state analyzer's output was typically displayed as a list 
of binary words expressed in l's and O's. 

The state analyzer, while showing the correct sequence of states, 
does not furnish the data against an accurate time scale unless the 
clock signal has a uniform and known period. 

The timing analyzer, on the other hand, had its own internal free­
running clock, and capture data without regard to synchronization with 
the circuit being observed. The data was shown in a format similar to 
oscilloscope waveforms, which the timing analyzer was expected to mimic, 
with the added benefit of multiple traces and before-the-trigger data 
capture. 

The timing analyzer does not show exactly the transition times of 
the signals it is trying to measure, since the transitions that appear 
are those of its own clock. Using a 50 nanosecond clock period, for 
example, the timing analyzer shows a signal transition Oto SO 
nanoseconds after it actually occurs, depending on when the analyzer's 
clock edge transition occurred compared to the signal being measured. 

In order to achieve a reasonably accurate representation of the 
measured signal, the timing analyzer clock has to be several times 
faster than the frequency of the events being observed. A popular rule 
of thumb calls for the timing analyzer's clock frequency to be four to 
five times higher than the fastest frequency to be observed. 

High speed is more important to a timing analyzer than to a state 
analyzer. A state analyzer need only be as fast as the system clock of 
whatever it is measuring. 
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The Omni has both Internal Clock and External Clock modes, allowing 
it to serve as either a timing or state analyzer. Its 29 MHz clock rate 
is fast enough to make it quite serviceable as a timing analyzer for 
microprocessor based systems. This flexibility makes the Omni very easy 
to use. Furthermore, regardless of how the data was collected, using 
either internal clock (timing analzyer) or external clock (state 
analyzer}, the data can be displayed in either timing diagram format or 
state diagram format. Once you have collected the data, you can display 
it in several formats until you find the one most revealing. Generally 
speaking, a timing diagram is most useful for studying hardware 
operation, while a state display is most appropriate for tracing 
software execution. 

The Omni also has a Trigger Out signal which may be used to trigger 
an oscilloscope for high-resolution examination of waveforms. This 
enables you to see the data signals in detail - waveform shape, multiple 
glitches, actual logic levels, and so on. The resolution, which is now 
determined by the bandwidth of the oscilloscope, can be as fine as 1.5 
nanoseconds with a 200 MHz scope. 

The Omni's triggering capability allows the oscilloscope to observe 
events that are associated only with a certain data word, or with the 
presence of glitches, or with a combination of both. 

See Section 7 for further information on using the Trigger Out 
signal. 

li.!i SOURCES m:_ ERROR 

To summarize, the logic analyzer is subject to the following 
limitations: 

The square waveforms appearing in the Waveform and Edge Displays do 
not represent the actual waveshapes of the signals being recorded. 
Regardless of the actual waveforms~ the input levels are recorded as 
only HI or LO levels. 

A transition in the input is not recorded until the time the next 
sample is taken. Thus the transitions displayed correspond to the time 
of sampling, not the transition points in the input waveforms. 

Signal activity between sampling points is not recorded, with the 
following exception. Transitions between sampling points are recorded 
as glitches on the lower four channels, and will be displayed if glitch 
display is activated. 

Another possible source of error is loading by the analyzer inputs 
on the circuit under teat. This can be very significant with ·some types 
of analyzers which use long ribbon cables (over 6 inches) and unbuffered 
TrL or LS TTL chips for the input. The Omni series analyzers avoid 
this by using high impedance (1 megohm} buffered probes with 6-inch 
probe leads, which hold the capacitance to a few picofarads. 

Rev. D 
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27. APPLICATIONS 

EXAMPLE 1. A CRT controller that was not putting out any output signal 
or responding to any input. 

"First of all, I checked to see if the clock was running and which 
lines had signals on them and which were dead. 

"I put one of the 8 leads of one probe on the controller clock line 
and the rest at various places in the circuit. The Trigger Menu's 
"logic probe" display showed activity on the clock and other lines. I 
then used the Omni's default sampling conditions - Internal Clock, 50 
nanoseconds Sample Rate - and took a sample. 

"Looking at the Waveform Displays, I saw that the controller"s 
clock was operating properly. Some of the other lines had activity on 
them and others did not. Moving the probes around and taking repeated 
samples, I hunted to find out where the signals were getting stopped. 
One 74LS138 address decoder had lots of activity on the address and 
enable pins, but all the output pins remained high. (The 74LS138 
generates an active low output on one pin when it is enabled.) 
Comparing the waveforms for the address and enable inputs, the chip was 
enabled for address combination 5, which according to the data book 
would cause a low output on pin 10 - and there was not. Obviously, 
either the chip was bad, or a short was pulling the output high. 

"I replaced the chip, and then the unit worked. 

"Total cost - 40 cents in parts and 10 minutes.'~ 

Here, the technician was using the Omni to observe activity on the 
signal lines. While a logic probe can identify active signals, it does 
not provide any clue to the time relationships of the signals, as was 
the key here. No sophisticated trigger settings were needed. The 
Omni's ability to display signals on many lines simultaneously isolated 
a bad chip quickly. 

EXAMPLE 1:. A microcomputer displays its turn-on message properly but 
does not respond to the keyboard. 

"I hooked up the Omni's 16 data probes to the address bus to see if 
the Z80 was reading addresses. I used the· system /MF.MR (memory read) 
signal as the clock. The Clock Qualify probe went on /Ml (pin 27 on the 
ZBO) to collect only opcode fetch addresses. I entered all 1•s for the 
Trigger Event. I pressed 'G' (for 'Go and Collect Sample'), let it run 
for a second, then manually triggered it by hitting the space bar. 

111 used 'D -500' to display the captured data in hex. 
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"Paging through the Dump Display, it was obvious that the Z80 was 
looping OV'er and over through about 20 bytes of PROM code. 

"One of the addresses 2323H. I moved the cursor to 2323H on the 
display, pressed the'•' key to enter it (2323H) as the Trigger Event. 
Then when I ran it again, I would see in the trace how it got to 2323H. 

"Then I pushed down the Reset button for the microcomputer, and 
while holding the button down, typed 'G' on the Omni. The Omni started 
collecting. I released the Reset button. The Omni stopped collecting 
and went back to the Dump Display with the cursor on 2323. 

"Looking at the display, I saw that it was executing PROM code 
around 2080H just before making a jump to 231CH. Studying the listing 
of the assembly language code I had written for the ROM, I saw that 
there wasn't supposed to be a jump like that around 2080H. Using the 
clue provided by the Omni, I checked the PROM - sure enough, it had one 
bad bit• 

"Without the Omni, I could have spent hours looking for shorted 
address lines in the system or studying the code listing looking for 
errors. I wouldn't even have been able to tell whether t had a hardware 

, fault or a software bug without hours of work. This only took me about 
40 minutes, and most of that time was spent getting my tools together 
and taking the cover off the microcomputer." 

Rev. D 

Omni Operating Manual 27-2 Applications 

n 

" n 
n 
n 
n 
n 
n 
n 
n 
n 
n 
n 

" 
" 
" n 

" 

Ka
yp
roJ
ou
rna
l



u 
u 
LI 

u 
LI 

LI 

u 
LI 

u 
LI 

u 
u 
LI 

u 
LI 

u 
u 
LI 

LI 

28. ADVANCED APPLICATIONS 

28.l EXTENDING THE TRIGGER .!!IBP_ 

Some applications may require triggering on more than 17 bits (16 
bits on the data lines plus l on the Trigger Qualifier allows an 
effective 17 bit trigger word). Or, you may want to trigger on one 16 
bit combination, such as a microprocessor address, while recording some 
other data, such as 8 bits on the microprocessor's data bus. 

With the Omni's External Trigger capability, you can trigger on a 
word of any length by using some simple external circuitry to generate a 
trigger pulse. Exhibit 28-1 on the next page shows a circuit that may 
be used to trigger on a word of up to 64 bits. 

The trigger word is identified by 8-bit comparators (TI 74LS682). 
For a 64-bit trigger word, eight such comparators are required with 
their outputs ANDed. The schematic shows only one comparator; the 
circuit for the others is identical. 

The comparators' Q inputs contain internal pull-up resistors, so no 
external resistors are needed. Each switch is used to set one bit in 
the trigger word. Switch closed is a "O", switch open is a 11111 • For a 
"don" t care" (''X") bit, tie the P input of the LS682 high (+5V) and set 
the corresponding switch open. The comparator will see a high on both 
inputs, satisfying the trigger condition if all the other inputs match. 

You can use fewer than eight 74LS682's for fewer inputs. Tie the 
unused inputs of the LS3O high (+SV). 

~ COLLECTING DATA WIDER ~ ll fill§. 

Using the Trigger Pulse Generator will also allow you to collect 
data wider than the Omni's 16-bit word by making more than one 
collection pass. With the Trigger Pulse Generator recognizing the 
trigger word, you can move the data probes around to collect multiple 
sets of data. 

For example, assume that you want to collect data on 32 lines. 
Connect the Omni data probes to 16 lines, collect the data, reconnect 
the probes to the second set of 16 lines, and collect data again. The 
data from the two passes may be combined for 32 bits total. 

Printer output is especially useful here. The data from each pass 
can be printed on paper, then the two sheets spliced together for a 32-
bit "display". Given enough time, patience, and cellophane tape, you 
can get data displays of any length word. 

28.3 ADDED DELAYS AND LOADING 

The delay from the P inputs of the 74LS682 to the output is 
specified as 25 nanoseconds maximum. This delay adds a 25 nanosecond 
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hold time requirement for the data signals;'normally the hold time 
required for the data signals is zero. If this proves critical to your 
application, it may be necessary to put buffers on the inputs to delay 
the data signals by a matched amount. 

The comparator inputs add one TrL load to the circuit to which they 
are connected. This will not be a problem for equipment with adequate 
design margins, but it should be considered, particularly if other loads 
are applied to the same circuit points during the testing. 

T7 
T6 
TS 
T4 
T3 
T2 
Tl 
T0 

74LS682 

P7 
P6 
PS 
P4 
P3 
P2 
Pl 
P0 

TO OTHER 
COMPARATORS 

Q7 
Q6 
Q5 
Q4 
Q3 
Q2 
Ql 
~ 
P-Q 1 

Rev. S-8-85 

s 
3 

- 74LS04 . 

74LS30 

Exhibit 28-1. Trigger pulse generator. When the trigger word appears 
at the inputs, a /TRIG signal is generated that may be used to drive the 
Omni's External Trigger probe line. 
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29. 32 CHANNEL ADAPTER 

29.1 INTRODUCTION 

The 32 Channel Adapter is an accessory for the Omni that extends 
its data collection capacity to 32 channels total. The added 16 
channels are called Bank 1, Channels AF-AO. The original 16 channels 
are considered Bank 0, and retain their original designations, DF-DO. 
Four connectors on the Adapter accept four standard Omni buffered probes 
(TTL or CMOS type), each of which handles 8 data channels. 

The Adapter mounts externally, on the right hand side of the Omni. 
See Exhibit 29-1. Two cables from the Adapter plug into the probe 
connectors below the disk drives. 

The control lines associated with the original 16 channels (Clock, 
Clock Qualify, Trigger, and Trigger Qualify) remain identical. 

The 32 Channel Mode also provides three clock inputs, called 
External Clock, External Clock 2, and Multiplexer Clock. The latter is 
useful for collecting data, particularly for Instruction Disassembly, 
from microprocessors such as the 8085 that use a multiplexed data and 
address bus. 

Most of the Omni's functions are the same with the 32 Channel 
Adapter, except extended to the additional channels. This section 
describes the differences. 

When the Adapter is installed, the Omni has two basic modes of 
operation, 32 Channel Mode and 16 Channel Mode. In 16 Channel Mode, the 
operation is nearly identical to that without the Adapter. 16 Channel 
Mode is retained to provide some functions that are not available in 32 
Channel Mode. 

When using 32 Channel Mode, the maximum data collection rate is 10 
MHz (100 nanosecond resolution) and the trace depth is 500 samples. The 
maximum trigger word width remains 16 bits (17 bits including the 
Trigger Qualify input). 32 Channel Mode is designed solely for use with 
an external clock; it will not work with the Internal Clock. Also, no 
glitch collection capability is available. Glitch collection and 
Internal Clock are available in 16 Channel Mode. 

29.2 INSTALLING m_ ,ll. CHANNEL ADAPTER 

The 32 Channel Adapter may be installed on the Omni with ordinary 
hand tools. Follow these six steps: 

a. Loosen the lower two Phillips-head screws that hold the 
hood on the right side. Be careful not to scratch the finish. 
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Exhibit 29-1. The 32 Channel Adapter is a slim box that attaches to the 
right side of the Omni. 

b. Slide one flange of the metal right-angle strip under 
the hood. 

c. Hook the fingers at the top of the 32 Channel Adapter 
into the vent holes in the hood, so the Adapter hangs from the 
fingers and the mounting holes on its lower edge line up with the 
holes in the right-angle strip. 

d. Insert the screws throught the angle strip into the 
Adapter, and while pressing the adapter against the side of the 
Omni, tighten them securely. 

e. Tighten the screws holding the hood to the Omni on the 
right side. 

f. Plug the two ribbon cable connectors from the Adapter 
into the connectors on the front of the Omni. The shorter ribbon 
cable goes to the nearer connector. 

Omni Operating Manual 29-2 32 Channel Adapter 

n 
n 
n 

n 
n 
n 
n 
n 
n 
n 

" n 
n 

n 
n 
n 
n 

Ka
yp
roJ
ou
rna
l



Li 

LI 

LI 

u 
u 
u 
u 
LI 

u 
LI 

u 
LI 

Li 

u 
LI 

LI 

u 
LI 

Li 

A7-A~ AF-A8 

D7-D0 DF-D8 

Probe ~ £. Input ~ .1 Input ~ 

1 D7-DO Ext Clock Ext Trig 
2 DF-08 Clock Qual Trig Qual 
3 A7-AO Ext Clock 2 Not Used 
4 AF-A8 Mux Clock Not Used 

Exhibit 29-2. The buffered probes plug into four connectors on the side 
of the 32 Channel Adapter. 

Exhibit 29-2 shows the order in which the buffered probes are 
plugged into the 32 Channel Adapter. 

29.3 LOGIC ANALYZER PROGRAM 

A special version of the Logic Analyzer Program called LA32.COM is 
used to operate the Omni with the 32 Channel Adapter. The special 
program also has a 16 channel mode, so that you can use the Omni as 
before. 

Five of the menus and displays have been modified to accomodate 32 
channel operation: the Trigger Menu, Options Menu, Dump Display, 
Instruction Disassembly, and the Locate Function. The shift between 32 
Channel Mode and 16 Channel Mode is controlled by the Trigger Menu. 
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Exhibit 29-3. Trigger Menu used with the 32 Channel Adapter. The Omni 
is in 32 Channel Mode here. When it is in 16 Channel Mode, Channels AF­
AO are all blank in Item 1. Also, Items C and Dare different; Item C 
is used to enter the Sample Rate and Item C the Recognition Mode, the 
same as when the Adapter is not used. 

29.4 TRIGGER J!ISil!. 

Exhibit 29-3 shows an example of the 32 Channel Trigger Menu. It 
has several major differences from the standard Trigger Menu. Details 
about the changed menu items are given below. Item 1 controls the shift 
between modes. 

Two menu items change when the mode is changed. In 16 Channel 
Mode, Item C becomes Sample Rate and Item D becomes Recognition Mode -
the same as in normal 16 channel operation without the Adapter. 

Item 1) Active Probe~ 

This item has been expanded to apply to 32 channels. The channels 
are divided into Bank O, DF-00 (upper row), and Bank 1, AF-AO (lower 
row). 

To make a given channel active, enter a 1 in its bit position; to 
make it inactive, enter an x. Active channels are shown by a 1 or O, 
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and inactive changes are represent by a blank space. Use the cursor 
arrow keys to move the cursor from one channel position to another, or 
keys F,E, ••• 2 may be used for direct cursor positioning. 

32 Channel Mode is in effect whenever there are any channels active 
in Bank l (AF-AO). 'l'he Omni switches to 16 Channel Mode automatically 
when no channels are active in Bank 1. The default mode at turn-on is 
32 Channel Mode, as shown in Exhibit 29-3. 

Only the standard sixteen channels, DF-DO, have the logic probe 
feature, that is, the ability to show the instantaneous logic state of 
the probes. 

Item 3) Trigger Event 

This item is likewise divided into two banks, DF-DO (upper row) and 
AF-AO (lower row). A trigger word may be entered in either bank, but 
not both at the same time. Only one bank at a time can be active, which 
means a trigger word may be recognized in either the DF-DO Channels or 
the AF-AO, but not both. Accessing a bank makes it active, and the 
other bank is automatically made inactive - all X's are displayed. 

A trigger word formerly displayed in the inactive bank is saved 
internally. Accessing that bank will again cause the trigger word to be 
displayed. 

Item B) Ext Clock 

In 32 Channel Mode, there is no Internal Clock and an External 
Clock is required. Each of the three clocks, External Clock, External 
Clock 2, and Multiplexer Clock, is controlled by a menu item. The two 
External Clock inputs are OR'd together within the On\ni, and they act 
internally as a single clock which simultaneously samples all 32 
channels. 

The External Clock input line is on Probe 1. 

Enter 1 in this item to select the rising edge of the clock pulse 
as the active edge, or Oto select the falling edge. While the 16 
Channel Mode allows you to enter X to make the External Clock inactive, 
in the 32 Channel Mode this item will not accept an x. If Probe 1 is 
disconnected, the External Clock is automatically made inactive. To 
make it inactive with the probe connected, enter al and leave the probe 
lead floating (high). 

Item C) Ext Clock 2 

External Clock 2 is a second external clock input line. It is on 
Probe 3. 'l'he comments above about Item B apply to this item as well. 

Item D) Mux Clock 

'l'he Multiplexer Clock function is used to demultiplex internally 
signals taken from a multiplexed source. The Multiplexer Clock signal 
is picked up by the clock input line on Probe 4. 
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When the multiplexer function is active, the 8 data bits sensed by 
Channels DF--08 (Probe 2) are sampled on the active edge of the 
Multiplexer Clock signal, and transferred to a latch. The next external 
clock signal (from External Clock or External Clock 2) will cause the 
data to be collected from the latch into Channels A7-AO (normally 
collected by Probe 3). 

Enter 1 in this item to select the rising edge of the clock signal 
as the active edge, 0 for the falling edge. Enter X to deactivate the 
Multiplexer Clock function altogether. Xis the default entry. 

This function is very useful for collecting data from systems which 
use a multiplexed data bus, such as the 8085 microprocessor. An example 
of such an application appears at the end of this section. 

Item F) Complex Trigger 

The Complex Trigger function provides multilevel (sequential) 
triggering capability. This item is used to activate the Z Menu, which 
controls it. Merely accessing this item toggles the entry from No to 
Yes, or vice-versa. 

29.5 OPTIONS~ 

The Options Menu has been modified to accomodate the extra sixteen 
channels. In particular, Items 1 and 2 allow separate specification of 
the number base in which data is displayed for each of the two banks. 

Item 1) Bank O (Dx) signals 

This item specifies the number base in which the-data collected on 
Channels DF--00 will be displayed in the Dump Display and other displays 
that show the data in numeric form. The default choice is hexadecimal. 
Enter B for binary, D for decimal, U for unsigned decimal, or O for 
octal. 

Item 2) Bank 1 (Ax) signals 

Item 2 specifies the nl.DDber base for Channels AF-AO, similarly to 
Item 1 for Channels DF--00. 

Item 3) Probe bank used for waveforms 

The Waveform Display only shows sixteen channels at a time. Use 
this item to select which bank will be displayed, the D(x) bank or the 
A(x) bank. Accessing Item 3 toggles the selection from D(x) to A(x), or 
vice-versa. Choice of the bank displayed is independent of the bank 
containing the trigger word; you can trigger on the bank you are not 
viewing. 

29,6 ~ DISPLAY 

Operation of the Dump Display is the same as with the standard 
version, except that a full 32 bit word is collected and displayed, 
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Snlple fWr 00-07 ct I bits f'tlemonic 00--0F Sjtes 
141 193:, 01111111 Ee111111 Ail 3F 
143 1933 01111111 00111111 00111111 LXI H,llJ32 
1~ 1cm 01111111 00111111 00111111 LXI D,0EOO 
149 193[ 01111111 00111111 CPI 04 
151 19113 01111111 00111111 00111111 JC 5019 

-> 154 1$0 01111111 00111111 CPI 02 
156 1$2 01111111 00111111 JZ 66 
158 1$5 01111111 00111111 00111111 LOO CJE2 00 
162 1~ 01111111 t1J.I D,A 
163 1$9 01111111 00111111 00111111 LOO F482 00 
167 1%C 01111111 lltA A 
168 1W 01111111 00111111 00111111 JZ 6F19 
171 1%f 01111111 LDl< B 03 
173 1970 01111111 00111111 Ail □ 
175 1972 01111111 w:10 
176 1973 01111111 STAX 8 
177 1974 01111111 fl9I H 
178 1975 01111111 00111111 00111111 LXI H,7682 
181 1978 01111111 f1JJ E,H ffi 
183 1979 01111111 IHR H ffi 
185 197A 01111111 00111111 l'fJI 0,00 
1B7 197C 01111111 PCfl H 113 82 

l Enter: C,D,E,F,G,H,1,L,M,H,O,P,S,T,W,X,Z,~, ?,sp 

Exhibit 29-4. Format of display when Instruction Disassembly is used 
with the 32 Channel Adapter. 

This is revealed by the fact that eight hexadecimal digits are 
highlighted by the cursor, representing the 32 bit word. 

29.7 INSTRUCTION DISASSEMBLY 

Instruction Disassembly functions the same as in the standard 
version, except that it is now possible to view 16 channels of address 
in addition to the 8 channels of data and the control lines. Use 
Channels AF-AO for up to 16 address lines, and Channels DF-08 for the 8 
data lines. Two or three of the channels in the remaining group, D7-DO, 
should be used for the control signals. 

Refer to Section 17 of the Omni Operating Manual for details on 
using the Instruction Disassembly function with various microprocessors. 
Exhibit 29-4 shows an example of the Instruction Disassembly display 
provided when the 32 Channel Adapter is used. The full 16-bit address 
is displayed, as well as the disassembled instructions from the address 
bus. 
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29.8 LOCATE FUNCTION 

The Locate Menu has been modified to accept 32 bit words as the 
search keys. In other respects, operation is identical. 

29.9 EXAMPLE 

The Intel 8085 is an example of a microprocessor for which it is 
desirable to collect more than 16 channels of data, and demultiplexing 
is required. 

The 8085 uses an 8-bit data bus and a 16-bit address. The upper 8 
address bits appear on their own pins, A15-A8. However, both data and 
the lower 8 address bits are multiplexed on one set of pins, AD7-ADO. 
The 8085's multiplexing clock signal is called ALE, Address Latch 
Enable. 

In the first part of a memory read cycle, the CPU places the lower 
8 address bits on pins AD7-ADO. In 8085 systems, ALE is used to strobe 
the bits into an address latch. The output of the latch drives the 
corresponding mempry address lines, usually called A7-AO. 

In the next part of the cycle, the data bits stored at address A15-
A8 are read from memory. The read strobe, /RD, causes the memory to 
place the data bits on the bus pins, AD7-ADO. (/RD is usually shown in 
data books as RD. The overbar means the signal is negative-active.) 

Connect Probe 2 (Omni Channels DF-08) to 8085 pins AD7-ADO, and the 
Multiplexer Clock input lead (Probe 4) to ALE. The address is valid on 
the falling edge of ALE, so enter O in Trigger Menu Item D, Multiplexer 
Clock. 

Connect Probe 4 (Omni Channels AF-AS) to 8085 pins A15-A8. Connect 
the Omni's External Clock input lead (Probe 1) to the 8085's /RD (read) 
signal. Data is valid on the rising edge of /RD, so enter 1 in Item B, 
External Clock. External Clock 2 will not be used, so leave its input 
probe lead floating (Probe 3) and enter 1 in Trigger Menu Item C, 
External Clock 2. 

When data is collected, the Omni's internal demultiplexing will 
transfer the lower 8 address bits to Channels A7-AO. The 8085 read 
strobe will clock the upper 8 address bits into Channels AF-AS. The 
bits from the 8085 data bus will be collected in Channels DF-D8. The 
Instruction Disassembly function may then be used to display the 
collected information in disassembled form. 

Rev. D 
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30. PATTERN GENERATOR 

The Pattern Generator is a new accessory for the Omni which bas not 
yet been released. It will be controlled by a menu (accessed by the P 
Command) in the logic analyzer program, allowing you to use the logic 
analyzer and Pattern Generator together as an integrated system. 

When the Pattern Generator becomes available, a chapter describing 
its operation will be provided to replace this page. 

Rev. D 
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Appendix A. QUICK START 

If you are like most of us, you will want to turn on the Omni and 
make it do something right away. In this section we will walk you 
through the Omni's basic functions and displays in about half an hour. 
The advanced functions take about another hour. 

The Omni's computer-based design makes it very easy to learn to 
use. By the time you are done, you will know most of what you need to 
know to use the Omni effectively. 

I. BASIC FUNCTIONS 

A.l GETTING fil UP 

Place the Omni flat on your table ■ Unfasten the clamps on the 
right and left sides that hold on the front cover/keyboard, and pull it 
off. Connect the telephone-type coil cord between the keyboard (rear 
edge) and the main unit rear panel (near the top). If the rear panel 
has more than one telephone-type connector, use the one marked 
"KEYBOARD.11 Lift the main unit and lower the stand on the underside so 
that the screen is up and easily visible. Plug the connectors for the 
probes into the two ribbon-cable connectors below Drive B. 

Open the doors of both floppy disk drives. Some types of drives 
use a pushbutton or lever to latch in the disk rather than a door. 
Whichever type you have, unlatch the mechanism and remove the shipping 
cards from inside the drives. Due to the nature of CP/M, turning on the 
machine with a disk in the drive may result in scrambling the data on 
the disk - which is why backup disks are a good practice ■ (Also, you 
must always remember to take the disks out of the drives before turning 
off the Omni). 

The power switch is a large rocker switch on the rear panel. Turn 
it on now. The disk drives will start whirring and you will soon see: 

* Omni * 
Please insert your diskette into Drive A 

on the screen. 

Put the logic analyzer program disk, the one labeled "Omni Logic 
Analyzer Operating Disk", in Drive A. It is all right to put a disk in 
the Omni while the drive is whirring and the red light on the drive is 
on. (This is not true for all computers). To put the disk in the right 
way, insert it with the exposed slot to the rear and the label up. Push 
it in until it clicks in place, then close the door (or actuate the 
pushbutton or lever). Be careful to avoid bending the disk or touching 
the brown magnetic surface in the slot, of course. 
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A.2 MASTER~ 

When you close the door of the drive, the computer will load the 
CP/M operating system and display the Master Menu. The Master Menu is a 
new feature that makes the system very easy to use. It displays 
information about each menu choice automatically. 

The Master Menu lists the major disk functions in the left column. 
For the Logic Analyzer disk, the two major functions listed are: 

Logic Analyzer 
Disk Utilities 

To select a function, use the up-arrow and down-arrow keys to move the 
darkened area to the function in which you are interested. The text in 
the right column describes the function marked by the darkened area. 

For this example, move the dark area over "Logic Analyzer". Now 
press the right-arrow key. A sub-menu giving a complete list of the 
individual functions available will be displayed in the middle column: 

Logic Analyzer 
EPROM Programmer 
Pattern Generator 

Again, you can identify the program in which you are most interested by 
moving the dark area over it. As before, the right column provides 
details about the marked item. 

Select "Logic Analyzer" and press <RETURN>. The Omni will load and 
begin running the logic analyzer program. 

A.3 EARLIER MODELS 

Earlier models of the Omni (1984 and prior) do not have the Master 
Menu feature and use the standard CP/M disk directory user interface. 
(The standard interface is also available under the Master Menu system; 
merely press <ESC> to leave the menu and access it.) The logic analyzer 
functions are the same whether your system has Master Menu or not. If 
you have the Master Menu feature, skip this section and go to section 
A. 4. 

When you close the door of the drive, the computer will load the 
CP/M operating system from the disk, and respond with the standard 
prompt: 

AO> 

B·efore going further, after the "AO>" prompt type "DIR<RETURN>". 

Note: here "<RETURN>" means "press the RETURN key," 
not type the characters "< R E T U R N >". 

The directory listing will show at least six files. LA.COM and L.~.LAO 
are the logic analyzer program. LA.LAH contains the Omni's on-line Help 
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information. DATA-1-.IAD, DATA-2-.LAD, and DATA-S-.LAS contain sample 
data for this start-up exercise. 

When the "AO>11 prompt appears again after the directory listing, 
type "LA<RETURN>". The Omni will load and begin running the logic 
analyzer program. 

hl LOGIC ANALYZER PROGRAM 

The first part of the logic analyzer program is a self-test 
sequence. If you have the probes plugged in and connected to nothing, 
or if there are no probes plugged in, the tests will all be passed and 
the computer will display 

CLOCK CIRCUITRY TEST 
TRIGGER CONTROL TEST 
DATA RAM LOW LEVEL TEST 
DATA RAM HIGH LEVEL TEST 
GLITCH RAM LOW LEVEL TEST 
GLITCH RAM HIGH LEVEL TEST 

and then go on. 

If the probes are plugged in and connected to something, one or 
more tests will probably fail because the tests assume an "inputs 
floating" condition. If any test fails, the program will report it and 
then stop. If necessary, press <SPACE> to override the stop-on-fail and 
make it go on. 

As part of the self-test, the program senses whether inverting or 
non-inverting probes are connected. The standard Omni probes are 
inverting type; when no probes are connected, the program interprets 
that as the non-inverting case. If you plug in the probes after self­
test, you must go to the Options Menu and change the Probe Type to 
Inverting in order to have the data displayed with correct polarity. 

A.5 TRIGGER MENU 

The first thing that appears after the self-test is the Trigger 
Setup Menu, which controls the data collection conditions. For example, 

3) Trigger Event xxxxxxxxxxxxxxxx 

is the trigger word. Each "X" means "don't care" - trigger with the bit 
in that position either O or 1. An "X" in every position means "trigger 
on anything." 

We will come back to the Trigger Menu shortly. But first, press 
<SPACE> to access a summary of the available commands. The first page 
of this listing shows the commands which take parameters, including 
those which control the Omni's complement of useful displays. 

Press any key to access the second page of commands, which lists 
all the single-stroke commands at your disposal. You can get the 
command list back on the screen again with the command "?<RETURN>'' 
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anytime the following command prompt line is displayed: 

Enter: C,D,E 1 F,G,H,I,L,M,N,O,P 1 S,T,W,X,Z 1 •,?,(sp),-P 

The commands are also listed on the Reference Card following this 
section, as well as on the keyboard (in abbreviated form). Operation is 
simple enough, however, that reference to any separate information is 
unnecessary once you gain a basic familiarity with the machine. 

Press <SPACE> to return to the Trigger Menu. Look at Item 1, 
Active Probes. It has two functions. First, it serves as a logic probe 
to show the instantaneous logic levels on the input probe lines. 
Second, it defines the channels that will be included in the Omni's data 
displays. 

The logic probe feature is especially useful because it shows you 
which lines have activity on them before you try to perform a data 
collection. Connect the ground clip on one of the probes to a data line 
and watch the display change. 

Practice changing the sampling conditions on the menu. Type "3" to 
put the cursor on Item 3. Use the left and right arrow keys at the top 
of the keyboard to move the cursor from bit to bit. Or, press "711 to 
move the cursor directly to bit 7. Enter a ''O" or a "l" in each bit 
position to specify the trigger word. Use an "X" for "don't care". 
Press <SPACE> to leave the trigger word. 

Ordinarily, after setting up the trigger conditions you would type 
"Gn ( for "Go collect data") to tell the machine to collect data, but 
don't do it now. The trace memory would fill up with all l's, since the 
probes "float high" to a 1 level when they are not connected. So 
instead press <SPACE> once or twice to bring up the Waveform Display. 

A.6 WAVEFORM DISPLAY 

The Waveform Display has sixteen traces, one for each of the probe 
data lines. They are labeled DF through DO on the left. 

Probably all you will see at this point are flat traces. Near the 
bottom of the screen is a window that looks like: 

____ • __ ! SM 

The bright area shows where the displayed samples are located in the 
1000 samples of data collected. Press the"<" key (or comma, no shift 
is required). 'lbe display will page to the left and you will see some 
waveforms - actually, meaningless data left in memory from the turn-on 
sequence. Also observe that the bright area in the window has moved 
left. 

The Waveform Display shows about 80 words out of the Omni's 1000~ 
odd sample memory. The"<" and">" keys (really, the comma and period) 
on the keyboard just above the space bar move the display left and 
right. Try it and see. 
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A. 7 FILES 

We also have some sample data stored on disk that you can view. 

One of the features that makes the Omni unique in the field of 
digital analysis is its ability to store sample data and all associated 
parameters on disk files. Such files appear in the CP/M disk directory 
with the ex tens ion ". LA.D". 

The I.A disk contains a sample file of previously captured data 
called DATA-1-.I.AD. To call it up, type 11F" to access the File Menu. 
Type "4" to access the choice "READ into SAMPLE memory from file". Type 
"DATA-1-<RETURN>" (do not type ".LAD"; the extension is appended 
automatically) and the program will load the data. 

Now press <SPACE> and notice that the data which was previously on 
the screen has been replaced by new data. 

Study the Waveform. Display further; this is a timing display, and 
it contains a wealth of information. Below the traces is a scale 
showing the number of each sample in the memory relative to the trigger 
word. Sample O is the trigger word, sample 10 is the tenth after the 
trigger word, sample -10 is the tenth sample before, and so on. 

Below the sample scale is the hex equivalent of each sample word, 
in the form of f.our characters· in a vertical column. 

The highlighted cursor may be moved right or 
keys at the upper right on the keyboard. Try it• 
of the sample marked by the cursor also appear at 
"cur: 11 • 

left using the arrow 
The nwuber and time 

lower right after 

Note the prompt line at the bottom of the Waveform. Display: 

This lists the commands that are available. All of the Omni's menus and 
displays show the available choices at the bottom of the screen. A 
label on the keyboard also lists these commands. 

To call up Help information on the Waveform Display, type 11?W11 or 
its lowercase equivalent, "/w". 

!,& ~DISPLAY 

Next we'll look at a Dump Display of the same data. The Dump 
Display is the other display most often used along with the Waveform 
Display. Note which sample the highlighted cursor is on. Type 
uD<RETURN>" for "Dump"• 

What you are now seeing is a hex listing of the same data, with the 
same sample highlighted as before. Use the four cursor keys (top row on 
the keyboard) to move the cursor around on the screen. As before, the 
cursor counter ''cur:" at the lower right corner gives the number of the 
marked sample. 
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A.9 OPTIONS ~ 

The number base for the Dump Display is controlled by the Options 
Menu. Let's change the base and see the same data in binary. Type "O" 
( the letter "O", not zero) to display the Options Menu. Type "l" to 
select Item 1 on the menu, Output Number Base. 

As soon as you type the "l ", the choices available are shown at the 
bottom of the screen - binary (B), decimal (D), hexadecimal (H), octal 
(O), and unsigned decimal (U). All the Omni's commands work this way; 
as soon as you enter the first character, the Omni shows you the format 
so you can enter the rest of the command correctly. No more hit-or-miss 
struggling to remember command formats. 

Type "B 11 to change the number base to binary. Now press <SPACE> to 
return to the Dump Display. Now the same data is displayed in binary. 

Before going on, change the base back to hexadecimal. Type "O" to 
return to the Options Menu again, enter "H" in Item 1, and then press 
<SPACE> to return to the Dump Display. 

The system is designed so that <SPACE> usually takes you to the 
next page you will need. After viewing a display, <SPACE> takes you to 
the Trigger Menu so you can change the trigger conditions in preparation 
for collecting a new sample. Command G then collects the new sample, 
and displays it in whatever format you used last. If you lose your 
place, typing <SPACE> once or twice will bring you either the Trigger 
Menu or an "Enter:" command prompt line. Command T takes you right to 
the Trigger Menu. 

The Omni's flexible data collection - any trigger word or external 
trigger signal, internal or external clock with trigger and clock 
qualifiers - coupled with its ability to display the data in many 
different ways, expands exponentially your ability to collect and 
interpret meaningful digital data. 

A.IO EDGE DISPLAY ----
Type "E<RETURN>" for Edge Display. Another form of the Waveform 

Display; the Edge Display emphasizes waveform edges by omitting 
sequences of 3 or more identical samples. Page the display left and 
right and note that the long sequences of flat traces you saw in the 
Waveform Display have been dropped and replaced by vertical rows of 
blanks. In this case, the Edge Display contains about as much 
information as three pages of the Waveform Display. 

,hl!. ~COMMAND 

One of the Omni's most helpful features is the N Command for 
renaming channels. To rename Channel Zero (the lowest trace), type: 

NOTEST<RETURN> 

which means "name Channel Zero TEST". You will see the label of the 
lowest trace change to "TEST". 
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Note that you cannot enter spaces in a label; the space bar is used 
only to exit the current display. Use underscore characters in place of 
spaces. 

The new channel name automatically carries through to all menus and 
displays. Press <SPACE> to get back to the Trigger Menu. Type "1" to 
get on Item 1, then use the cursor key-> repeatedly to step the 
blinking prompt-cursor along through the channels. The name of 
whichever channel the prompt-cursor is on will appear at the upper right 
under "Signal". When you reach channel 0, the name you assigned, 
"TEST", appears. This feature relieves you of the tedious chore of 
keeping track of which channel is which, and is one of the benefits of 
coupling a logic analyzer with a computer. 

Press <SPACE> once or twice to leave the Trigger Menu and return to 
the Edge Display. Note that the program pauses and flashes a "No data 
has yet been collected 11 message at the bottom of the screen. This is to 
warn you that no new data has been collected since you changed a 
parameter. 

!.:.il. ~ PAGES 

Help information is available on-line with a few keystrokes. For 
example, when viewing a menu, you can call up an explanation of any item 
by typing 11'l 11 followed by the item number. Try it with the Trigger 
Menu. Type "T" and see the Trigger Menu again. Type "?2 11 and read an 
explanation of Item 2, Active Glitch. Press <SPACE> to return to the 
menu itself, ready to make any changes you want. 

Help information is also available on the display commands whenever 
the cursor-prompt is in the lower left corner of the screen. To get an 
explanation of any command x, enter 11 ?x11 • For example, type 11?D" to see 
the Help Pages for the Dump Display and Command. Now go to the Trigger 
Menu and read the Help Page for each item (1, 2, ••• E). 

You can print out a complete listing of all the Help Pages on a 
printer if you wish. Use the command "CTRL-P?'' to get the printout. 
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II. ADVANCED FUNCTIONS 

The Omni has six advanced functions - Instruction Dissassembly, 
Signature Analysis, Correlation, Matrix Display, Locate Function, and 
Histogram Display. 

Instruction Disassembly assumes the data in sample memory to be 
instructions collected from a microprocessor data bus, and translates 
the data back into microprocessor mnemonics. Signature Analysis 
calculates signatures from the data in memory. The Correlation Function 
compares two sets of data, Sample and Reference, to find differences. 
The Locate Function finds desired data patterns in the sample memory for 
you. The Histogram Display shows a graph of the percentages of data 
words lying within consecutive ''runs" of varying lengths. The Matrix 
Display shows the frequency of occurrence of bytes 00 through FF hex 
within the data sample. 

A.13 INSTRUCTION DISASSEMBLY 

The default processor for which Instruction Disassembly is 
performed is the zso. 

Instruction Disassembly is normally used with Channels F-8 
connected to a microprocessor.data bus. For the Z80, in addition 
Channels 6 and 7 are connected to the /Ml and /MREQ control signals, 
which the Omni uses to identify opcode fetches. Channels 5-0 may be 
used to monitor any other signals you wish - address lines or I/0 port 
bits, for example. 

To view a sample of the Omni's Instruction Disassembly 
capabilities, load the file DATA-2-.LA.D into sample memory. Type "F" to 
access the File Operations Menu, "4", and then "DATA-;;.2-<RETURN>" to read 
the file. Now type "I-420<RETURN>". 

The display you see is somewhat like an assembly listing. On the 
left side are the bits and bytes, while on the right are the mnemonics 
and operands. Each line represents one instruction. 

For example, if you see "00100001-80", the ''00100001" is a binary 
representation of Channels 7-0, which includes the control lines. "80 11 

is the byte on the data bus (in hexadecimal), and is the opcode for the 
ADD A,B instruction. 

The listing on the right includes not only the mnemonics for the 
opcodes and operands, but also the hex data corresponding to the 
execution of the instruction. When a Z80 executes a POP DE instruction, 
it reads one byte from the program (POP DE is a one-byte instruction), 
and then reads two more bytes from the stack region of memory for 
loading into its DE registers. Thus you see these two bytes following 
the instruction. 

Normally you use the microprocessor system memory READ line as the 
External Clock to collect the sample from the data bus. Collect a 
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sample with the G Command, then use the I Command to translate it into 
mnemonics. 

Disassembly for the 8085/8080 is performed in a similar manner, 
using Channels 7, 6, and 5 to sense the 8085/8080 status signals /IOM, 
SO, and Sl. 

The Instruction Disassembly function allows you to perform 
disassembly for other microprocessors by loading the appropriate 
mnemonics. Mnemnonics tables are loaded via Item 2 in the File Menu. A 
table is currently available for the 8048 family (8748, 80C48, 8039, 
etc.). You can also create new tables for other processors yourself. 

A.14 SIGNATURE ANALYSIS 

The next function we'll look at is Signature Analysis, which is 
controlled by a combined menu and display. Type "S" to call it up. 

A "signature" is a kind of checksum calculated from the data stream 
passing a circuit node. A very powerful troubleshooting technique, 
signature analysis is used to isolate faults in defective circuit 
boards. The user compares the signatures of various points on a 
malfunctioning board to the signatures of the same points on a "known 
good" board of the same type. 

The Omni can collect signatures from up to 14 points at one time. 
The signatures, which are four-digit hexadecimal numbers, appear in the 
Sample column on the display. The "known good" signatures (collected 
previously from a working board and stored on disk) are recalled to 
appear in the Reference column. 

Reference signatures are stored on disk in special files with the 
extension ".!AS". They must be called up with the Signature Menu, not 
via the Files Menu like data files. 

To call up a sample set of known-good signatures type "7" to put 
the cursor on Item 7, "Read from file". Then type "DATA-S-", which will 
load the sample signature file DATA-S-.LAS from disk. (The extension 
".!AS'' is appended automatically; don't type it.) The stored signatures 
will then appear in the Reference column. 

The G Command tells the Omni to "Go collect a new sample," 
calculate the signatures, and display them in the Sample column. Any 
Sample signatures different from the References would be marked by 
highlighting and a pointer arrow. Having all the Sample and Reference 
signatures displayed side-by-side makes the comparisons error-free and 
fast. See the illustration in Section 25 of the manual for an example 
of the display. 

A.15 CORRELATION 

The Correlation function allows you to compare two sets of data, 
one in Sample Memory and the other in Reference Memory. This is useful 
for comparing questionable data to known good data, or for isolating 
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small changes in the data that could be nearly impossible to find by 
eye. 

The Reference data may be loaded from a disk file. Type "F" to get 
the File Menu. Type "3" followed by "DATA-1-<RETURN>" to load the file 
data into Reference Memory. 

Now type "C" to go to the Correlation Menu. Note that 
"DATA-1-.LAD" appears in Item 1. Press <TAB> to initiate correlation. 

Note that this function does not normally perform a new data 
collection; it merely correlates the data already in Sample Memory to 
the data in Reference Memory. (An exception: Item 9 on the Correlation 
Menu allows repeated new data collections and correlations.) 

The results of the operation appear as four columns, one sample 
position in each line. The first column gives the sample number, Sample 
0 corresponding to the sample at the trigger event as usual. The second 
column gives the Sample data. The third column gives the Reference 
data. The fourth column gives the sample number o·f the data in 
Reference Memory. Non-correlating samples are marked by"<•>" and 
intensified brightness. 

!.:.!.§. MATRIX DISPLAY 

Press <SPACE> to leave Correlation and get the command prompt line. 

Type "MALL<RETURN>n to bring up the Matrix Display for samples -488 
to 511 (or whatever the trace limits are). The Omni will calculate and 
display a table giving the number of occurrences of each possible byte 
(00 through FF) in Sample Memory. 

The eight bits on which the Matrix table is based correspond to the 
eight (or less) lowest active probe lines. (Active probe lines are set 
on the Trigger Menu, and as of now all sixteen should be active.) The 
first hex digit of each byte is on the left, the second hex digit on the 
scale at the top. Look and see how many times the byte 1110" occurs. 

!.!.!l LOCATE FUNCTION 

We can use the Locate function to find the occurrences of the byte 
"10" in Sample Memory. 

The Locate function is also controlled by a menu; type "Lu to bring 
it up. Item 1, Start Sample Number, contains -488 as the default value 
so the search will start from the first sample in the data collected. 
Type "3" to get on the Global Channel Mask item. We want to consider 
only the lower eight channels in the search, so type "FF<RETURN>" to 
mask out the upper eight channels. (The Omni will right justify the 
number entered, so "FF" is the same as "00P'F".) Type "4" to get on the 
Search Pattern item, and then type in "lO<RETURN>". Press <SPACE> to· 
leave the Search Pattern items. 

Now press <TAB>. The Waveform Display will come back with the 
first occurrence of "10" marked by the highlighted cursor. If there 
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were no occurrences, then "Not found 0 would appear at the upper right on 
the Locate Menu. 

Note that the Locate function does not cause any new data to be 
collected. 

Each time a search pattern is found, the Start Sample Number on the 
menu will be updated automatically to the start the next at the sample 
after where the pattern was last found. Once a search pattern has been 
entered, it is possible to find the second, third, and all subsequent 
occurrences of the pattern by repeatedly pressing <TAB>. 

A.18 HISTOGRAM DISPLAY 

The Omni's last function is Histogram, a sophisticated form of 
statistical analysis. Type "H", which takes you to the 'Histogram 
Display. This one combines the menu and display on the same page. 

The Histogram is primarily used for studying program execution to 
impr~Je efficiency. When the data in Sample Memory represents addresses 
of instructions, the Histogram can be used to measure the amount of time 
the compu_ter uses executing different parts of the program. 

The algorithm that produces the Histogram Display works as follows. 
It looks through the Sample Memory for sample data falling in the range 
specified in Items 1 and 2; ·let us call those "in-range samples." An 
in-range sample will sometimes appear in a "run" of in-range samples 
(that is, with other in-range samples before or after it, or both) and 
sometimes all alone. 

Two questions are of interest here. First, how long are the "runs" 
of in-range samples - how many samples are there in each run? Second, 
and more important, how are the samples distributed. in the runs of 
different lengths - how many samples fall in short runs versus long 
runs? So the histogram algorithm identifies the "runs" of in-range 
samples, sorts them into categories by length of run, and then counts 
the number of samples in each category. 

The column on the left is the run lengths; that is, "5-9" means 
runs 5 to 9 in-range samples long. The second column is the percentage 
of in-range samples that fall in runs of varying lengths. The base for 
the percentage (100%) is the total number of in-range samples in the 
sample memory. Thus a "7" in the second column next to 115-9 11 would mean 
that 7% of the in-range samples fell in runs 5 to 9 samples long. 

The Histogram function can perform repeated accumulations for 
better statistical accuracy. 

The Histogram Menu will accept input in other nwn.ber bases other 
than hexadecimal. For example, type 111" to put the cursor on Item 1, 
then type "O<RETURN>" to enter O. Type "2" to put the cursor on Item 2, 
then type "999d<RETURN>" to enter 999 decimal. The Omni will calculate 
and display a histogram based on those values. 
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A.19 EXITING THE LOGIC ANALYZER PROGRAM 

To exit to CP/M, use CTRL~ (press "C" while holding down the 
<CTRL> key) • 

A. 2 0 CONCLUSION 

Well, that's it. You now know how the Omni works and are ready to 
hook the probes up to a real circuit and start looking at digital data. 

For more detailed study of how to use the Omni's full capability, 
we suggest you start with Chapter Sin this manual and read from there. 

For your first data collection runs, it's a good idea to use 
Internal Clock and leave the Trigger Event on the Trigger Menu set to 
all "don't cares." These conditions will always give you a completed 
data collection and display any activity on the data lines. Before 
using External Clock, use this method to check to make sure that the 
signal you plan to use for the External Clock is actual~y present. 

If the Omni is set to trigger on a certain word and that word is 
not present in the data stream, triggering will not occur and the 
machine will just wait. If that happens, press any key except <SPACE> 
to cause a manual trigger. The data then displayed will be accurate 
data, however, Sample O will correspond to your manual trigger time 
rather than the trigger word entered on the Trigger Menu. Studying the 
data will usually give you clues as to why the expected trigger word did 
not appear. 

Rev. D 
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Appendix B. REFERENCE CARD 

Collect ..Q!. Display Data: 

D [x] 
E [x) 
G 
I [x] 
M[x[,y]] 
W[x[,y]] -
Utility Commands: 

? [C/D, • • •] 
N flxyz ••• 
CTRL-P [x( ,y]] 
X[x[,y]] 

Numeric dump from sample x 
Edge display from sample x 
Go and Start Data Collection 
Instruction disassembly from sample x 
Matrix display from sample x toy 
Waveform display from sample x toy 
Load trigger and collect data 

Help Pages for Commands C, o, ... 
Name Channel number fl with xyz ••• 
Print copy of sample x toy 
Calculate time between cursor, x, or y 

~ Callup Commands; · 

C 
F 
H 
L 
0 
p· 

s 
T 
z 

Correlation Menu 
File Operations Menu 
Histogram Menu and Display 
Locate Pattern Menu 
Options Menu 
Pattern Generator Menu 
Signature Analysis Menu 
Trigger Menu 
Multilevel Triggering 

Display Control Keys: 

> Scroll display to right one page 
< Scroll display to left one page 
-> Move cursor right one sample 
<- Move cursor left one sample 
arrow up Move cursor up one channel or sample 
arrow down Move cursor down one channel or sample 
<SPACE> Change mode, terminate function 

Manual~ 

16-1 
15-1 
12-1 
17-1 
19-1 
13-1 
10-3 

9-1 
14-1 
24-1 
22-1 

18-1 
20-1 
23-1 
21-1 
11-1 
30-1 
25-1 
10-1 
29-6 

'nlis list of the Omni's commands is also on line as two Help Pages. To 
obtain the first, type "?<RETURN>"; then strike <SPACE> to obtain the 
second. 
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OmniLogic, Inc. 

LOGIC ANALyzER USER'S CCMMENTS 

OmniLogic is pleased to receive comments from our users. Problems 
with either software or the operating manual should be sent to us so 
that improvements can be made. As these improvements are implemented, 
software, hardware, and manual updates will be made available to our 
customers. Please photocopy this form and use it for comments. 

Did you find any problems or have any suggestions regarding the 
hardware? 

Did you find any problems or have any suggestions reg_arding the 
software? 

Did you find the manual understandable, usable, and well-organized? 
Did you find errors? Please make suggestions for improvement by page 
number. 

Page No. Problem or suggestion 

Please indicate how you are using the Omni Logic Analyzer. 

Name Date ------------------------ '--------
Organization Phone ------------------- ;._ ______ _ 
Street ---------------------------------City _______________ State;.,_., _______ ZIP ____ _ 

Thank you for your help. 
OmniLogic, Inc. 
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